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Introduction

This manual describes detailed instructions on the operation and notes about the use of this machine.
To get maximum versatility from this machine all operators are requested to read this manual carefully
and follow the instructions. Please keep this manual in a handy place near the machine.

Please read the Safety Information before using this machine. It contains important information related
to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.

Trademarks

AppleTalk, EtherTalk, LaserWriter, Macintosh are registered trademarks of Apple Computer, Inc.

Microsoft, Windows, Windows NT are registered trademarks of Microsoft Corporation in the United
States and/or other countries.

Novell, NetWare are registered trademarks of Novell, Inc.

PostScript is a registered trademark of Adobe Systems, Incorporated.

PowerPC is a registered trademark of International Business Machines Corporation.
PCL is a registered trademark of Hewlett-Packard Company.

3Com is a trade mark of 3Com corporation.

Bluetooth is a Trademark of the Bluetooth SIG, Inc. (Special Interest Group) and licensed to RICOH
Company Limited.

The Bluetooth Trademarks are owned by Bluetooth SIG, Inc. USA

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights to those marks.

The proper names of the Windows operating systems are as follows:

* The product name of Windows® 95 is Microsoft® Windows 95.

¢ The product name of Windows® 98 is Microsoft® Windows 98.

* The product name of Windows® Me is Microsoft® Windows Millennium Edition (Windows Me).

* The product names of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Advanced Server
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Professional
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 The product names of Windows® XP are as follows:
Microsoft® Windows® XP Professional
Microsoft® Windows® XP Home Edition

 The product names of Windows Server™ 2003 are as follows:
Microsoft® Windows Server™ 2003 Standard Edition
Microsoft® Windows Server™ 2003 Enterprise Edition
Microsoft® Windows Server™ 2003 Web Edition

 The product names of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Server 4.0

*  Microsoft® Windows NT® Workstation 4.0

Notes:

Some illustrations in this manual might be slightly different from the machine.
Certain options might not be available in some countries. For details, please contact your local dealer.

Two kinds of size notation are employed in this manual. With this machine refer to the metric version.
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How to Read This Manual

Symbols

The following set of symbols is used in this manual.

/\ WARNING:

This symbol indicates a potentially hazardous situation that might result in death or serious injury when
you misuse the machine without following the instructions under this symbol. Be sure to read the in-
structions, all of which are described in the Safety Information section.

A\ CAUTION:

This symbol indicates a potentially hazardous situation that might result in minor or moderate injury or
property damage that does not involve personal injury when you misuse the machine without following
the instructions under this symbol. Be sure to read the instructions, all of which are described in the
Safety Information section.

* The statements above are notes for your safety.

i@klmportant
If this instruction is not followed, paper might be misfed, originals might be damaged, or data might be
lost. Be sure to read this.

& Preparation
This symbol indicates information or preparations required prior to operating.

& Note
This symbol indicates precautions for operation, or actions to take after abnormal operation.

? Limitation
This symbol indicates numerical limits, functions that cannot be used together, or conditions in which
a particular function cannot be used.

y
y
y
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A Reference
This symbol indicates a reference.

[ 1]

Keys that appear on the machine's display panel.

[ 1]

Keys and buttons that appear on the computer's display.

]
Keys built into the machine's control panel.
1

Keys on the computer's keyboard.
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Checking the Network Environment

Windows 2000/XP
Windows Server 2003
Windows NT 4.0
(Server)

Windows 95/98/ @
Me/2000/XP \4

F
gz
~a
Q

S Z

Macintosh

&

ACE018S
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% Connecting Printer and Computer

* Network connection (Ethernet cable, IEEE 1394 cable (IP over 1394), IEEE 802.11b (wireless
LAN))

» Parallel connection (parallel cable)

¢ USB connection (USB cable)

* IEEE 1394 (SCSI print) connection (IEEE 1394 cable)
+ Bluetooth™ connection
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Windows Configuration

< Connecting a Print Server

Windows 2000/XP
Windows Server 2003
Windows NT 4.0

Print Server

Print Server

=
—

Ny
Windows 95/98/Me/
2000/XP

Windows Server 2003

~> ~
5y 5y
N~ N
Windows NT 4.0

ACE0198

* See p.22 “Printing Using a Print Server” in “Windows 95/98/Me Configuration”.

* See p.54 “Printing Using a Print Server” in “Windows 2000 Configuration”.

* See p.87 “Printing Using a Print Server” in “Windows XP, Windows Server 2003 Configura-

tion”.

* See p.118 “Printing Using a Print Server” in “Windows NT 4.0 Configuration”.

W
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% Network Connection(Ethernet)

Windows 95/98/Me/ Windows Server 2003 Windows NT 4.0 Macintosh
2000/XP

ACE063S
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% Network Connection (IEEE 1394 (IP over 1394))

N 2
Windows Me/XP Windows Server 2003

ACE064S




» IEEE 802.11b

<+ad hoc mode

Printer Client Reference

infrastructure mode

access point

%@ M)
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< Interface supported protocols

Interface
Ethernet IEEE 802.11b IEEE 1394 (IP over
1394)
Protocol TCP/IP @) O] O
NetBEUI O O X
NetWare O oO* X
AppleTalk O O X

O the protocol is supported.
X the protocol is not supported.

*1

If the optional IEEE 802.11b interface unit is installed, you cannot use ad hoc mode.

See p.28 “Printing without a Print Server” in “Windows 95/98/Me Configuration”.

See p.60 “Printing without a Print Server” in “Windows 2000 Configuration”.

See p.93 “Printing without a Print Server” in “Windows XP, Windows Server 2003 Configura-
tion”.

See p.124 “Printing without a Print Server” in “Windows NT 4.0 Configuration”.
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< Parallel Connection

See p.43 “Printing via Parallel Connection” in “Windows 95/ 98/ Me Configuration”.
See p.75 “Printing via Parallel Connection” in “Windows 2000 Configuration™.

See p.106 “Printing via Parallel Connection” in “Windows XP, Windows Server 2003 Configu-
ration”.

See p.139 “Printing via Parallel Connection” in “Windows NT 4.0 Configuration”.

Windows NT 4.0

S Windows 95/98/Me/
2000/XP
\a Windows Server 2003

ACE066S
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% USB Connection
* See p.47 “Installing the Printer Driver Using USB” in “Windows 95/ 98/ Me Configuration”.
* See p.79 “Installing the Printer Driver Using USB” in “Windows 2000 Configuration”.

* See p.110 “Installing the Printer Driver Using USB” in “Windows XP, Windows Server 2003
Configuration”.

7 Windows 98 SE/Me/
2000/XP
V Windows Server 2003

ACE067S




Printer Client Reference

+ |IEEE 1394 Connection
* See p.49 “Installing the Printer Driver Using IEEE 1394” in “Windows 95/ 98/ Me Configura-
tion”.
* See p.80 “Installing the Printer Driver Using IEEE 1394” in “Windows 2000 Configuration”.

* See p.111 “Installing the Printer Driver Using IEEE 1394” in “Windows XP, Windows Server
2003 Configuration”.

SCSI print

% Connecting a NetWare Server
See p.161 “NetWare Configuration”.
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Macintosh Configuration

See p.145 “Macintosh Configuration”.

UNIX Configuration

For UNIX printing information, please visit our Web site or consult your authorized retailer.
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1. Windows 95/98/Me Configuration

Printing Using a Print Server

Printing Using a Windows 2000/XP, Windows Server 2003, or Windows
NT 4.0 Print Server

This section describes procedures for setting up a client on a network using Windows 2000/XP, Win-
dows Server 2003, or Windows NT 4.0 as a print server.

To print from Windows 95/98/Me, you must install the printer driver and change the printer port con-
nection to the print server.

Windows 2000/XP
Windows Server 2003
Windows NT 4.0

Print Server

Windows 95/98/Me

ACE069S
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Installing the PCL 5c or RPCS Printer Driver

] Preparation

4
u|

a

To use the print server, install the printer driver by selecting “Network printer server”, and then select
the Windows 2000/XP, Windows Server 2003, or Windows NT 4.0 shared printer. For more infor-
mation about how to install and settings, see Administrator Reference.

This section assumes the client has already been configured to communicate with a Windows
2000/XP, Windows Server 2003, or Windows NT 4.0 print server. Do not begin the following proce-
dure until the client is set up and configured correctly.

Limitation
When using a print server connected to the printer via SmartDeviceMonitor for Client, you cannot
use Recovery Printing and Parallel Printing.

When using Windows XP as a print server, the client computer cannot receive notification of print
job completion.

n Quit all applications that are running.

ﬂ Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

{¥Important

3 Never have two versions of the same printer driver installed on your system at the same time.
When upgrading to a new version of the printer driver, delete the old version, and then install the
new one.

& Note

3 Auto Run might not work automatically due to certain operating system settings. If this is the
case, launch “Setup.exe” located in the CD-ROM root directory.



| Operating Instructions

B Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

ﬂ Click [PCL/RPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog box.

After reading through the content, click [| accept the agreement.] to agree with the license agree-
ment, and then click [Next>].

B In the [Select Program] dialog box, select the printer drivers you want to use, and then click [Next>].

You can select more than one printer driver.

ﬂ Select the [Printer Name] check box for the model(s) of printer you want to use.
To change the printer name, use the [Change settings for 'Printer Name'] box.

m Double-click the printer name to display its settings.

& Note

3 The details shown for [Comment], [Driver], and [Port] vary depending on the operating system be-
ing used, model of printer selected, and port being used.

g Click [Port], and then click [Add].
[E Click [Network Printer], and then click [OK].

m Double-click the computer name you want to use as the print server in the [Browse for Printer]
window.

m Select the printer you want to use, and then click [OK].

24
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[B Make sure the location for the selected printer is displayed after [Port].

m Configure the user code and default printer as necessary.

% User Code
The procedure to specify the user code may differ depending on the printer language.

* RPCS
You can specify the user code when installing the printer driver. You cannot register or edit
the user code from the printer driver dialog box. To change the user code, you must uninstall
the printer driver, and then register the new user code during the re-install process.

* PCL 5c
You can specify the user code with the Printer Driver Properties after installing the printer
driver. See the printer driver's Help.

+ Default Printer
Select the [Default Printer] check box to set the printer as the default printer.

[B Click [Continue] to start printer driver installation.

m When the [Select Program] dialog box appears, click [Finish].

[ﬂ When the [Installation completion.] dialog box appears, click [Finish].
m Set up the options.

& Note

3 You must set up the options when bidirectional transmission is disabled. For more information
about bidirectional transmission status, see p.52 “Bidirectional transmission”.

/A Reference
For more information about option settings, see p.51 “Setting Up Options”.
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Installing the PostScript Printer Driver

n Quit all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

ﬂlmportant

3 Never have two versions of the same printer driver installed on your system at the same time.
When upgrading to a new version of the printer driver, delete the old version, and then install the
new one.

& Note

3 Auto Run might not work automatically due to certain operating system settings. If this is the
case, launch “Setup.exe” located in the CD-ROM root directory.

B Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

& Note

O The printer driver with the selected language will be installed. The printer driver will be installed
in English if you select the following languages: Cestina, Magyar, Polski, Portugues, Suomi

ﬂ Click [PostScript 3 Printer Driver].
“Add Printer Wizard” starts.

B crick [Nexts].
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E Click [Network Printer], and then click [Next>].
ﬂ Click [Browse].

B Double-click the computer name you want to use as the print server in the [Browse for Printer]
window.

g Select the printer you want to use, and then click [OK].
[m After confirming the location for the selected printer shown, click [Next>].

m Change the name of the printer if you want, and then click [Next>].
Configure the default printer as necessary. Click [Yes] to set the printer as the default printer.

m Select whether or not you want to print a test page, and then click [Finish].
The installation is complete.

& Note

3 You can specify the user code with the Printer Driver Properties after installing the printer driver.
See the printer driver's Help.

~ Reference
For more information about option settings, see p.51 “Setting Up Options”.

[B Restart the computer.
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Printing without a Print Server

= Preparation
To use a printer connected to the Ethernet interface, IEEE 802.11b (wireless LAN) interface or IEEE
1394 (IP over 1394) interface, select “SmartDeviceMonitor” when installing the printer driver.

Configuring Protocols

Configuring TCP/IP and IPP for Printing

Follow these instructions to configure the printer and Windows 95/98/Me to use TCP/IP and IPP.

% Configuring the printer
Configure the printer to use TCP/IP.
e Check TCP/IP is set to active. (The default is active.)
* Assign an IP address and make other settings required for TCP/IP.

/~ Reference
For more information about how to make the above settings, see “Configuring the printer for the
Network”, Setup Guide.
If DHCP is used to assign IP addresses, see Appendix, “When Using DHCP”, Administrator Ref-
erence.

Under Windows Me, when you want to use IP over 1394, see Setup Guide.

g
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& Note
3 After setting the IP address, use the ping command to check it is set correctly.

@® Windows 95/98
Click [Start], point to [Programs], and then click [MS-DOS Prompt].

® Windows Me
Click [Start], point to [Programs], point to [Accessories], and then click [MS-DOS Prompt].

® Enter the following: (Example: IP address is 192.168.15.16)
C:> ping 192.168.15.16
If the address is configured correctly, the following message appears:
Reply from 192.168.15.16 : bytes=32 time<lOms TTL=32
If the address is configured incorrectly, the following message appears:
Request timed out.

< Configuring a Windows 95/98/Me computer
Follow the procedure below to configure a Windows 95/98/Me computer to use TCP/IP:
@® Open [Control Panel] and double-click the [Network] icon. Check “TCP/IP” is listed in the [The
following network components are installed:] box under the [Configuration] tab.

& Note
3 If TCP/IP is not installed, click [Add] under the [Configuration] tab and install it. For more infor-
mation about installing TCP/IP, see Windows 95/98/Me Help.

3 Under Windows Me, if you want to use IEEE 1394 (IP over 1394), make sure TCP/IP is bound
to the IEEE 1394 adaptor being used. The following message appears:

TCP/IP -> (IEEE 1394 adaptor in use)

@ Configure TCP/IP with the appropriate IP address, subnet mask and other settings.
Check the settings are correct with the network administrator.
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Configuring NetBEUI for Printing

Follow these instructions to configure the printer and Windows 95/98/Me to use NetBEUI.

® Limitation

O To use NetBEUI, use the SmartDeviceMonitor for Client port.

% Configuring the printer
Enable the SMB of the printer in order to enable printing using NetBEUI. (The default is active.)
¢ Check NetBEUI is set to active. (The default is active.)

ye Reference

For more information about how to make the above settings, see “Configuring the printer for the
Network”, Setup Guide.

% Configuring a Windows 95/98/Me computer
Install NetBEUI on a Windows 95/98/Me computer and set it as the default protocol.

@® Open [Control Panel] and double-click the [Network] icon. Check “NetBEUT” is listed in the [The
following network components are installed:] box under the [Configuration] tab.

& Note
3 If NetBEUI is not installed, click [Add] under the [Configuration] tab and install it. For more in-
formation about installing NetBEUI, see Windows 95/98/Me Help.
O If “NetBEUI ->Dial-Up Adaptor” is listed in the [The following network components are installed:]
box, select it, and then click [Remove] to remove the binding.
@ Set NetBEUI as the default protocol. Click the [Configuration] tab, select “NetBEUI” in the [The
following network components are installed:] box, and then click [Properties].
® Click the [Advanced] tab, select the [Set this protocol to be the default protocol] check box, and
then click [OK].
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@ Click [OK] to close the [Network] dialog box.
® When the restart message appears, click [Yes].

Installing Software

& Preparation
If you are not using a print server, install SmartDeviceMonitor for Client, and then install the printer
driver by selecting “SmartDeviceMonitor for Client”. This enables peer-to-peer network printing via
TCP/IP, NetBEUI, or IPP.

& Note
3 Under Windows Me, you can print using TCP/IP and the IEEE 1394 (IP over 1394) interface.

Installing SmartDeviceMonitor for Client

n Quit all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

i%klmportant

3 Never have two versions of the same printer driver installed on your system at the same time.
When upgrading to a new version of the printer driver, delete the old version, and then install the
new one.

& Note
3 Auto Run might not work automatically due to certain operating system settings. If this is the
case, launch “Setup.exe” located in the CD-ROM root directory.

7



Printer Client Reference

B Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

ﬂ Click [SmartDeviceMonitor for Client/Admin].

B The software license agreement appears in the [License Agreement] dialog box.
After reading through the content, click [| accept the agreement.] to agree with the license agree-
ment, and then click [Next>].

E Select the [SmartDeviceMonitor for Client] check box, and then click [Next >].

ﬂ Follow the instructions on the screen.

& Note

3 If you are required to restart the computer after the installation of SmartDeviceMonitor for Client,
restart and continue configuration.

Installing the PCL 5c¢ or RPCS Printer Driver

n Quit all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.
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{¥Important

3 Never have two versions of the same printer driver installed on your system at the same time.
When upgrading to a new version of the printer driver, delete the old version, and then install the
new one.

& Note
3 Auto Run might not work automatically due to certain operating system settings. If this is the

case, launch “Setup.exe” located in the CD-ROM root directory.
B Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

ﬂ Click [PCL/RPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog box.

After reading through the content, click [| accept the agreement.] to agree with the license agree-
ment, and then click [Next>].

E In the [Select Program] dialog box, select the printer drivers you want to use, and then click
[Next>].

You can select more than one printer driver.

ﬂ Select the [Printer Name] check box for the model(s) of printer you want to use.
To change the printer name, use the [Change settings for 'Printer Name'] box.
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B Double-click the printer name to display its settings.

& Note

3 The details shown for [Comment], [Driver], and [Port] vary depending on the operating system be-
ing used, model of printer selected, and port being used.

g Select SmartDeviceMonitor.

SmartDeviceMonitor

@ Click [Port], and then click [Add].
@ Select [SmartDeviceMonitor], and then click [OK].
© Select the printer you want to use.

< TCP/IP
@ Click [TCP/IP], and then click [Search].
Available printers will be listed.
@ Click the printer you want to use, and then click [OK].

& Note

3 Printers that respond to an IP broadcast from the computer will be displayed. To print to a
printer not listed here, click [Specify Address], and then enter the printer's IP address or host
name.

3 Part of the printer’s IP address is used for the port name.

3 Avoid using an address that is partially similar to one already in use. For example, if “192.
168. 0.2” is already used, “192. 168. 0.2xx” cannot be used. Similarly, if “192. 168. 0.20”
is already used, “192.168.0.2” cannot be used.
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% NetBEUI

@ Click [NetBEUI], and then click [Search].
A list of printers that can be used with NetBEUI appears.

@ Click the printer you want to use, and then click [OK].

& Note

3 Printers that respond to a broadcast from the computer will be displayed. To print to a
printer not listed here, click [Specify Address], and then enter the NetBEUI address. Check
the NetBEUI network address is on the configuration page. For more information about
printing the configuration page, see “Printing a Configuration Page”, Administrator Refer-
ence. NetBEUI address appears as “\RNPxxxx\xxx” on the configuration page. Enter the
printer's network path name in the form of “%%Computer name\Share name”. Do not en-
ter “\\” as head characters but “%%".

3 You cannot print to printers beyond routers.

& IPP
® Click [IPP].
The IPP setting dialog box appears.

® To specify the IP address of the printer, type "http://printer's-ip-address/printer”" in the
[Printer URL] box.

& Note

3 If you have configured SSL (secure sockets layer) encryption and have issued the
server certificate, enter "https://<printer's IP address>/printer". Internet Explorer 5.01
or later must be installed on the computer.

(Example IP address is 192.168.15.16)

https://192.168.15.16/printer



Printer Client Reference

® If necessary, enter the names to distinguish the printer in the [IPP Port Name] box. Enter a
different name from those of existing port names.
If you do not do this, the address entered in the [Printer URL] box will be set as the TPP port
name.

@ If a proxy server and IPP user name are used, click [Detailed Settings], and then configure
the necessary settings.

& Note
O For more information about these settings, see SmartDeviceMonitor for Client Help.

® Click [OK].
[m Make sure the location for the selected printer is displayed after [Port].

m Configure the user code and default printer as necessary.

% User Code

The procedure to specify the user code may differ depending on the printer language.

* RPCS
You can specify the user code when installing the printer driver. You cannot register or edit
the user code from the printer driver dialog box. To change the user code, you must uninstall
the printer driver, and then register the new user code during the re-install process.

* PCL 5c
You can specify the user code with the Printer Driver Properties after installing the printer
driver. See the printer driver's Help.

< Default Printer
Select the [Default Printer] check box to set the printer as the default printer.

m Click [Continue] to start printer driver installation.

[B When the [Select Program] dialog box appears, click [Finish].

l y
,//
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m When the [Installation completion.] dialog box appears, click [Finish].

[B Set up the options.

& Note
3 You must set up the options when bidirectional transmission is disabled. For more information
about bidirectional transmission status, see p.52 “Bidirectional transmission”.

/~ Reference
For more information about option settings, see p.51 “Setting Up Options”.

Installing the PostScript Printer Driver

n Quit all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

i@klmportant

3 Never have two versions of the same printer driver installed on your system at the same time.
When upgrading to a new version of the printer driver, delete the old version, and then install the
new one.

& Note
3 Auto Run might not work automatically due to certain operating system settings. If this is the
case, launch “Setup.exe” located in the CD-ROM root directory.

g
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B Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

& Note

O The printer driver with the selected language will be installed. The printer driver will be installed
in English if you select the following languages: Cestina, Magyar, Polski, Portugues, Suomi

ﬂ Click [PostScript 3 Printer Driver].
“Add Printer Wizard” starts.

B click Nexts.

E Click [Local Printer], and then click [Next>].
A dialog box for selecting the printer manufacturer and model name appears.

ﬂ Select the name of the printer whose driver you want to install, and then click [Next>].
B In the [Available ports:] box, click [LPT1:], and then click [Next>].

g Change the name of the printer if you want, and then click [Next>].
Configure the default printer as necessary. Click [Yes] to set the printer as the default printer.

m Select whether or not you want to print a test page, and then click [Finish].

m On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

m Click the icon of the printer you want to use. On the [File] menu, click [Properties].
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[B Click [Details], and then click [Add Port...].
[I] Select [SmartDeviceMonitor], and then click [OK].

[B Select the printer you want to use.

TCP/IP

© Click [TCP/IP], and then click [Search].
Available printers will be listed.
@ Click the printer you want to use, and then click [OK].

& Note

3 Printers that respond to an IP broadcast from the computer will be displayed. To print to a
printer not listed here, click [Specify Address], and then enter the printer's IP address or host
name.

3 Part of the printer’s IP address is used for the port name.

3 Avoid using an address that is partially similar to one already in use. For example, if “192.
168. 0.2” is already used, “192. 168. 0.2xx” cannot be used. Similarly, if “192. 168. 0.20” is
already used, “192.168.0.2” cannot be used.

NetBEUI

@ Click [NetBEUI], and then click [Search].
A list of printers that can be used with NetBEUI appears.
@ Click the printer you want to use, and then click [OK].
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& Note

O Printers that respond to a broadcast from the computer will be displayed. To print to a printer
not listed here, click [Specify Address], and then enter the NetBEUI address. Confirm the Net-
BEUI network address is on the configuration page. For more information about printing the
configuration page, see “Printing a Configuration Page”, Administrator Reference. NetBEUI
address appears as “\RNPxxxx\xxx” on the configuration page. Enter the printer's network
path name in the form of “%%Computer name\Share name”. Do not enter “\\” as head char-
acters but “%%".

3 You cannot print to printers beyond routers.

IPP

© Click [IPP].
The IPP setting dialog box appears.

@ In the [Printer URL] box, enter “http://(printer's IP address)/printer” as the printer's IP ad-
dress.

& Note

3 If you have configured SSL (secure sockets layer) encryption and have issued the server cer-
tificate, enter "https://<printer's IP address>/printer". Internet Explorer 5.01 or later must be
installed on the computer.

(Example: IP address is 192.168.15.16)
https://192.168.15.16/printer

© If necessary, enter the names to distinguish the printer in the [IPP Port Name] box. Enter a
different name from those of existing port names.

If you do not do this, the address entered in the [Printer URL] box will be set as the IPP port name.

O If a proxy server and IPP user name are used, click [Detailed Settings], and then configure
the necessary settings.
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& Note
O For more information about these settings, see SmartDeviceMonitor for Client Help.

@ Click [OK].
M crick [ok].

[ﬂ Confirm that the selected port is highlighted in [Printer to the following port], and then click
[OK].

& Note

3 You can specify the user code with the Printer Driver Properties after installing the printer driver.
See the printer driver's Help.

/~ Reference
For more information about option settings, see p.51 “Setting Up Options”.

m Restart the computer.

Changing Port Settings

Follow the procedure below to change SmartDeviceMonitor for Client settings, such as proxy server
settings or IPP URL.

& Note
3 There are no settings for NetBEUI.

n In the [Printers] window, click the icon of the printer you want to use. On the [File] menu, click
[Properties].
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ﬂ Click the [Details] tab, and then click [Port Settings...].
The [Port Settings] dialog box appears.
* For TCP/IP, you can configure Timeout Settings.

& Note
O If you cannot set items on the [Recovery/Parallel Printing] tab, follow the procedure below:
@ Click [Cancel] to close the [Port Configuration:] dialog box.
@ Start SmartDeviceMonitor for Client, and then right-click the SmartDeviceMonitor for Cli-
ent icon on the taskbar.
® Click [Extended Features Settings], and then select the [Set Recovery/Parallel Printing for each
port] check box.
@ Click [OK] to close the [Extended Features Settings] dialog box.

* For IPP, you can configure User Settings, Proxy Settings and Timeout Settings.

& Note
O For more information about these settings, see SmartDeviceMonitor for Client Help.
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Printing via Parallel Connection

To use a printer connected to the parallel interface, select “LPT1:” when installing the printer driver.

Installing the PCL 5¢ or RPCS Printer Driver

n Quit all applications that are running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

1k Important
3 Never have two versions of the same printer driver installed on your system at the same time. When
upgrading to a new version of the printer driver, delete the old version, and then install the new one.

& Note

3 Auto Run might not work automatically due to certain operating system settings. If this is the
case, launch “Setup.exe” located in the CD-ROM root directory.

B Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

ﬂ Click [PCL/RPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog box.

After reading through the content, click [| accept the agreement.] to agree with the license agree-
ment, and then click [Next>].
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E In the [Select Program] dialog box, select the printer drivers you want to use, and then click
[Next>].

You can select more than one printer driver.

ﬂ Select the [Printer Name] check box for the model(s) of printer you want to use.
To change the printer name, use the [Change settings for 'Printer Name'] box.

B Double-click the printer name to display its settings.

& Note

3 The details shown for [Comment], [Driver], and [Port] vary depending on the operating system be-
ing used, model of printer selected, and port being used.

g Confirm that [LPT1:] is shown for [Port].

m Configure the user code and default printer as necessary.

% User Code

The procedure to specify the user code may differ depending on the printer language.

* RPCS
You can specify the user code when installing the printer driver. You cannot register or edit
the user code from the printer driver dialog box. To change the user code, you must uninstall
the printer driver, and then register the new user code during the re-install process.

* PCL 5c/PostScript 3
You can specify the user code with the Printer Driver Properties after installing the printer
driver. See the printer driver's Help.

< Default Printer
Select the [Default Printer] check box to set the printer as the default printer.

m Click [Continue] to start printer driver installation.
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m When the [Select Program] dialog box appears, click [Finish].
[B When the [Installation completion.] dialog box appears, click [Finish].
m Set up the options.

& Note
3 You must set up the options when bidirectional transmission is disabled. For more information
about bidirectional transmission status, see p.52 “Bidirectional transmission”.

~ Reference
For more information about option settings, see p.51 “Setting Up Options”.

Installing the PostScript Printer Driver

n Quit all applications that are running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

#¥Important

3 Never have two versions of the same printer driver installed on your system at the same time.
When upgrading to a new version of the printer driver, delete the old version, and then install the
new one.

& Note
3 Auto Run might not work automatically due to certain operating system settings. If this is the
case, launch “Setup.exe” located in the CD-ROM root directory.
| //
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B Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

& Note

O The printer driver with the selected language will be installed. The printer driver will be installed
in English if you select the following languages: Cestina, Magyar, Polski, Portugues, Suomi

ﬂ Click [PostScript 3 Printer Driver].
“Add Printer Wizard” starts.

B click Nexts.

E Click [Local Printer], and then click [Next>].
A dialog box for selecting the printer manufacturer and model name appears.

ﬂ Select the name of the printer whose driver you want to install, and then click [Next>].
B In the [Available ports:] box, click [LPT1:], and then click [Next>].

g Change the name of the printer if you want, and then click [Next>].
Configure the default printer as necessary. Click [Yes] to set the printer as the default printer.

m Select whether or not you want to print a test page, and then click [Finish].

/~ Reference
For more information about option settings, see p.51 “Setting Up Options”.

m Restart the computer.
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Installing the Printer Driver Using USB

This section gives basic instructions for installing the printer drivers using USB. The printer drivers can
be installed from the provided CD-ROM.

= Preparation
Installation is not possible under Windows 95/98. Upgrade to Windows 98 SE/Me.

iiklmportant
3O Make sure all other applications are closed and the computer is not currently printing prior to instal-
lation.

Windows 98 SE/Me - Installing the Printer Driver Using USB

The procedure below uses Windows 98 as an example. The procedure for Windows Me may be slightly
different.

When the USB cable is used for the first time, the “plug and play” function starts and the [New Hardware
Found], [Device Driver Wizard] or [Found New Hardware Wizard] dialog box appears depending on the
system used.

If the printer driver is already installed, the “plug and play” window appears, and the printer with its
port directed to the USB cable is added to the [Printers] folder.

l] Click [Next>].
ﬂ Click [Search for the best driver for your device. (Recommended).], and then click [Next>].

B Select the [Specify a location:] check box, and then click [Browse...].
The [Browse for Folder] dialog box appears.
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ﬂ Insert the CD-ROM provided into the CD-ROM drive.

& Note
3 When Auto Run starts, click [Exit].

O If you want to inactivate Auto Run, press the [Shift] key when inserting the CD-ROM into the
drive and keep it pressed until the computer completes transmission to the drive.

B Select the drive where the printer driver is located according to the operating system used, and
then click [OK].

If the CD-ROM drive is D, the folder will be “D:\Drivers\USBPRINT\WIN98ME".

E Confirm the printer driver location, and then click [Next>].
“USB Printing Support” will be installed.

& ciick [Finish].

B Follow the “plug and play’ on the screen to install the printer drivers.

When installation is complete, the printer with its port directed to “USB0On” appears on the [Print-
ers] folder. (“n” is the number of printers connected.)
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Installing the Printer Driver Using IEEE 1394

This section gives basic instructions for installing the printer drivers using the IEEE 1394 interface. The
printer drivers can be installed from the provided CD-ROM.

= Preparation
To use a printer connected to the IEEE 1394 (IP over 1394) interface, select “SmartDeviceMonitor”
when installing the printer driver. See p.28 “Configuring Protocols” and p.31 “Installing Software”

i@klmportant
O Make sure all other applications are closed and the computer is not currently printing prior to instal-
lation.

Printing via IP over 1394

You can print by setting the IP address for the printer and the computer on which Windows Me is in-
stalled.

® Limitation

3O When using the IEEE 1394 (IP over 1394) interface in a network, the Ethernet interface cannot be
used on the same network.

& Note

3 The maximum number of simultaneous print requests when connecting with IP over 1394 includes
requests via Ethernet interface. For more information, see Administrator Reference.
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Installing the Printer Driver

To print using SmartDeviceMonitor, see p.28 “Printing without a Print Server”.

& Note
3 If [Add New Hardware Wizard] starts every time you restart the computer with an operating system that
does not support SCSI print or plug in or out the cable, inactivate the device by following procedures.
@ In the [Add New Hardware Wizard] dialog box, confirm that [Windows has found the following new
Hardware: IEEE SBP-2 Device] is displayed, and click [Recommended search for a better driver
[Recommended]], and then click [Next>].

@ When the [Windows was unable to locate the software for this device.] message appears, click
[Finish].
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Setting Up Options

You must set up options when bidirectional transmission is disabled.

& Note
3 The description uses the PCL 5c printer driver.

n On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.
B On the [File] menu, click [Properties].
ﬂ Click the [Accessories] tab.

& Note
3 If you are using the RPCS printer driver, click [Printer Configuration...] under the [Print Settings] tab.

B In the [Options] box, select the options you have installed. Make any necessary settings.

& Note
3 If you are using the RPCS printer driver, select the options from [Select printer options:].

3 ciick [0k




Printer Client Reference

{Bidirectional transmission

When bidirectional transmission is enabled, information about paper size and feed direction settings is

automatically sent to the printer by the computer. You can also check printer status from your computer.

* Bidirectional transmission is supported by Windows 95/98/Me/2000/XP, Windows Server 2003,
and Windows NT 4.0.

* If you use the RPCS printer driver and bidirectional transmission is enabled, under Windows
95/98/Me, unavailable functions are shaded in the [Change Accessories] dialog box of the printer
properties. The [Change Accessories] dialog box is displayed by clicking the [Change Accesso-
ries...] button under the [Printer Configuration] tab.

& Note

3 The RPCS printer driver supports bidirectional transmission and updates the printer status automat-
ically.

O The PCL 5c printer driver supports bidirectional transmission; you can update the printer status
manually.

O The PostScript 3 printer driver does not support bidirectional transmission.

Bidirectional transmission requires the following conditions:

< When connecting via parallel cable

The computer must support bidirectional transmission.

The printer must be set to bidirectional transmission.

The Interface cable must support bidirectional transmission.

The printer must be connected to the computer using standard parallel cable and parallel connec-
tor.

Under Windows 95/98/Me, [Enable bidirectional support for this printer] must be selected in
[Spool Settings...] on the [Details] tab with RPCS printer driver.
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< When connecting with the network
* The printer must be set to bidirectional transmission.

¢ SmartDeviceMonitor for Client included on the CD-ROM must be installed, and TCP/IP must
be used.

e Under Windows 95/98/Me, [Enable bidirectional support for this printer] must be selected in
[Spool Settings...] on the [Details] tab with RPCS printer driver.

< When connecting with IEEE 1394

* The printer must be connected to the IEEE 1394 connector of a computer using the IEEE 1394
interface cable.

< When connecting with USB
The printer must be connected to the computer's USB connector using the USB interface cable.
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2. Windows 2000 Configuration

Printing Using a Print Server

Printing Using a Windows 2000/XP, Windows Server 2003, or Windows
NT 4.0 Print Server

This section describes procedures for setting up a client in a network using Windows 2000/XP, Win-
dows Server 2003, or Windows NT 4.0 as a print server.

To print from Windows 2000, you must install the printer driver and change the printer port connection
to the print server.

Windows 2000/XP
Windows Server 2003
Windows NT 4.0

Print Server

o
—

~>
S
Windows 2000

ACE070S8
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Installing the PCL 5c or RPCS Printer Driver

] Preparation

4
u|

To use the print server, install the printer driver by selecting “Network printer server”, and then select
the Windows 2000/XP, Windows Server 2003, or Windows NT 4.0 shared printer. For more infor-
mation about how to install and settings, see Administrator Reference.

This section assumes the client has already been configured to communicate with a Windows
2000/XP, Windows Server 2003, or Windows NT 4.0 print server. Do not begin the following proce-
dure until the client is set up and configured correctly.

Limitation
When using a print server connected to the printer via SmartDeviceMonitor for Client, you cannot
use Recovery Printing and Parallel Printing.

& Note

a

When using Windows NT 4.0 as a Print Server, make sure to install the Windows NT 4.0 printer driv-
er before connecting the print server. There is a Windows NT 4.0 printer driver on the CD-ROM la-
beled “Printer Drivers and Utilities”.

n Quit all applications that are running.

ﬂ Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

iiklmportant

3 Never have two versions of the same printer driver installed on your system at the same time. When
upgrading to a new version of the printer driver, delete the old version, and then install the new one.

& Note

3 Auto Run might not work automatically due to certain operating system settings. If this is the
case, launch “Setup.exe” located in the CD-ROM root directory.



Printer Client Reference

B Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

ﬂ Click [PCL/RPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog box.

After reading through the content, click [| accept the agreement.] to agree with the license agree-
ment, and then click [Next>].

E In the [Select Program] dialog box, select the printer drivers you want to use, and then click
[Next>].

You can select more than one printer driver.

ﬂ Select the [Printer Name] check box for the model(s) of printer you want to use.
To change the printer name, use the [Change settings for 'Printer Name'] box.

m Double-click the printer name to display its settings.

& Note

3 The details shown for [Comment], [Driver], and [Port] vary depending on the operating system be-
ing used, model of printer selected, and port being used.

g Click [Port], and then click [Add].
m Click [Network Printer], and then click [OK].

m Double-click the computer name you want to use as the print server in the [Browse for Printer]
window.
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m Select the printer you want to use, and then click [OK].
[B Make sure the location for the selected printer is displayed after [Port].

m Configure the user code and default printer as necessary.

% User Code
When using RPCS, you can specify the user code with the Printer Driver Properties after install-
ing the printer driver. See the printer driver's Help.

+ Default Printer
Select the [Default Printer] check box to set the printer as the default printer.

[B Click [Continue] to start printer driver installation.

[B When the [Select Program] dialog box appears, click [Finish].

m When the [Installation completion.] dialog box appears, click [Finish].
m Set up the options.

& Note

3 You must set up the options when bidirectional transmission is disabled. For more information
about bidirectional transmission status, see p.85 “Bidirectional transmission”.

/~ Reference
For more information about option settings, see p.84 “Setting Up Options”.
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Installing the PostScript Printer Driver

n Quit all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

ﬂlmportant

3 Never have two versions of the same printer driver installed on your system at the same time.
When upgrading to a new version of the printer driver, delete the old version, and then install the
new one.

& Note

3 Auto Run might not work automatically due to certain operating system settings. If this is the
case, launch “Setup.exe” located in the CD-ROM root directory.

B Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

& Note

O The printer driver with the selected language will be installed. The printer driver will be installed
in English if you select the following languages: Cestina, Magyar, Polski, Portugues, Suomi

ﬂ Click [PostScript 3 Printer Driver].
“Add Printer Wizard” starts.

B crick [Nexts].
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E Click [Network Printer], and then click [Next>].
ﬂ Click [Next>].

B Double-click the computer name you want to use as the print server in the [Shared printers:]
window.

g Select the printer you want to use, and then click [Next>].
Configure the default printer as necessary. Click [Yes] to set the printer as the default printer.

[m Start printer driver installation.
m Click [Next>].

[ﬂ Click [Finish].
The installation is complete.

& Note

3 You can specify the user code with the Printer Driver Properties after installing the printer driver.
See the printer driver's Help.

~ Reference
For more information about option settings, see p.84 “Setting Up Options”.

[B Restart the computer.
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Printing without a Print Server

= Preparation
To use a printer connected to the Ethernet interface or IEEE 802.11b (wireless LAN) interface, se-
lect “SmartDeviceMonitor”, “Standard TCP/IP Port”, or “LPR Port” when installing the printer driver.
« For SmartDeviceMonitor, see p.60 “Configuring Protocols”, p.63 “Installing Software”, p.64 “In-
stalling the PCL 5¢ or RPCS Printer Driver”, and p.69 “Installing the PostScript Printer Driver”.

» For Standard TCP/IP Port, LPR Port, see p.60 “Configuring Protocols”, p.64 “Installing the PCL
5c or RPCS Printer Driver”, and p.69 “Installing the PostScript Printer Driver”.

& Note

O If you want to use “LPR Port”, “Print Services for UNIX” must be installed. For details, see
Windows 2000 Help.

Configuring Protocols

Configuring TCP/IP and IPP for Printing

Follow these instructions to configure the printer and Windows 2000 to use TCP/IP and IPP.

< Configuring the printer
Configure the printer to use TCP/IP.
e Check TCP/IP is set to active. (The default is active.)

* Assign an IP address and make other settings required for TCP/IP.
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A Reference
For more information about how to make the above settings, see “Configuring the printer for the
Network”, Setup Guide.
If DHCP is used to assign IP addresses, see Appendix, “When Using DHCP”, Administrator Ref-
erence.

& Note
3 After setting the IP address, use the ping command to check it is set correctly.
@ Click [Start], point to [Programs], point to [Accessories], and then click [Command Prompt].

@ Enter the following: (Example: IP address is 192.168.15.16)
C:> ping 192.168.15.16
If the address is configured correctly, the following message appears:
Reply from 192.168.15.16 : bytes=32 time<lOms TTL=32
If the address is configured incorrectly, the following message appears:
Request timed out.

% Configuring a Windows 2000 computer
Follow the procedure below to configure a Windows 2000 computer to use TCP/IP:

@® On the [Start] menu, point to [Settings], and then click [Network and Dial-up Connections].
@ Click [Local Area Connection].
® On the [File] menu, click [Properties].

@ Confirm that “Internet Protocol (TCP/IP)” is selected in the [Components checked are used by
this connection:] box on the [General] tab.

& Note
O If the check box for TCP/IP is not selected, select it.

3 If TCP/IP is not installed, click [Install...] on the [General] tab and install it. For more information
about installing TCP/IP, see Windows 2000 Help.
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® Configure TCP/IP with the appropriate IP address, subnet mask and other settings.
Check the settings are correct with the network administrator.

Configuring NetBEUI for Printing

Follow these instructions to configure the network interface board and Windows 2000 to use NetBEUI:

= Preparation
To use NetBEUI, use the SmartDeviceMonitor for Client port.

% Configuring the printer
Enable the SMB of the printer in order to enable printing using NetBEUI. (The default is active.)
¢ Check NetBEUTI is set to active. (The default is active.)

ye Reference

For more information about how to make the above settings, see “Configuring the printer for the
Network”, Setup Guide.

% Configuring a Windows 2000 computer
Follow the procedure below to configure a Windows 2000 computer to use NetBEUI:

@® On the [Start] menu, point to [Settings], and then click [Network and Dial-up Connections].
@® Click [Local Area Connection].
® On the [File] menu, click [Properties].

@ Check “NetBEUI Protocol” is selected in the [Components checked are used by this connection:]
box on the [General] tab.

& Note
O If the check box for NetBEUI is not selected, select it.

3 If NetBEUI is not installed, click [Install...] on the [General] tab to install it. For more information
about installing NetBEUI, see Windows 2000 Help. y
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Installing Software

] Preparation
If you are not using a print server, install SmartDeviceMonitor for Client, and then install the printer
driver by selecting “SmartDeviceMonitor for Client”. This enables peer-to-peer network printing via
TCP/IP, NetBEUI, or IPP.

Installing SmartDeviceMonitor for Client

n Quit all applications that are running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

& Note

3 Auto Run might not work automatically due to certain operating system settings. If this is the
case, launch “Setup.exe” located in the CD-ROM root directory.

B Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

ﬂ Click [SmartDeviceMonitor for Client/Admin].

B The software license agreement appears in the [License Agreement] dialog box.

After reading through the content, click [| accept the agreement.] to agree with the license agree-
ment, and then click [Next>].
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E Select the [SmartDeviceMonitor for Client] check box, and then click [Next >].

ﬂ Follow the instructions on the screen.

& Note

3 If you are required to restart the computer after the installation of SmartDeviceMonitor for Client,
restart and continue configuration.

Installing the PCL 5c¢ or RPCS Printer Driver

n Quit all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

i%klmportant

3 Never have two versions of the same printer driver installed on your system at the same time.
When upgrading to a new version of the printer driver, delete the old version, and then install the
new one.

& Note

3 Auto Run might not work automatically due to certain operating system settings. If this is the
case, launch “Setup.exe” located in the CD-ROM root directory.

B Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

ﬂ Click [PCL/RPCS Printer Drivers].
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B The software license agreement appears in the [License Agreement] dialog box.

After reading through the content, click [l accept the agreement.] to agree with the license agree-
ment, and then click [Next>].

E In the [Select Program] dialog box, select the printer drivers you want to use, and then click
[Next>].

You can select more than one printer driver.

ﬂ Select the [Printer Name] check box to select the printer model(s) you want to use.
To change the printer name, use the [Change settings for 'Printer Name'] box.

B Double-click the printer name to display its settings.

& Note
3 The details shown for [Comment], [Driver], and [Port] vary depending on the operating system be-
ing used, model of printer selected, and port being used.

g Click [Port], and then click [Add] in the [Change settings for 'Port'] box.

[m The next part of the procedure depends on the port in use. Follow the section that corresponds
to the port you want to use.

¢ SmartDeviceMonitor
e Standard TCP/IP Port
e LPR Port

SmartDeviceMonitor

@ Select [SmartDeviceMonitor], and then click [OK].
@ Select the printer you want to use.
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< TCP/IP
@ Click [TCP/IP], and then click [Search].
Available printers will be listed.
@ Click the printer you want to use, and then click [OK].

& Note

3 Printers that respond to an IP broadcast from the computer will be displayed. To print to a
printer not listed here, click [Specify Address], and then enter the printer's IP address or host
name.

< NetBEUI
® Click [NetBEUI], and then click [Search].
A list of printers that can be used with NetBEUI appears.
@ Click the printer you want to use, and then click [OK].

& Note

3 Printers that respond to a broadcast from the computer will be displayed. To print to a
printer not listed here, click [Specify Address], and then enter the NetBEUI address. Confirm
the NetBEUI network address is on the configuration page. For more information about
printing the configuration page, see “Printing a Configuration Page”, Administrator Refer-
ence. NetBEUI address appears as “\\RNPxxxx\xxx” on the configuration page. Enter the
printer's network path name in the form of “%%Computer name\Share name”. Do not en-
ter “\\” as head characters but “%%".

3 You cannot print to printers beyond routers.

& IPP

@ Click [IPP].
The IPP setting dialog box appears.

® To specify the IP address of the printer, type "http://printer's-ip-address/printer”" in the
[Printer URL] box. l //
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& Note

3 If you have configured SSL (secure sockets layer) encryption and have issued the
server certificate, enter "https://<printer's IP address>/printer". Internet Explorer 5.01
or later must be installed on the computer.

(Example IP address is 192.168.15.16)

https://192.168.15.16/printer

® If necessary, enter the names to distinguish the printer in the [IPP Port Name] box. Enter a
different name from those of existing port names.
If you do not do this, the address entered in the [Printer URL] box will be set as the TPP port
name.

@ If a proxy server and IPP user name are used, click [Detailed Settings], and then configure
the necessary settings.

& Note
O For more information about these settings, see SmartDeviceMonitor for Client Help.

® Click [OK].

Standard TCP/IP Port

@ Select [Standard TCP/IP Port], and then click [OK].
@ In the [Add Standard TCP/IP Printer Port Wizard] window, click [Next>].

© In the [Printer Name or IP Address:] box, enter the printer name or IP address, and then click
[Next>].

O In the [Add Standard TCP/IP Printer Port Wizard] window, click [Finish].

7
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LPR Port

@ Select [LPR Port], and then click [OK].
@ In the [Name or address of server providing Ipd:] box, enter the printer's IP address.
© In the [Name of printer or print queue on that server:] box, enter “Ip”.

m Make sure the location for the selected printer is displayed after [Port].
m Configure the default printer as necessary.

< Default Printer
Select the [Default Printer] check box to set the printer as the default printer.

[B Click [Continue] to start printer driver installation.

m When the [Select Program] dialog box appears, click [Finish].

[B When the [Installation completion.] dialog box appears, click [Finish].
m Set up the options.

& Note
3 You must set up the options when bidirectional transmission is disabled. For more information
about bidirectional transmission status, see p.85 “Bidirectional transmission”.

~ Reference
For more information about option settings, see p.84 “Setting Up Options”.

7
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Installing the PostScript Printer Driver

n Quit all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

ﬂlmportant

3 Never have two versions of the same printer driver installed on your system at the same time.
When upgrading to a new version of the printer driver, delete the old version, and then install the
new one.

& Note

3 Auto Run might not work automatically due to certain operating system settings. If this is the
case, launch “Setup.exe” located in the CD-ROM root directory.

B Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

& Note

O The printer driver with the selected language will be installed. The printer driver will be installed
in English if you select the following languages: Cestina, Magyar, Polski, Portugues, Suomi

ﬂ Click [PostScript 3 Printer Driver].
“Add Printer Wizard” starts.

B rick [Next>].
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E Click [Local printer], and then click [Next>].
ﬂ Click [Create a new port:].

B The next part of the procedure depends on the port in use. Follow the section that corresponds
to the port you want to use.

¢ SmartDeviceMonitor
e Standard TCP/IP Port
e LPR Port

SmartDeviceMonitor

@ Select [SmartDeviceMonitor], and then click [Next>].
@ Select the printer you want to use.

< TCP/IP

@ Click [TCP/IP], and then click [Search].
Available printers will be listed.

@® Click the printer you want to use, and then click [OK].

& Note

3 Printers that respond to an IP broadcast from the computer will be displayed. To print to a
printer not listed here, click [Specify Address], and then enter the printer's IP address or host
name.

+« NetBEUI

@® Click [NetBEUI], and then click [Search].
A list of printers that can be used with NetBEUI appears.

@ Click the printer you want to use, and then click [OK]. '
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& Note

3 Printers that respond to a broadcast from the computer will be displayed. To print to a
printer not listed here, click [Specify Address], and then enter the NetBEUI address. Confirm
the NetBEUI network address is on the configuration page. For more information about
printing the configuration page, see “Printing a Configuration Page”, Administrator Refer-
ence. NetBEUI address appears as “\\RNPxxxx\xxx” on the configuration page. Enter the
printer's network path name in the form of “%%Computer name\Share name”. Do not en-
ter “\\” as head characters but “%%".

3 You cannot print to printers beyond routers.

& IPP
@ Click [IPP].
The IPP setting dialog box appears.

@ To specify the IP address of the printer, type "http://printer's-ip-address/printer" in the
[Printer URL] box.

& Note

3 If you have configured SSL (secure sockets layer) encryption and have issued the
server certificate, enter "https://<printer's IP address>/printer". Internet Explorer 5.01
or later must be installed on the computer.

(Example IP address is 192.168.15.16)

https://192.168.15.16/printer

® If necessary, enter the names to distinguish the printer in the [IPP Port Name] box. Enter a
different name from those of existing port names.
If you do not do this, the address entered in the [Printer URL] box will be set as the IPP port
name.

@ If a proxy server and IPP user name are used, click [Detailed Settings], and then configure
the necessary settings.
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& Note
O For more information about these settings, see SmartDeviceMonitor for Client Help.

® Click [OK].

Standard TCP/IP Port

@ Select [Standard TCP/IP], and then click [Next>].
@ In the [Add Standard TCP/IP Printer Port Wizard] window, click [Next>].

© In the [Printer Name or IP Address:] box, enter the printer name or IP address, and then click
[Next>].

O In the [Add Standard TCP/IP Printer Port Wizard] window, click [Finish].

LPR Port

@ Select [LPR Port], and then click [Next>].
@ In the [Name or address of server providing Ipd:] box, enter the printer's IP address.
© In the [Name of printer or print queue on that server:] box, enter “Ip”.

g Confirm to select the name of the printer whose driver you want to install, and then click
[Next >].

[m Change the name of the printer if you want, and then click [Next >].
Configure the default printer as necessary. Click [Yes] to set the printer as the default printer.

[ Crick [Next>].

m Select whether or not you want to print a test page, and then click [Next>].
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[B Click [Finish].
Printer driver installation starts.

m Set up the options.

& Note

3 You can specify the user code with the printer properties dialog box after installing the printer
driver. See the printer driver's Help.

~ Reference
For more information about option settings, see p.84 “Setting Up Options”.

Changing Port Settings

Follow the procedure below to change SmartDeviceMonitor for Client settings, such as proxy server
settings or IPP URL.

& Note
3 There are no settings for NetBEUI.

n In the [Printers] window, click the icon of the printer you want to use. On the [File] menu, click
[Properties].

B Click the [Ports] tab, and then click [Configure Port...].
The [Port Configuration:] dialog box appears.
* For TCP/IP, you can configure Timeout Settings.

& Note
3 If you cannot set items on the [Recovery/Parallel Printing] tab, follow the procedure below:

@ Click [Cancel] to close the [Port Configuration:] dialog box.




Printer Client Reference

@ Start SmartDeviceMonitor for Client, and then right-click the SmartDeviceMonitor for Cli-
ent icon on the taskbar.

® Click [Extended Features Settings], and then select the [Set Recovery/Parallel Printing for each
port] check box.

@ Click [OK] to close the [Extended Features Settings] dialog box.
* For IPP, you can configure User Settings, Proxy Settings and Timeout Settings.

& Note
3 For more information about these settings, see SmartDeviceMonitor for Client Help.




Printer Client Reference

Printing via Parallel Connection

= Preparation
To use a printer connected to the parallel interface, select “LPT1:” when installing the printer driver.

Installing the PCL 5c or RPCS Printer Driver

n Quit all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

i%klmportant

3 Never have two versions of the same printer driver installed on your system at the same time.
When upgrading to a new version of the printer driver, delete the old version, and then install the
new one.

& Note
3 Auto Run might not work automatically due to certain operating system settings. If this is the
case, launch “Setup.exe” located in the CD-ROM root directory.

B Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

ﬂ Click [PCL/RPCS Printer Drivers].
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B The software license agreement appears in the [License Agreement] dialog box.

After reading through the content, click [l accept the agreement.] to agree with the license agree-
ment, and then click [Next>].

E In the [Select Program] dialog box, select the printer drivers you want to use, and then click
[Next>].

You can select more than one printer driver.

ﬂ Select the [Printer Name] check box for the model(s) of printer you want to use.
To change the printer name, use the [Change settings for 'Printer Name'] box.

B Double-click the printer name to display its settings.

& Note

3 The details shown for [Comment], [Driver], and [Port] vary depending on the operating system be-
ing used, model of printer selected, and port being used.

g Confirm that [LPT1:] is shown for [Port].

[m Configure the default printer as necessary.

< Default Printer
Select the [Default Printer] check box to set the printer as the default printer.

m Click [Continue] to start printer driver installation.

m When the [Select Program] dialog box appears, click [Finish].

[B When the [Installation completion.] dialog box appears, click [Finish].
m Set up the options.
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& Note

3 You must set up the options when bidirectional transmission is disabled.

3 For more information about bidirectional transmission status, see p.85 “Bidirectional transmis-
sion”.

/~ Reference
For more information about option settings, see p.84 “Setting Up Options”.

Installing the PostScript Printer Driver

n Quit all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

ﬂlmportant

3 Never have two versions of the same printer driver installed on your system at the same time.
When upgrading to a new version of the printer driver, delete the old version, and then install the
new one.

& Note
3 Auto Run might not work automatically due to certain operating system settings. If this is the
case, launch “Setup.exe” located in the CD-ROM root directory.

B Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

l y
,//
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& Note

O The printer driver with the selected language will be installed. The printer driver will be installed
in English if you select the following languages: Cestina, Magyar, Polski, Portugues, Suomi

ﬂ Click [PostScript 3 Printer Driver].
“Add Printer Wizard” starts.

B cClick Nexts).

E Click [Local printer], and then click [Next>].
A dialog box for selecting the printer port appears.

ﬂ Select the printer port, and then click [Next>].
B Change the name of the printer if you want, and then click [Next>].

g Select whether or not you want to print a test page, and then click [Next>].
Printer driver installation starts.

m Click [Finish].
m Set up the options.

/A Reference
For more information about option settings, see p.84 “Setting Up Options”.

m Restart the computer.
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Installing the Printer Driver Using USB

This section gives basic instructions for installing the printer drivers using USB. The printer drivers can
be installed from the provided CD-ROM.

{¥Important
3O Make sure all other applications are closed and the computer is not currently printing prior to instal-
lation.

Windows 2000 - Installing the Printer Driver Using USB

® Limitation

3 Installing a printer driver requires Administrator permission. When you install a printer driver, log on
using an account that has Administrator permission.

When the USB cable is used for the first time, the [Found New Hardware Wizard] dialog box appears,

and Windows 2000's [USB Printing Support] will automatically install.

If the printer driver is already installed, the “plug and play” window appears, and the printer with its
port directed to the USB cable is added to the [Printers] folder.

n Install the printer driver by referring to the instructions for installing the printer driver with
Parallel/Ethernet connection.
When installation is complete, the printer with its port directed to “USB0On” appears on the [Print-
ers] folder. (“n” is the number of printers connected.)
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Installing the Printer Driver Using IEEE 1394

This section gives basic instructions for installing the printer drivers using the IEEE 1394 interface. The
printer drivers can be installed from the provided CD-ROM.

1¥Important
3O Make sure all other applications are closed and the computer is not currently printing prior to instal-
lation.

Printing via SCSI print

Printing using a SCSI print device with the optional IEEE 1394 interface board is possible under Win-
dows 2000.

1¥Important

3 The optional IEEE 1394 interface board can only be used with Service Pack 1 (SP1) or later. If the
Service Pack is not installed, only one 1394 bus SCSI print device is connectable. The client cannot
install the printer driver without using an account that has Administrator permission.

O Do not connect new IEEE 1394 or USB devices to the computer or turn on another printer while in-
stalling the printer driver.

3 Before uninstalling the printer driver, be sure to disconnect the IEEE 1394 interface cable from the
computer.

3 “SCSI print” must be set to active from the control panel. For more information, see “IEEE 1394 Con-
figuration”, Setup Guide.

& Note

3 The printer cannot receive print data from more than one computer at the same time. If you send
data from your computer when data is being received from another, an error message may appear
on the computer display.
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Installing the Printer Driver

& Note

O If [Found New Hardware Wizard] appears every time the computer is started or the cable is connected
with Windows 2000, inactivate the device. If you want to install another printer driver after setting
the “1394_00n” port, select the “1394_00n" port by following the procedure for installing a printer
driver.

3 When the printer connected via the optional IEEE 1394 interface board is installed properly, the icon
in the printer folder changes depending on whether the cable is attached or not.

n Connect the printer and computer using the IEEE 1394 interface cable.
B In the [Found New Hardware Wizard] dialog box, click [Next>].

B When the [This wizard will complete the installation for this Device: (Unknown)] message appears,
click [Search for a suitable driver for my device (recommended)], and then click [Next>].

ﬂ When the [Locate Driver Files] message appears, click [Specify a location], and then click [Next>].

B Hold down the left [SHIFT] key, and then insert the CD-ROM into the CD-ROM drive.
Keep the left [SHIFT] key held down until the computer has finished accessing the CD-ROM.
If the Auto Run program starts, click [Cancel], and then click [Exit].

E Click [Browse].
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ﬂ Select the printer driver you want to use. The following are locations on the CD-ROM where
printer drivers are stored:
* RPCS
\DRIVERS\RPCS\WIN2K_XP\(Language)\DISK1
* PCL 5c
\DRIVERS\PCL5C\WIN2K_XP\(Language)\DISK 1

* PostScript 3
\DRIVERS\PS\WIN2K_XP\(Language)\DISK1

B Click [Open].

ﬂ Click [OK].
The [Driver Files Search Results] dialog box appears.

m Follow the instructions on the screen.

& Note

O If the printer driver is already installed, the printer icon is automatically added to the [Printer] fold-
er. In this case, installation is not necessary.

O When installation is complete, the printer with its port directed to “1394_00n” appears on the
[Printers] folder. (“n” is the number of printers connected.)

O If printing does not work properly after installation, you need to delete the port and reinstall the
printer driver. For more information, see “Printer Does Not Print”, Maintenance Guide.

3 If you do not want to install the printer driver when [Found New Hardware Wizard] starts when using
an operating system that supports SCSI print, inactivate the device by following this procedure:

@ In the [Found New Hardware Wizard] dialog box, click [Next>].

@ When the [This wizard will complete the installation for this Device: (Unknown)] message ap-
pears, click [Search for a suitable driver for my device [recommended]], and then click [Next>].
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® When the [Locate Driver Files] message appears, remove all checks from [Optional search lo-
cations.], and then click [Next>].

@ When the [Driver Files Search Results] message appears, select the [Disable the device. The
Add/Remove Hardware Wizard in the control Panel can be able to complete the driver installa-
tions.] check box, and then click [Finish].

If [Found New Hardware Wizard] appears every time you restart the computer when using an oper-

ating system that does not support IP over 1394, plug in or take out the cable, or inactivate the

device by the following procedure:

® In the [Found New Hardware Wizard] dialog box, click [Next>].

@ When the [This wizard will complete the installation for this Device:] message appears and “TP
over 1394” appears click [Search for a suitable driver for my device [recommended]], and then
click [Next>].

® When the [Locate Driver Files] message appears, remove all checks from [Optional search lo-
cations.], and then click [Next>].

@ When the [Driver Files Search Results] message appears, select the [Disable the device.] check
box, and then click [Finish].
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Setting Up Options

You must set up options when bidirectional transmission is disabled.

& Note
3 The description uses the PCL 5c printer driver.

n On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.
B On the [File] menu, click [Properties].
ﬂ Click the [Accessories] tab.

& Note
O If you are using the RPCS printer driver, click the [Change Accessories] tab.
3 If you are using the PostScript printer driver, click the [Device Settings] tab.

B In the [Options] box, select the options you have installed. Make any necessary settings.

& Note
3 If you are using the RPCS printer driver, select the options from [Select printer options:].
3 If you are using the PostScript 3 printer driver, select the options from [Installable Options].

3 ciick [0k
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{Bidirectional transmission

When bidirectional transmission is enabled, information about paper size and feed direction settings is
automatically sent to the printer by the computer. You can also check printer status from your compu-
ter.

* Bidirectional transmission is supported by Windows 95/98/Me/2000/XP, Windows Server 2003,
and Windows NT 4.0.

* If you use the RPCS printer driver and bidirectional transmission is enabled, under Windows 2000,
the [Change Accessories] tab is shaded, and cannot be used.

& Note

3O The RPCS printer driver supports bidirectional transmission and updates the printer status automat-
ically.

O The PCL 5c printer driver supports bidirectional transmission; you can update the printer status
manually. However, it does not support bidirectional transmission over a parallel connection.

O The PostScript 3 printer driver does not support bidirectional transmission.
Bidirectional transmission requires the following conditions:

< When connecting via parallel cable
* The computer must support bidirectional transmission.
* The printer must be set to bidirectional transmission.
* The Interface cable must support bidirectional transmission.

* The printer must be connected to the computer using standard parallel cable and parallel connec-
tor.

* Under Windows 2000, [Enable bidirectional support] must be selected and [Enable printer pool-
ing] must not be selected on the [Ports] tab with RPCS printer driver.
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< When connecting with the network
* The printer must be set to bidirectional transmission.

¢ SmartDeviceMonitor for Client included on the CD-ROM must be installed, and TCP/IP must
be used.

* Under Windows 2000, [Enable bidirectional support] must be selected and [Enable printer pool-
ing] must not be selected on the [Ports] tab with RPCS printer driver.

< When connecting with IEEE 1394

* The printer must be connected to the IEEE 1394 connector of a computer using the IEEE 1394
interface cable.

* On the printer's control panel, [Active] is selected in the SCSI print of IEEE 1394 and [On] is se-
lected in the Bidi-SCSI print.

e Under Windows 2000, [Enable bidirectional support] must be selected and [Enable printer pool-
ing] must not be selected on the [Ports] tab with RPCS printer driver.

< When connecting with USB
The printer must be connected to the computer's USB connector using the USB interface cable.
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3. Windows XP, Windows Server 2003 Configuration

Printing Using a Print Server

Printing Using a Windows 2000/XP, Windows Server 2003, or Windows
NT 4.0 Print Server

This section describes procedures for setting up a client in a network using Windows 2000/XP, Win-
dows Server 2003, or Windows NT 4.0 as a print server.

To print from Windows XP or Windows Server 2003, you must install the printer driver and change the
printer port connection to the print server.

Windows 2000/XP
Windows Server 2003
Windows NT 4.0

Print Server

Windows XP, Windows Server 2003

ACE071S



Printer Client Reference

Installing the PCL 5c or RPCS Printer Driver

] Preparation
To use the print server, install the printer driver by selecting “Network printer server”, and then select
the Windows 2000/XP, Windows Server 2003, or Windows NT 4.0 shared printer. For more infor-
mation about how to install and settings, see Administrator Reference.
This section assumes the client has already been configured to communicate with a Windows
2000/XP, Windows Server 2003, or Windows NT 4.0 print server. Do not begin the following proce-
dure until the client is set up and configured correctly.

Limitation
When using a print server connected to the printer via SmartDeviceMonitor for Client, you cannot
use Recovery Printing and Parallel Printing.

& Note

O When using Windows NT 4.0 as a Print Server, make sure to install the Windows NT 4.0 printer driv-
er before connecting the print server. There is a Windows NT 4.0 printer driver on the CD-ROM la-
beled “Printer Drivers and Utilities”.

4
u|

n Quit all applications that are running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

iiklmportant

3 Never have two versions of the same printer driver installed on your system at the same time.
When upgrading to a new version of the printer driver, delete the old version, and then install the
new one.
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& Note
3 Auto Run might not work automatically due to certain operating system settings. If this is the

case, launch “Setup.exe” located in the CD-ROM root directory.
B Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

ﬂ Click [PCL/RPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog box.

After reading through the content, click [| accept the agreement.] to agree with the license agree-
ment, and then click [Next>].

B In the [Select Program] dialog box, select the printer drivers you want to use, and then click
[Next>].

You can select more than one printer driver.

ﬂ Select the [Printer Name] check box for the model(s) of printer you want to use.
To change the printer name, use the [Change settings for 'Printer Name'] box.

B Double-click the printer name to display its settings.

& Note

3 The details shown for [Comment], [Driver], and [Port] vary depending on the operating system be-
ing used, model of printer selected, and port being used.

g Click [Port], and then click [Add].
[E] Click [A network printer, or a printer attached to another computer], and then click [OK]. I
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m Double-click the computer name you want to use as the print server in the [Browse for Printer]
window.

m Select the printer you want to use, and then click [OK].
[B Make sure the location for the selected printer is displayed after [Port].

m Configure the default printer as necessary.

+ Default Printer
Select the [Default Printer] check box to set the printer as the default printer.

[B Click [Continue] to start printer driver installation.

& Note

O During installation, the [Hardware Installation] dialog box may appear. If this happens, click [Con-
tinue Anyway] to continue the installation.

m When the [Select Program] dialog box appears, click [Finish].
m When the [Installation completion.] dialog box appears, click [Finish].
m Set up the options.

& Note

3 You must set up the options when bidirectional transmission is disabled. For more information
about bidirectional transmission status, see p.116 “Bidirectional transmission”.

A Reference
For more information about option settings, see p.115 “Setting Up Options”.
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Installing the PostScript Printer Driver

n Quit all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

ﬂlmportant

3 Never have two versions of the same printer driver installed on your system at the same time.
When upgrading to a new version of the printer driver, delete the old version, and then install the
new one.

& Note

3 Auto Run might not work automatically due to certain operating system settings. If this is the
case, launch “Setup.exe” located in the CD-ROM root directory.

B Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

& Note

O The printer driver with the selected language will be installed. The printer driver will be installed
in English if you select the following languages: Cestina, Magyar, Polski, Portugues, Suomi

ﬂ Click [PostScript 3 Printer Driver].
“Add Printer Wizard” starts.

B crick [Nexts].
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E Click [A network printer, or a printer attached to another computer], and then click [Next>].
ﬂ Click [Next>].

B Double-click the computer name you want to use as the print server in the [Browse for Printer]
window, and then click [Next].

g Double-click the computer name you want to use as the print server in the [Shared printers:]
window.

[m Select the printer you want to use, and then click [Next>].

m Start printer driver installation.

& Note

3 During installation, the [Hardware Installation] dialog box may appear. If this happens, click [Con-
tinue Anyway] to continue the installation.

m Click [Next>].

Configure the default printer as necessary. Click [Yes] to set the printer as the default printer.
[B Click [Finish].

The installation is complete.

& Note

3 You can specify the user code with the Printer Driver Properties after installing the printer driver.
See the printer driver's Help.

~ Reference
For more information about option settings, see p.115 “Setting Up Options”.

m Restart the computer. r
y
,//
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Printing without a Print Server

= Preparation
To use a printer connected to the Ethernet interface, IEEE 802.11b (wireless LAN) interface or IEEE
1394 (IP over 1394) interface, select “SmartDeviceMonitor”, “Standard TCP/IP Port”, or “LPR Port”
when installing the printer driver.

» For SmartDeviceMonitor, see p.93 “Configuring Protocols”, p.95 “Installing Software”, p.96 “In-
stalling the PCL 5¢ or RPCS Printer Driver”, and p.101 “Installing the PostScript Printer Driver”.

+ For Standard TCP/IP Port, LPR Port, see p.93 “Configuring Protocols”, p.96 “Installing the PCL
5c or RPCS Printer Driver”, and p.101 “Installing the PostScript Printer Driver”.

& Note

O If you want to use “LPR Port”, “Print Services for UNIX” must be installed. For details, see
Windows XP or Windows Server 2003 Help.

Configuring Protocols

Configuring TCP/IP and IPP for Printing

Follow these instructions to configure the printer and Windows XP or Windows Server 2003 to use
TCP/IP and IPP.

< Configuring the printer
Configure the printer to use TCP/IP.
e Check TCP/IP is set to active. (The default is active.)

* Assign an IP address and make other settings required for TCP/IP.
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A Reference
For more information about how to make the above settings, see “Configuring the printer for the
Network”, Setup Guide.

If DHCP is used to assign IP addresses, see Appendix, “When Using DHCP”, Administrator Ref-
erence.

To use IP over 1394, see Setup Guide.

& Note
3 After setting the IP address, use the ping command to check it is set correctly.
@ Click [Start], point to [All Programs], point to [Accessories], and then click [Command Prompt].

@ Enter the following: (Example: IP address is 192.168.15.16)
C:> ping 192.168.15.16
If the address is configured correctly, the following message appears:
Reply from 192.168.15.16 : bytes=32 time<lOms TTL=32
If the address is configured incorrectly, the following message appears:
Request timed out.

< Configuring a Windows XP and Windows Server 2003 computer
Follow the procedure below to configure a Windows XP and Windows Server 2003 computer to use
TCP/1P:

@® On the [Start] menu, point to [Control Panel], and then click [Network Connections].
@ Click [Local Area Connection].
® On the [File] menu, click [Properties].

& Note
3 When using IP over 1394, click [1394 Connection].
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@ Check “Internet Protocol (TCP/IP)” is selected in the [This connection uses the following items:]
box on the [General] tab.

& Note
O If the check box for TCP/IP is not selected, select it.

3 If TCP/IP is not installed, click [Install...] on the [General] tab and install it. For more information
about installing TCP/IP, see Windows XP or Windows Server 2003 Help.

® Configure TCP/IP with the appropriate IP address, subnet mask and other settings.
Check the settings are correct with the network administrator.

Installing Software

= Preparation
If you are not using a print server, install SmartDeviceMonitor for Client, and then install the printer
driver by selecting “SmartDeviceMonitor for Client”. This enables peer-to-peer network printing via
TCP/IP, NetBEUI, or IPP.

Installing SmartDeviceMonitor for Client

n Quit all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

& Note

3 Auto Run might not work automatically due to certain operating system settings. If this is the
case, launch “Setup.exe” located in the CD-ROM root directory.

l y
,//



Printer Client Reference

B Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

ﬂ Click [SmartDeviceMonitor for Client/Admin].

B The software license agreement appears in the [License Agreement] dialog box.
After reading through the content, click [| accept the agreement.] to agree with the license agree-
ment, and then click [Next>].

E Select the [SmartDeviceMonitor for Client] check box, and then click [Next >].

ﬂ Follow the instructions on the screen.

& Note

3 If you are required to restart the computer after the installation of SmartDeviceMonitor for Client,
restart and continue configuration.

Installing the PCL 5c¢ or RPCS Printer Driver

n Quit all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.
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{¥Important

3 Never have two versions of the same printer driver installed on your system at the same time.
When upgrading to a new version of the printer driver, delete the old version, and then install the
new one.

& Note
3 Auto Run might not work automatically due to certain operating system settings. If this is the

case, launch “Setup.exe” located in the CD-ROM root directory.
B Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

ﬂ Click [PCL/RPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog box.

After reading through the content, click [| accept the agreement.] to agree with the license agree-
ment, and then click [Next>].

E In the [Select Program] dialog box, select the printer drivers you want to use, and then click
[Next>].

You can select more than one printer driver.

ﬂ Select the [Printer Name] check box to select the printer model(s) you want to use.
To change the printer name, use the [Change settings for 'Printer Name'] box.



Printer Client Reference

B Double-click the printer name to display its settings.

& Note
3 The details shown for [Comment], [Driver], and [Port] vary depending on the operating system be-
ing used, model of printer selected, and port being used.

ﬂ Click [Port], and then click [Add] in the [Change settings for 'Port'] box.

m The next part of the procedure depends on the port in use. Follow the section that corresponds
to the port you want to use.

¢ SmartDeviceMonitor
e Standard TCP/IP Port
e LPR Port

SmartDeviceMonitor

@ Select [SmartDeviceMonitor], and then click [OK].
@ Select the printer you want to use.

< TCP/IP

@ Click [TCP/IP], and then click [Search].
Available printers will be listed.

@ Click the printer you want to use, and then click [OK].

& Note

3 Printers that respond to an IP broadcast from the computer will be displayed. To print to a
printer not listed here, click [Specify Address], and then enter the printer's IP address or host
name.

3 You can set a port using TCP/IP and the IEEE 1394 (IP over 1394) interface. D‘/
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& IPP
@ Click [IPP].
The IPP setting dialog box appears.

@ To specity the IP address of the printer, type "http://printer's-ip-address/ printer" in the
[Printer URL] box.

& Note

3 If you have configured SSL (secure sockets layer) encryption and have issued the
server certificate, enter "https://<printer's IP address>/printer". Internet Explorer 5.01
or later must be installed on the computer.

(Example IP address is 192.168.15.16)

https://192.168.15.16/printer

® If necessary, enter the names to distinguish the printer in the [IPP Port Name] box. Enter a
different name from those of existing port names.
If you do not do this, the address entered in the [Printer URL] box will be set as the IPP port
name.

@ If a proxy server and IPP user name are used, click [Detailed Settings], and then configure
the necessary settings.

& Note
3 For more information about these settings, see SmartDeviceMonitor for Client Help.

® Click [OK].

Standard TCP/IP Port

@ Select [Standard TCP/IP], and then click [OK].
@ In the [Add Standard TCP/IP Printer Port Wizard] window, click [Next>].

© In the [Printer Name or IP Address] box, enter the printer name or IP address, and then click ;
[Next>]. y
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O In the [Add Standard TCP/IP Printer Port Wizard] window, click [Finish].

LPR Port

@ Select [LPR Port], and then click [OK].
@ In the [Name or address of server providing Ipd] box, enter the printer's IP address.
© In the [Name of printer or print queue on that server] box, enter “Ip”.

m Make sure the location for the selected printer is displayed after [Port].

m Configure the default printer as necessary.

+ Default Printer
Select the [Default Printer] check box to set the printer as the default printer.

[B Click [Continue] to start printer driver installation.

& Note

O During installation, the [Hardware Installation] dialog box may appear. If this happens, click [Con-
tinue Anyway] to continue the installation.

m When the [Select Program] dialog box appears, click [Finish].
[B When the [Installation completion.] dialog box appears, click [Finish].
m Set up the options.

& Note

3 You must set up the options when bidirectional transmission is disabled. For more information
about bidirectional transmission status, see p.116 “Bidirectional transmission”.
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A Reference
For more information about option settings, see p.115 “Setting Up Options”.

Installing the PostScript Printer Driver

n Quit all applications that are running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

{¥Important

3 Never have two versions of the same printer driver installed on your system at the same time.
When upgrading to a new version of the printer driver, delete the old version, and then install the
new one.

& Note
3 Auto Run might not work automatically due to certain operating system settings. If this is the
case, launch “Setup.exe” located in the CD-ROM root directory.

B Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

& Note
3 The printer driver with the selected language will be installed. The printer driver will be installed
in English if you select the following languages: Cestina, Magyar, Polski, Portugues, Suomi

l y
,//
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ﬂ Click [PostScript 3 Printer Driver].
“Add Printer Wizard” starts.

B Click [Next >].
E Click [Local printer attached to this computer], and then click [Next>].
ﬂ Click [Create a new port:].

B The next part of the procedure depends on the port in use. Follow the section that corresponds
to the port you want to use.

¢ SmartDeviceMonitor
e Standard TCP/IP Port
e LPR Port

SmartDeviceMonitor

@ Select [SmartDeviceMonitor], and then click [Next>].
@ Select the printer you want to use.

< TCP/IP

@ Click [TCP/IP], and then click [Search].
Available printers will be listed.

@ Click the printer you want to use, and then click [OK].
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& Note

3 Printers that respond to an IP broadcast from the computer will be displayed. To print to a
printer not listed here, click [Specify Address], and then enter the printer's IP address or host
name.

3 You can set a port using TCP/IP and the IEEE 1394 (IP over 1394) interface.

& IPP
@ Click [IPP].
The IPP setting dialog box appears.

® To specify the printer's IP address, enter “http://(printer's-ip-address)/printer” in the [Print-
er URL] box.

& Note

3 If you have configured SSL (secure sockets layer) encryption and have issued the
server certificate, enter "https://<printer's IP address>/printer". Internet Explorer 5.01
or later must be installed on the computer.

(Example: IP address is 192.168.15.16)

https://192.168.15.16/printer

® If necessary, enter the names to distinguish the printer in the [IPP Port Name] box. Enter a
different name from those of existing port names.
If you do not do this, the address entered in the [Printer URL] box will be set as the IPP port
name.

@ If a proxy server and IPP user name are used, click [Detailed Settings], and then configure
the necessary settings.

& Note
3 For more information about these settings, see SmartDeviceMonitor for Client Help.

® Click [OK].

g
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Standard TCP/IP Port

@ Select [Standard TCP/IP], then click [Next>].
@ In the [Add Standard TCP/IP Printer Port Wizard] window, click [Next>].

© In the [Printer Name or IP Address] box, enter the printer name or IP address, and then click
[Next>].

O In the [Add Standard TCP/IP Printer Port Wizard] window, click [Finish].

LPR Port

@ Select [LPR Port], and then click [Next>].
@ In the [Name or address of server providing Ipd] box, enter the printer's IP address.
© In the [Name of printer or print queue on that server] box, enter “Ip”.

g Confirm to select the name of the printer whose driver you want to install, and then click [Next >].

m Change the name of the printer if you want, and then click [Next >].
Configure the default printer as necessary. Click [Yes] to set the printer as the default printer.

m Click [Next >].
m Select whether or not you want to print a test page, and then click [Next>].
[B Click [Finish].

Printer driver installation starts.

& Note

3 During installation, the [Hardware Installation] dialog box may appear. If this happens, click [Con-
tinue Anyway] to continue the installation.
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m Set up the options.

/A Reference
For more information about option settings, see p.115 “Setting Up Options”.

Changing Port Settings

Follow the procedure below to change SmartDeviceMonitor for Client settings, such as proxy server
settings or IPP URL.

n In the [Printers and Faxes] window, click the icon of the printer you want to use. On the [File]
menu, click [Properties].

ﬂ Click the [Ports] tab, and then click [Configure Port...].
The [Port Configuration:] dialog box appears.
* For TCP/IP, you can configure Timeout Settings.

& Note
3 If you cannot set items on the [Recovery/Parallel Printing] tab, follow the procedure below:

@ Click [Cancel] to close the [Port Configuration:] dialog box.

@ Start SmartDeviceMonitor for Client, and then right-click the SmartDeviceMonitor for Cli-
ent icon on the taskbar.

® Click [Extended Features Settings], and then select the [Set Recovery/Parallel Printing for each
port] check box.

@ Click [OK] to close the [Extended Features Settings] dialog box.
» For IPP, you can configure User Settings, Proxy Settings and Timeout Settings.

& Note
3 For more information about these settings, see SmartDeviceMonitor for Client Help.

I_'/ z
,//



Printer Client Reference

Printing via Parallel Connection

= Preparation
To use a printer connected to the parallel interface, select “LPT1:” when installing the printer driver.

Installing the PCL 5c or RPCS Printer Driver

n Quit all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

i%klmportant

3 Never have two versions of the same printer driver installed on your system at the same time.
When upgrading to a new version of the printer driver, delete the old version, and then install the
new one.

& Note
3 Auto Run might not work automatically due to certain operating system settings. If this is the
case, launch “Setup.exe” located in the CD-ROM root directory.

B Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

ﬂ Click [PCL/RPCS Printer Drivers].
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B The software license agreement appears in the [License Agreement] dialog box.

After reading through the content, click [l accept the agreement.] to agree with the license agree-
ment, and then click [Next>].

E In the [Select Program] dialog box, select the printer drivers you want to use, and then click
[Next>].

You can select more than one printer driver.

ﬂ Select the [Printer Name] check box for the model(s) of printer you want to use.
To change the printer name, use the [Change settings for 'Printer Name'] box.

B Double-click the printer name to display its settings.

& Note

3 The details shown for [Comment], [Driver], and [Port] vary depending on the operating system be-
ing used, model of printer selected, and port being used.

g Confirm that [LPT1:] is shown for [Port].

[m Configure the default printer as necessary.

< Default Printer
Select the [Default Printer] check box to set the printer as the default printer.

m Click [Continue] to start printer driver installation.

m When the [Select Program] dialog box appears, click [Finish].

[B When the [Installation completion.] dialog box appears, click [Finish].
m Set up the options.
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& Note

3 You must set up the options when bidirectional transmission is disabled.

3 For more information about bidirectional transmission status, see p.116 “Bidirectional transmis-
sion”.

/~ Reference
For more information about option settings, see p.115 “Setting Up Options”.

Installing the PostScript Printer Driver

n Quit all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

ﬂlmportant

3 Never have two versions of the same printer driver installed on your system at the same time.
When upgrading to a new version of the printer driver, delete the old version, and then install the
new one.

& Note
3 Auto Run might not work automatically due to certain operating system settings. If this is the
case, launch “Setup.exe” located in the CD-ROM root directory.

B Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

l y
,//



Printer Client Reference

& Note

O The printer driver with the selected language will be installed. The printer driver will be installed
in English if you select the following languages: Cestina, Magyar, Polski, Portugues, Suomi

ﬂ Click [PostScript 3 Printer Driver].
“Add Printer Wizard” starts.

B Click [Next>].
E Click [Local printer attached to this computer], and then click [Next>].

ﬂ Click the port you want to use, and then click [Next>].
A dialog box for selecting the printer manufacturer and model name appears.

B Select the name of the printer whose driver you want to install, and then click [Next>].
g Change the name of the printer if you want, and then click [Next>].

[m Select whether or not you want to print a test page, and then click [Finish].
Printer driver installation starts.

& Note

O During installation, the [Hardware Installation] dialog box may appear. If this happens, click [Con-
tinue Anyway] to continue the installation.

m Set up the options.

/A Reference
For more information about option settings, see p.115 “Setting Up Options”.

m Restart the computer.
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Installing the Printer Driver Using USB

This section gives basic instructions for installing the printer drivers using USB. The printer drivers can
be installed from the provided CD-ROM.

1¥Important
3O Make sure all other applications are closed and the computer is not currently printing prior to instal-
lation.

Windows XP, Windows Server 2003 - Installing the Printer Driver Using
USB

? Limitation

O Installing a printer driver requires Administrator permission. When you install a printer driver, log on
using an account that has Administrator permission.

When the USB cable is used for the first time, the [Found New Hardware Wizard] dialog box appears,

and Windows XP or Windows Server 2003's [USB Printing Support] will automatically install.

If the printer driver is already installed, the “plug and play” window appears, and the printer with its
port directed to the USB cable is added to the [Printers and Faxes] folder.

With Windows XP or Windows Server 2003, even if the printer driver has already been installed,
[Found New Hardware Wizard] may start when connecting the printer and the computer with the USB
cable for the first time. In this case, install the printer driver by following the procedure below.

n Install the printer driver by referring to the instructions for installing the printer driver with
Parallel/Ethernet connection.

When installation is complete, the printer with its port directed to “USB0On” appears on the [Print-
ers and Faxes] folder. (“n” is the number of printers connected.)
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Installing the Printer Driver Using IEEE 1394

This section gives basic instructions for installing the printer drivers using the IEEE 1394 interface. The
printer drivers can be installed from the provided CD-ROM.

{¥Important
3O Make sure all other applications are closed and the computer is not currently printing prior to instal-
lation.

Printing via SCSI print

Printing using a SCSI print device with the optional IEEE 1394 interface board is possible under Win-
dows XP or Windows Server 2003.

{¥Important

3 Do not connect new IEEE 1394 or USB devices to the computer or turn on another printer while in-
stalling the printer driver.

O Before uninstalling the printer driver, be sure to disconnect the IEEE 1394 interface cable from the
computer.

3 “SCSI print” must be set to active from the control panel. For more information, see “IEEE 1394 Con-
figuration”, Setup Guide.

& Note

3 The printer cannot receive print data from more than one computer at the same time. If you send
data from your computer when data is being received from another, an error message may appear
on the computer display.
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Installing the Printer Driver

& Note

3 If you want to install another printer driver after setting the “1394_00n” port, select the “1394_00n”
port by following the procedure for installing a printer driver.

O When the printer connected via the optional IEEE 1394 interface board is installed properly, the icon
in the printer folder changes depending on whether the cable is attached or not.

n Connect the printer and computer using the IEEE 1394 interface cable.

EI In the [Found New Hardware Wizard] dialog box, confirm that [This wizard helps you install soft-
ware for: (Unknown)] is displayed, and click [Install from a list or specific location (Advanced)], and
then click [Next>].

B When [Please choose your search and installation options.] appears, select the [Search for the best
driver in these locations.] check box, then select the [Include this location in the search:] check box.

ﬂ Hold down the left [SHIFT] key, and then insert the CD-ROM into the CD-ROM drive.

& Note
O Keep the left [SHIFT] key held down until the computer has finished accessing the CD-ROM.
3 If the Auto Run program starts, click [Cancel], and then click [Exit].

B Click [Browse].

B Select the printer driver you want to use. The following are locations on the CD-ROM where
printer drivers are stored:

* RPCS
\DRIVERS\RPCS\WIN2K _XP\(Language)\DISK1

 PCL 5¢
\DRIVERS\PCL5C\WIN2K_XP\(Language)\DISK1 I



Operating Instructions

PostScript 3
\DRIVERS\PS\WIN2K _XP\(Language)\DISK1

1 ciick [0k

A printer model selection dialog box appears.

B Follow the instructions on the screen.

& Note

a

a

a

When installation is complete, the printer with its port directed to “1394_00n” appears on the
[Printers and Faxes] folder. (“n” is the number of printers connected.)

If the printer driver is already installed, the printer icon is automatically added to the [Printers and
Faxes] folder. In this case, installation is not necessary.

Even if the printer driver has already been installed, [Found New Hardware Wizard] may start when
connecting the printer and the computer with the IEEE 1394 interface cable for the first time. In
this case, install the printer driver by following the procedure.

If printing does not work properly after installation, you need to delete the port and reinstall the
printer driver. For more information, see “Printer Does Not Print”, Maintenance Guide.

If you do not want to install the printer driver when [Found New Hardware Wizard] starts when using

an operating system that supports SCSI print, inactivate the device by following this procedure:

® In the [Found New Hardware Wizard] dialog box, check [This wizard helps you install software
for: (Unknown)] is displayed, click [Install from a list or specific location (Advanced)], and then
click [Next>].

@ When [Please choose your search and installation options.] appears, remove all selections
from [Search for the best driver in these locations.], and then click [Next>].

® If [The wizard could not find the software on your computer for...] appears, click [OK].

@ If the [Cannot Install this Hardware] message appears, select the [Don't prompt again to install
the software] check box, and then click [Finish].

113

|
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Printing via IP over 1394

You can print by setting the IP address for the printer and the computer on which Windows XP or Win-
dows Server 2003 is installed.

] Preparation
“IP over 1394” must be set on the control panel and an IP address for the IEEE 1394 (IP over 1394)
interface must be specified.

For more information about how to make printer settings, see “IEEE 1394 Configuration”, Setup
Guide.

? Limitation
3O When using the IEEE 1394 (IP over 1394) interface in a network, the Ethernet interface cannot be
used on the same network.

& Note

3 The maximum number of simultaneous print requests when connecting with IP over 1394 includes
requests via Ethernet interface. For more information, see Administrator Reference.

Installing the Printer Driver

To print using SmartDeviceMonitor, see p.93 “Printing without a Print Server”.
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Setting Up Options

You must set up options when bidirectional transmission is disabled.

& Note
3 The description uses the PCL 5c printer driver.

l] On the [Start] menu, and then click [Printers and Faxes].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.
B On the [File] menu, click [Properties].
ﬂ Click the [Accessories] tab.

& Note
O If you are using the RPCS printer driver, click the [Change Accessories] tab.
3 If you are using the PostScript 3 printer driver, click the [Device Settings] tab.

B In the [Options] box, select the options you have installed. Make any necessary settings.

& Note
3 If you are using the RPCS printer driver, select the options from [Select printer options:].
3 If you are using the PostScript 3 printer driver, select the options from [Installable Options].

3 ciick [0k
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{Bidirectional transmission

When bidirectional transmission is enabled, information about paper size and feed direction settings is
automatically sent to the printer by the computer. You can also check printer status from your compu-
ter.

* Bidirectional transmission is supported by Windows 95/98/Me/2000/XP, Windows Server 2003,
and Windows NT 4.0.

* If you use the RPCS printer driver and bidirectional transmission is enabled, under Windows XP or
Windows Server 2003, the [Change Accessories] tab is shaded, and cannot be used.

& Note

3O The RPCS printer driver supports bidirectional transmission and updates the printer status automat-
ically.

O The PCL 5c printer driver supports bidirectional transmission; you can update the printer status
manually.

O The PostScript 3 printer driver does not support bidirectional transmission.
Bidirectional transmission requires the following conditions:

< When connecting via parallel cable
* The computer must support bidirectional transmission.
* The printer must be set to bidirectional transmission.
* The Interface cable must support bidirectional transmission.

* The printer must be connected to the computer using standard parallel cable and parallel connec-
tor.

* Under Windows XP or Windows Server 2003, [Enable bidirectional support] must be selected
and [Enable printer pooling] must not be selected on the [Ports] tab with RPCS printer driver.
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< When connecting with the network
* The printer must be set to bidirectional transmission.

¢ SmartDeviceMonitor for Client included on the CD-ROM must be installed, and TCP/IP must
be used.

* Under Windows XP or Windows Server 2003, [Enable bidirectional support] must be selected
and [Enable printer pooling] must not be selected on the [Ports] tab with RPCS printer driver.

< When connecting with IEEE 1394

* The printer must be connected to the IEEE 1394 connector of a computer using the IEEE 1394
interface cable.

* On the printer's control panel, [Active] is selected in the SCSI print of IEEE 1394 and [On] is se-
lected in the Bidi-SCSI print.

e Under Windows XP or Windows Server 2003, [Enable bidirectional support] must be selected
and [Enable printer pooling] must not be selected on the [Ports] tab with RPCS printer driver.

< When connecting with USB
The printer must be connected to the computer's USB connector using the USB interface cable.
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4. Windows NT 4.0 Configuration

Printing Using a Print Server

Printing Using a Windows 2000/XP, Windows Server 2003, or Windows
NT 4.0 Print Server

This section describes procedures for setting up a client in a network using Windows 2000/XP, Win-
dows Server 2003, or Windows NT 4.0 as a print server.

Printing from Windows NT 4.0, you must install the printer driver and change the printer port connec-
tion to the print server.

Windows 2000/XP
Windows Server 2003
Windows NT 4.0

Print Server

o
—

/

~>
S|
Windows NT 4.0

ACE072S
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Installing the PCL 5c or RPCS Printer Driver

] Preparation

4
u|

To use the print server, install the printer driver by selecting “Network printer server”, and then select
the Windows 2000/XP, Windows Server 2003, or Windows NT 4.0 shared printer. For more infor-
mation about how to install and settings, see Administrator Reference.

This section assumes the client has already been configured to communicate with a Windows
2000/XP, Windows Server 2003, or Windows NT 4.0 print server. Do not begin the following proce-
dure until the client is set up and configured correctly.

Limitation
When using a print server connected to the printer via SmartDeviceMonitor for Client, you cannot
use Recovery Printing and Parallel Printing.

n Quit all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.

Auto Run will start the installer.

i!klmportant

3 Never have two versions of the same printer driver installed on your system at the same time.
When upgrading to a new version of the printer driver, delete the old version, and then install the
new one.

& Note

3 Auto Run might not work automatically due to certain operating system settings. If this is the
case, launch “Setup.exe” located in the CD-ROM root directory.

l y
,//
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B Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

ﬂ Click [PCL/RPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog box.

After reading through the content, click [| accept the agreement.] to agree with the license agree-
ment, and then click [Next>].

E In the [Select Program] dialog box, select the printer drivers you want to use, and then click
[Next>].

You can select more than one printer driver.

ﬂ Select the [Printer Name] check box for the model(s) of printer you want to use.
To change the printer name, use the [Change settings for 'Printer Name'] box.

m Double-click the printer name to display its settings.

& Note

3 The details shown for [Comment], [Driver], and [Port] vary depending on the operating system be-
ing used, model of printer selected, and port being used.

g Click [Port], and then click [Add].
m Click [Network Printer], and then click [OK].

m Double-click the computer name you want to use as the print server in the [Browse for Printer]
window.
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m Select the printer you want to use, and then click [OK].
[B Make sure the location for the selected printer is displayed after [Port].

m Configure the default printer as necessary.

+ Default Printer
Select the [Default Printer] check box to set the printer as the default printer.

[B Click [Continue] to start printer driver installation.

m When the [Select Program] dialog box appears, click [Finish].

[ﬂ When the [Installation completion.] dialog box appears, click [Finish].
m Set up the options.

& Note

3 You must set up the options when bidirectional transmission is disabled. For more information
about bidirectional transmission status, see p.143 “Bidirectional transmission”.

A Reference
For more information about option settings, see p.143 “Setting Up Options”.

Installing the PostScript Printer Driver

n Quit all applications that are running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.
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{¥Important

3 Never have two versions of the same printer driver installed on your system at the same time.
When upgrading to a new version of the printer driver, delete the old version, and then install the
new one.

& Note
3 Auto Run might not work automatically due to certain operating system settings. If this is the

case, launch “Setup.exe” located in the CD-ROM root directory.
B Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

& Note

3 The printer driver with the selected language will be installed. The printer driver will be installed
in English if you select the following languages: Cestina, Magyar, Polski, Portugues, Suomi

ﬂ Click [PostScript 3 Printer Driver].
“Add Printer Wizard” starts.

B Click [Next>].
E Click [Network printer server], and then click [Next>].

ﬂ Double-click the computer name you want to use as the print server in the [Shared printers:]
box.

B Select the printer you want to use, and then click [OK].
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g Change the name of the printer if you want, and then click [Next>].
Configure the default printer as necessary. Click [Yes] to set the printer as the default printer.

m Change the name of the printer if you want, and then click [Next>].

m Select whether or not you want to print a test page, and then click [Finish].
The installation is complete.

m Restart the computer.
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Printing without a Print Server

= Preparation
To use a printer connected to the Ethernet interface, select “SmartDeviceMonitor” or “LPR Port”
when installing the printer driver.

» For SmartDeviceMonitor, see p.124 “Configuring Protocols”, p.127 “Installing Software”, p.129
“Installing the PCL 5c or RPCS Printer Driver”, and p.133 “Installing the PostScript Printer Driv-

er.

+ For LPR Port, see p.124 “Configuring Protocols”, p.129 “Installing the PCL 5c¢ or RPCS Printer
Driver”, and p.133 “Installing the PostScript Printer Driver”.

& Note

O If you want to use “LPR Port”, “Microsoft TCP/IP Printing” must be installed. For details, see
Windows NT Help.

Configuring Protocols

Configuring TCP/IP and IPP for Printing

Follow these instructions to configure the printer and Windows NT 4.0 to use TCP/IP and IPP.

< Configuring the printer
Configure the printer to use TCP/IP.
¢ Check TCP/IP is set to active. (The default is active.)

* Assign an IP address and make other settings required for using TCP/IP.
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A Reference
For more information about how to make the above settings, see “Configuring the printer for the
Network”, Setup Guide.
If DHCP is used to assign IP addresses, see Appendix, “When Using DHCP”, Administrator Ref-
erence.

& Note
3 After setting the IP address, use the ping command to check it is set correctly.
@ Click [Start], point to [Programs], and then click [Command Prompt].
@ Enter the following: (Example: IP address is 192.168.15.16)
C:> ping 192.168.15.16
If the address is configured correctly, the following message appears:
Reply from 192.168.15.16 : bytes=32 time<lOms TTL=32
If the address is configured incorrectly, the following message appears:
Request timed out.

% Configuring a Windows NT 4.0 computer
Follow the procedure below to configure a Windows NT 4.0 computer to use TCP/IP:
@® Open [Control Panel], and then double-click the [Network] icon. Confirm that “TCP/IP Protocol”
is listed in the [Network protocols] box under the [Protocols] tab.

& Note
3 If TCP/IP is not installed, click [Add...] under the [Protocols] tab, and then install it. For more
information about installing TCP/IP, see Windows NT 4.0 Help.
@ Configure TCP/IP with the appropriate IP address, subnet mask and other settings.
Check the settings are correct with the network administrator.
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® Click the [Services] tab, and check “Microsoft TCP/IP Printing” is installed.
If “Microsoft TCP/IP Printing” is not installed, click [Add...] under the [Services] tab, and install

it. For more information about installing and configuring network services, see Windows NT 4.0
Help.

Configuring NetBEUI for Printing

Follow these instructions to configure the printer and Windows NT 4.0 to use NetBEUIL

] Preparation
To use NetBEUI, use the SmartDeviceMonitor for Client port.

% Configuring the printer
Configure the printer to use NetBEUI.
¢ Check NetBEUTI is set to active. (The default is active.)

ye Reference

For more information about how to make the above settings, see “Configuring the printer for the
Network”, Setup Guide.

% Configuring a Windows NT 4.0 computer
Install NetBEUI on the Windows NT 4.0 computer, and change the LAN adapter number (Lana
Number).
@® Open [Control Panel] and double-click the [Network] icon. Check “NetBEUI Protocol” is listed
in the [Network Protocols] box under the [Protocols] tab.

& Note

3 If NetBEUI is not installed, click [Add...] under the [Protocols] tab, and install it. For more infor-
mation about installing NetBEUI, see Windows NT 4.0 Help.

l y
,//
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@ Change the Lana Number. Click the [Services] tab, click “NetBIOS Interface” in the [Network
Services:] box, and then click [Properties...].

® Click the Lana Number corresponding to the Nbf protocol of the [Network Route] column, and
then click [Edit].

@ Enter “0” as the Lana Number.

& Note
3 If another protocol’s Lana Number is configured as “0”, change it to another number.

® Click [OK].
® Click [Close], and then close the [Network] dialog box.
@ After confirming the restart message, click [Yes].

& Note
3 After you change the Lana Number, you must restart the computer.

Installing Software

] Preparation
If you are not using a print server, install SmartDeviceMonitor for Client, and then install the printer
driver by selecting “SmartDeviceMonitor for Client”. This enables peer-to-peer network printing via
TCP/IP, NetBEUI, or IPP.

Installing SmartDeviceMonitor for Client

n Quit all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.
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{¥Important

3 Never have two versions of the same printer driver installed on your system at the same time.
When upgrading to a new version of the printer driver, delete the old version, and then install the
new one.

& Note
3 Auto Run might not work automatically due to certain operating system settings. If this is the

case, launch “Setup.exe” located in the CD-ROM root directory.
B Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

ﬂ Click [SmartDeviceMonitor for Client/Admin].

B The software license agreement appears in the [License Agreement] dialog box.

After reading through the content, click [| accept the agreement.] to agree with the license agree-
ment, and then click [Next>].

E Select the [SmartDeviceMonitor for Client] check box, and then click [Next >].
ﬂ Follow the instructions on the screen.

& Note

O If you are required to restart the computer after the installation of SmartDeviceMonitor for Client,
restart and continue configuration.
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Installing the PCL 5c or RPCS Printer Driver

n Quit all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

ﬂlmportant

3 Never have two versions of the same printer driver installed on your system at the same time.
When upgrading to a new version of the printer driver, delete the old version, and then install the
new one.

& Note
3 Auto Run might not work automatically due to certain operating system settings. If this is the
case, launch “Setup.exe” located in the CD-ROM root directory.

B Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

ﬂ Click [PCL/RPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog box.

After reading through the content, click [| accept the agreement.] to agree with the license agree-
ment, and then click [Next>].
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E In the [Select Program] dialog box, select the printer drivers you want to use, and then click
[Next>].

You can select more than one printer driver.

ﬂ Select the [Printer Name] check box to select the printer model(s) you want to use.
To change the printer name, use the [Change settings for 'Printer Name'] box.

B Double-click the printer name to display its settings.

& Note
3 The details shown for [Comment], [Driver], and [Port] vary depending on the operating system be-
ing used, model of printer selected, and port being used.

ﬂ Click [Port], and then click [Add] in the [Change settings for 'Port'] box.

m The next part of the procedure depends on the port in use. Follow the section that corresponds
to the port you want to use.

¢ SmartDeviceMonitor
e LPR Port

SmartDeviceMonitor

@ Select [SmartDeviceMonitor], and then click [OK].
@ Select the printer you want to use.

< TCP/IP

@ Click [TCP/IP], and then click [Search].
Available printers will be listed.

@ Click the printer you want to use, and then click [OK].
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& Note

3 Printers that respond to an IP broadcast from the computer will be displayed. To print to a
printer not listed here, click [Specify Address], and then enter the printer's IP address or host
name.

+ NetBEUI

@® Click [NetBEUI], and then click [Search].
A list of printers that can be used with NetBEUI appears.

@ Click the printer you want to use, and then click [OK].

& Note

3 Printers that respond to a broadcast from the computer will be displayed. To print to a
printer not listed here, click [Specify Address], and then enter the NetBEUI address. Confirm
the NetBEUI network address is on the configuration page. For more information about
printing the configuration page, see “Printing a Configuration Page”, Administrator Refer-
ence. NetBEUI address appears as “\\RNPxxxx\xxx” on the configuration page. Enter the
printer's network path name in the form of “%%Computer name\Share name”. Do not en-
ter “\\” as head characters but “%%".

3 You cannot print to printers beyond routers.

< IPP
® Click [IPP].
The IPP settings dialog box appears.

@ To specify the IP address of the printer, type "http://printer's-ip-address/ printer" in the
[Printer URL] box.

& Note

3 If you have configured SSL (secure sockets layer) encryption and have issued the
server certificate, enter "https://<printer's IP address>/printer". Internet Explorer 5.01

or later must be installed on the computer. l y
,//
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(Example IP address is 192.168.15.16)
https://192.168.15.16/printer

® If necessary, enter the names to distinguish the printer in the [IPP Port Name] box. Enter a
different name from those of existing port names.
If you do not do this, the address entered in the [Printer URL] box will be set as the IPP port
name.

@ If a proxy server and IPP user name are used, click [Detailed Settings], and then configure
the necessary settings.

& Note
3 For more information about these settings, see SmartDeviceMonitor for Client online
Help.

® Click [OK].

LPR Port

© Select [LPR Port], and then click [OK].
@ In the [Name or address of server providing Ipd:] box, enter the printer's IP address.
© In the [Name of printer or print queue on that server:] box, enter “Ip”.

m Make sure the location for the selected printer is displayed after [Port].

m Configure the default printer as necessary.

+ Default Printer
Select the [Default Printer] check box to set the printer as the default printer.

[B Click [Continue] to start printer driver installation.

m When the [Select Program] dialog box appears, click [Finish].
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[B When the [Installation completion.] dialog box appears, click [Finish].

m Set up the options.

& Note
3 You must set up the options when bidirectional transmission is disabled. For more information
about bidirectional transmission status, see p.143 “Bidirectional transmission”.

/~ Reference
For more information about option settings, see p.143 “Setting Up Options”.

Installing the PostScript Printer Driver

n Quit all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

i@klmportant

3 Never have two versions of the same printer driver installed on your system at the same time.
When upgrading to a new version of the printer driver, delete the old version, and then install the
new one.

& Note
3 Auto Run might not work automatically due to certain operating system settings. If this is the
case, launch “Setup.exe” located in the CD-ROM root directory.

g
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B Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

& Note

O The printer driver with the selected language will be installed. The printer driver will be installed
in English if you select the following languages: Cestina, Magyar, Polski, Portugues, Suomi

ﬂ Click [PostScript 3 Printer Driver].
“Add Printer Wizard” starts.

B click Nexts.
[ ciick [Add Port....

ﬂ The next part of the procedure depends on the port in use. Follow the section that corresponds
to the port you want to use.

¢ SmartDeviceMonitor
e LPR Port

SmartDeviceMonitor

@ Select [SmartDeviceMonitor], and then [New Port...].
@ Select the printer you want to use.

% TCP/IP

@ Click [TCP/IP], and then click [Search].
Available printers will be listed.
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@ Click the printer you want to use, and then click [OK].

& Note

3 Printers that respond to an IP broadcast from the computer will be displayed. To print to a
printer not listed here, click [Specify Address], and then enter the printer's IP address or host
name.

< NetBEUI
@ Click [NetBEUI], and then click [Search].
A list of printers that can be used with NetBEUI appears.

@ Click the printer you want to use, and then click [OK].

& Note

3 Printers that respond to a broadcast from the computer will be displayed. To print to a
printer not listed here, click [Specify Address], and then enter the NetBEUI address. Confirm
the NetBEUI network address is on the configuration page. For more information about
printing the configuration page, see “Printing a Configuration Page”, Administrator Refer-
ence. NetBEUI address appears as “\RNPxxxx\xxx” on the configuration page. Enter the
printer's network path name in the form of “%%Computer name\Share name”. Do not en-
ter “\\” as head characters but “%%".

3 You cannot print to printers beyond routers.

& IPP
® Click [IPP].
The IPP setting dialog box appears.

@® To specify the printer's IP address, enter “http://(printer's-ip-address)/printer” in the [Print-
er URL] box.
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& Note

3 If you have configured SSL (secure sockets layer) encryption and have issued the
server certificate, enter "https://<printer's IP address>/printer". Internet Explorer 5.01
or later must be installed on the computer.

(Example: IP address is 192.168.15.16)

https://192.168.15.16/printer

® If necessary, enter the names to distinguish the printer in the [IPP Port Name] box. Enter a
different name from those of existing port names.
If you do not do this, the address entered in the [Printer URL] box will be set as the TPP port
name.

@ If a proxy server and IPP user name are used, click [Detailed Settings] and configure the
necessary settings.

& Note
O For more information about these settings, see SmartDeviceMonitor for Client Help.

® Click [OK].

LPR Port

@ Select [LPR Port], and then click [New Port...].
@ In the [Name or address of server providing Ipd:] box, enter the printer's IP address.
© In the [Name of printer or print queue on that server:] box, enter “Ip”.

B Confirm to select the name of the printer whose driver you want to install, and then click
[Next >].

g Change the name of the printer if you want, and then click [Next >].
Configure the default printer as necessary. Click [Yes] to set the printer as the default printer.
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m Select whether or not you want to print a test page, and then click [Finish].
Printer driver installation starts.

m Set up the options.

& Note

3 You can specify the user code with the printer properties dialog box after installing the printer
driver. See the printer driver's Help.

~ Reference
For more information about option settings, see p.143 “Setting Up Options”.

m Restart the computer.
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Changing Port Settings

Follow the procedure below to change SmartDeviceMonitor for Client settings, such as proxy server
settings or IPP URL.

& Note
3 There are no settings for NetBEUI.

n In the [Printers] window, click the icon of the printer you want to use. On the [File] menu, click
[Properties].

ﬂ Click the [Ports] tab, and then click [Configure Port...].
The [Port Configuration:] dialog box appears.
* For TCP/IP, you can configure Timeout Settings.

& Note
O If you cannot set items on the [Recovery/Parallel Printing] tab, follow the procedure below:
@ Click [Cancel] to close the [Port Configuration:] dialog box.
@ Start SmartDeviceMonitor for Client, and then right-click the SmartDeviceMonitor for Cli-
ent icon on the taskbar.
® Click [Extended Features Settings], and then select the [Set Recovery/Parallel Printing for each
port] check box.
@ Click [OK] to close the [Extended Features Settings] dialog box.

» For IPP, you can configure User Settings, Proxy Settings and Timeout Settings.

& Note
3 For more information about these settings, see SmartDeviceMonitor for Client Help.
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Printing via Parallel Connection

= Preparation
To use a printer connected to the parallel interface, select “LPT1:” when installing the printer driver.

Installing the PCL 5c or RPCS Printer Driver

] Preparation
The target printer must be turned on before starting the installation process.

n Quit all applications that are running.

B Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

iiklmportant

3 Never have two versions of the same printer driver installed on your system at the same time.
When upgrading to a new version of the printer driver, delete the old version, and then install the
new one.

& Note
3 Auto Run might not work automatically due to certain operating system settings. If this is the
case, launch “Setup.exe” located in the CD-ROM root directory.

B Select a language for the interface, and then click [OK].
The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)
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ﬂ Click [PCL/RPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog box.

After reading through the content, click [| accept the agreement.] to agree with the license agree-
ment, and then click [Next>].

E In the [Select Program] dialog box, select the printer drivers you want to use, and then click
[Next>].

You can select more than one printer driver.

ﬂ Select the [Printer Name] check box for the model(s) of printer you want to use.
To change the printer name, use the [Change settings for 'Printer Name'] box.

B Double-click the printer name to display its settings.

& Note

3 The details shown for [Comment], [Driver], and [Port] vary depending on the operating system be-
ing used, model of printer selected, and port being used.

g Confirm that [LPT1:] is shown for [Port].

[m Configure the default printer as necessary.

< Default Printer
Select the [Default Printer] check box to set the printer as the default printer.

m Click [Continue] to start printer driver installation.
m When the [Select Program] dialog box appears, click [Finish].
[B When the [Installation completion.] dialog box appears, click [Finish].
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m Set up the options.

& Note
3 You must set up the options when bidirectional transmission is disabled. For more information
about bidirectional transmission status, see p.143 “Bidirectional transmission”.

A Reference
For more information about option settings, see p.143 “Setting Up Options”.

Installing the PostScript Printer Driver

n Quit all applications that are running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

1¥Important

3 Never have two versions of the same printer driver installed on your system at the same time.
When upgrading to a new version of the printer driver, delete the old version, and then install the
new one.

& Note
3 Auto Run might not work automatically due to certain operating system settings. If this is the
case, launch “Setup.exe” located in the CD-ROM root directory.

B Select a language for the interface, and then click [OK].
The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

I_'/ z
,//
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& Note

O The printer driver with the selected language will be installed. The printer driver will be installed
in English if you select the following languages: Cestina, Magyar, Polski, Portugues, Suomi

ﬂ Click [PostScript 3 Printer Driver].
“Add Printer Wizard” starts.

B cClick Nexts).

E Click the port you want to use, and then click [Next>].
A dialog box for selecting the printer manufacturer and model name appears.

ﬂ Select the name of the printer whose driver you want to install, and then click [Next>].

B Change the name of the printer if you want, and then click [Next>].
Configure the default printer as necessary. Click [Yes] to set the printer as the default printer.

B Grick [Next].

[m Select whether or not you want to print a test page, and then click [Finish].
Set up the options with the printer driver.

/A Reference
For more information about option settings, see p.143 “Setting Up Options”.

m Restart the computer.
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Setting Up Options

You must set up options when bidirectional transmission is disabled.
The description uses the PCL 5c printer driver.

n On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.
B On the [File] menu, click [Properties].
ﬂ Click the [Accessories] tab.

& Note
3 If you are using the RPCS printer driver, click the [Change Accessories] tab.
O If you are using the PostScript printer driver, click the [Device Settings] tab.

B In the [Options] box, select the options you have installed. Make any necessary settings.
E Click [OK].

’@Bidirectional transmission

When bidirectional transmission is enabled, information about paper size and feed direction settings is

automatically sent to the printer by the computer. You can also check printer status from your computer.

* Bidirectional transmission is supported by Windows 95/98/Me/2000/XP, Windows Server 2003,
and Windows NT 4.0.

* If you use the RPCS printer driver and bidirectional transmission is enabled, under Windows
95/98/Me, unavailable functions are shaded.

l y
,//
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& Note

O The RPCS printer driver supports bidirectional transmission and updates the printer status automat-
ically.

3O The PCL 5c printer driver supports bidirectional transmission; you can update the printer status
manually.

O The PostScript 3 printer driver does not support bidirectional transmission.

Bidirectional transmission requires the following conditions:

< When connecting via parallel cable

The computer must support bidirectional transmission.
The printer must be set to bidirectional transmission.
The Interface cable must support bidirectional transmission.

The printer must be connected to the computer using standard parallel cable and parallel connec-
tor.

Under Windows NT 4.0, [Enable bidirectional support] must be selected and [Enable printer pool-
ing] must not be selected on the [port] tab with RPCS printer driver.

< When connecting with the network

The printer must be set to bidirectional transmission.

SmartDeviceMonitor for Client included on the CD-ROM must be installed, and TCP/IP must
be used.

Under Windows NT 4.0, [Enable bidirectional support] must be selected and [Enable printer pool-
ing] must not be selected on the [port] tab with RPCS printer driver.

Under Windows NT 4.0, the IP address specified in the Microsoft TCP/IP print is used.
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5. Macintosh Configuration

This section describes how to configure Mac OS.
» If you are using Mac OS, see p.145 “Mac OS™.
* If you are using Mac OS X, see p.155 “Mac OS X".

Mac OS

This section describes how to configure Mac OS to use EtherTalk and USB. The following procedure
describes how to configure Mac OS 9.1. If you are not using Mac OS 9.1, see the manual that comes
with your version of the Mac OS for more information.

® Limitation

3 For use with Mac OS 8.6 or later. (Mac OS X Classic environment is supported.)
3 For use with a Macintosh, Power PC is required.

& Note
O The PostScript 3 printer driver is stored in the following folder on the CD-ROM:

Mac OS 8 and 9:PS Driver: (language) :Diskl
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Installing the Printer Driver and Software

] Preparation
If the AdobePS installation starts under Mac OS X, the desktop automatically changes to the Classic
environment. If you want to set a printer with Mac OS X, see p.155 “Mac OS X".

Installing the PostScript Printer Driver and PPD File

It is necessary to install a printer driver and a PPD file to print from a Macintosh.

Follow the procedure below to install a printer driver and a PPD file into a Macintosh using Mac OS
8.6 or later:

PostScript Printer Driver

n Insert the CD-ROM into the CD-ROM drive.

B Double-click the CD-ROM icon.

B Double-click the [Mac OS 8 and 9] folder.

ﬂ Double-click the [PS Driver] folder.

B Double-click the folder of the language you are using.
E Open [DISK1], and then double-click the installer icon.

ﬂ Follow the instructions on the screen.
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PPD File

n Double-click the CD-ROM icon.

B Double-click the [Mac OS 8 and 9] folder.

B Double-click the [Printer Descriptions] folder.

ﬂ Double-click the folder of the language you are using.
B Open [Disk1].

E Drag the PPD file and the Plugin file into [Printer Descriptions] in [Extensions] which is in [Sys-
tem Folder].

ﬂ Restart the Macintosh.

Setting Up the PPD File

] Preparation
Check the printer is connected to an AppleTalk network before performing the following procedure.

l] On the [Apple] menu, click [Chooser].
ﬂ Click the [Adobe PS] icon.
B In the [Select a PostScript Printer:] list, click the name of the printer you want to use.

ﬂ Click [Create].
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B Click the printer you want to use, and then click [Select].

The PPD file is set up, and the [Adobe PS] icon appears on the left of the printer name in the list.
Next, follow the procedure on p.149 “Setting Up Options” to make option settings, or close the
[Chooser] dialog box.

Creating a Desktop Printer icon

] Preparation
Check the printer is connected to the USB before performing the following procedure.
To use a printer connected via USB, create a Desktop Printer icon.

l] Double-click [Desktop Printer Utility] in the [AdobePS Components] folder.

B Click [AdobePS] in [With:] and [Printer (USB)] in [Create Desktop], and then click [OK].
B Click [Change] in [USB Printer Selection].

ﬂ Select the model you are using in [Select a USB Printer:], and then click [OK].

B Click [Auto Setup] in [PostScript™ Printer Description (PPD) File].

E Click [Create].

ﬂ Enter the printer name, and then click [Save].
The printer icon appears on the desktop.

B Exit the Desktop Printer Utility.
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Setting Up Options

l] On the [Apple] menu, click [Chooser].
B Click the [Adobe PS] icon.

B In the [Select the PostScript Printer:] list, click the name of the printer you want to use, and then
click [Setup].

ﬂ Click [Configure].
A list of options appears.

B Select the option you want to set up, and then select the appropriate setting for it.

& Note

3 If the option you want to set up is not displayed, the PPD file might not be set up correctly. Check
the name of the PPD file shown in the dialog box.

3 ciick [ox).

The list of options closes.

ﬂ Click [OK].
The [Chooser] dialog box appears.

B Close the [Chooser] dialog box.
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Installing the ColorSync profile

ColorSync profile makes it possible for the printer to print colors of similar intensity to those that ap-
pear on your computer display. You must install the ColorSync profile to use this feature.

& Note

3 The ColorSync profile complies with color characteristics as defined by the International Color Con-
sortium (ICC).

O Some computer displays may require particular settings to be controlled by ColorSync. See the doc-
umentation that comes with your display for details.

The following procedure shows how to install the ColorSync profile.
n Start the Macintosh.

ﬂ Double-click the hard disk icon, and then open the appropriate folder in which to install the
ColorSync profile.

& Note

3 The location of the appropriate folder may differ depending on operating system versions. The
following are examples:

+ System: Preferences: ColorSync profiles
+ System: ColorSync profiles

B Insert the CD-ROM into the CD-ROM drive.
The CD-ROM icon appears.

ﬂ Double-click the CD-ROM icon.
The contents of the CD-ROM appear.

B Double-click the [Mac OS 8 and 9] folder. r
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E Double-click the [ColorSync™ Profiles] folder in the CD-ROM.

ﬂ Drag the file to the [ColorSync™ Profiles] folder on the hard disk.
The ColorSync profile is installed.

Installing the Adobe Type Manager

& Note

O Close all applications that are running before the installation. Install ATM after restarting the com-
puter.

n Start the Macintosh.

ﬂ Insert the CD-ROM into the CD-ROM drive.
B Double-click the CD-ROM icon.

ﬂ Double-click the [Mac OS 8 and 9] folder.

B Double-click the [ATM] folder.

E Double-click the [ATM 4.6.2 installer] icon.

ﬂ Follow the instructions on the screen.

B When the procedure is complete, restart the computer. ATM will be completely installed only
after restarting.

ﬂ On the [Apple] menu, click [Control Panel], and then click [~ATM].
m Open the ATM control panel.
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& Note
3 For more information about installation, see the user's guide in the ATM folder.

Installing screen fonts

The screen fonts described below can be found on the CD-ROM, in the folder named [Fonts].
n Start the Macintosh.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The CD-ROM icon appears.

B Double-click the CD-ROM icon.
The contents of the CD-ROM appear.

ﬂ Double-click the [Mac OS 8 and 9] folder.
B Double-click the [Fonts] folder.
E Double-click the [Screen font] folder.

ﬂ Double- click the [TrueType] or [Type1] folder.
Select the font enter you want to use.

B Copy the fonts you want to install into [Fonts] in the [System Folder].
A Confirmation dialog box appears.

B cick [0k

The fonts are installed.

[m Restart the Macintosh.
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Using USB Interface

This section explains the setup procedure when using the printer with a USB connection.

= Preparation
Install the required files by referring to p.146 “Installing the Printer Driver and Software”.
Connect your Macintosh and the printer using a USB cable.

? Limitation
O Mac OS is compatible with the standard USB port only.

n Open the [AdobePS Component] folder on the hard disk.

ﬂ Double-click [Desktop Printer Utility].

B Click [AdobePS] in [With:] and [Printer (USB)] in [Create Desktop], and then click [OK].
ﬂ Click [Change] under [PostScript(TM) Printer Description (PPD) File].

B Select the connected printer's PPD file, and then click [Select].

E Click [Change] in [USB Printer Selection].

ﬂ Select the model you are using in [Select a USB Printer:], and then click [OK].

B Click [Create].
A message appears.

g Enter the printer name, and then click [Save].
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m Specify the location where the file is to be saved and the name, and then click [Save].
The printer icon appears on the desktop.

m Quit Desktop Printer Utility.
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Mac OS X

This section describes how to configure a Mac OS X to use Ether Talk. The following procedure de-
scribes how to configure Mac OS X 10.1. If you are not using Mac OS X 10.1, see the manual that
comes with your version of the Mac OS X for more information.

® Limitation

3 For use with Mac OS X 10.1 or later.
3 For use with a Macintosh, Power PC is required.

& Note
O The PPD file is stored in the following folder on the CD-ROM:

Mac OS X:PPD Installer

Installing the PPD File

It is necessary to install a PPD file to print from a Macintosh.

] Preparation

You need an administrator name and a password (phrase). For more information, consult your ad-
ministrator.

n Insert the CD-ROM into the CD-ROM drive.
ﬂ Double-click the CD-ROM icon.

B Double-click the [Mac OS X] folder.

ﬂ Double-click the installer icon.

B Follow the instructions on the screen.
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Setting Up the PPD File

n Start Print Center.

B Click [Add Printer].
Click [AppleTalk] in the first pop-up menu.
If the zone has been set, select the zone in the second pop-up menu.

B Select the PPD file of the model you are using on the “Printer Model:”” pop-up menu, and then
click [Add].

Setting Up Options

? Limitation

3 You can make all the settings of printer features, even if the necessary option is not installed, due
to the limitation of Mac OS X native mode. Confirm which option is installed to the printer before you
print.

Using USB Interface

n Start Print Center.
ﬂ Click [Add].

B Click [USB] on the pop-up menu.
The connected printer is displayed.
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ﬂ Select the printer, and then select its manufacturer on the [Printer Model:] pop-up menu.
A list of printer types appears.

& Note

3 For Mac OS X 10.1.x, a list of model names appears on the [Printer Model:] pop-up menu. Select
the printer's model name, and then proceed to step [3.

B Select the connected printer's name in the list of printer types, and then click [Add].
E Close the [Printer List] dialog box, and then quit Print Center.

Using Rendezvous

When using Mac OS X 10.2.3 or later, you can print using Rendezvous. Ethernet and Wireless LAN
connections can be used.

n Start Print Center.
B Click [Add].

B Click [Rendezvous] on the pop-up menu.
The connected printer appears.

ﬂ Select the printer, and then select its manufacturer on the [Printer Model:] pop-up menu.
A list of printer types appears.

B Select the name of the connected printer from the list of printer types, and then click [Add].
E Close the [Printer List] dialog box, and then quit Print Center.
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Configuring Macintosh

Changing to EtherTalk

Follow this procedure to configure a Macintosh to use EtherTalk.

X Reference
For more information about installing the software required for EtherTalk, see the Macintosh man-
uals.

Mac OS

n Open [Control Panel], and then double-click the [AppleTalk] icon.

ﬂ On the [Connect via:] pop-up menu, select “Ethernet”.

B If you change zones, select a name on the [Current zone:] pop-up menu.
ﬂ Close the [AppleTalk] dialog box.

B Restart the computer.
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Mac OS X

] Preparation

You need an administrator name and a password (phrase). For more information, consult your ad-
ministrator.

l] Open [System Preference], and then click the [Network] icon.
ﬂ Click the [AppleTalk] tab.
B If you change zone, select a name on the [AppleTalk Zone:] pop-up menu.

ﬂ When the setting is complete, click [Apple Now].

Configuring the Printer

Use the control panel to activate AppleTalk. (The default is active.)

X Reference
For more information about the configuration, see “Configuring the Printer for the Network with the
Control Panel”, Setup Guide.

Changing the Printer Name

If the network has several same model printers, their names will be the same. Printers of the same name
will have their names changed slightly in the [Chooser] dialog box. For example, three printers named
“printer” will appear in the [Chooser] dialog box as “printer0”, “printer1” and “printer2”.

For details about changing the printer name, see PostScript 3 Supplement.

l y
,//
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Changing the Zone

It may be necessary to change the zone configuration.
For details about changing the printer name, see PostScript 3 Supplement.
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6. NetWare Configuration

This chapter describes how to set up a client computer when using a NetWare print server.

& Note
O Use the latest version of Novell Client or the one provided with your operating system.

3 This section assumes the client has NetWare client applications installed and is correctly configured
to communicate with a NetWare print server. If not, install the necessary applications before starting
the setting up procedure.

Windows 95/98/Me

Follow this procedure to set up a Windows 95/98/Me client.
After installing the printer driver, change the print port to NetWare queue.

= Preparation
Log on to the NetWare file server before starting the following procedure.

n Install the printer driver you want to use as ‘“Local Printer”.

A Reference
For more information about installing the printer driver, see p.43 “Printing via Parallel Connec-
tion”.

& Note

3 Any port can be selected during installation, however, LPT1 is recommended.

i@klmportant

3 Never have two versions of the same printer driver installed on your system at the same time.
When upgrading to a new version of the printer driver, delete the old version, and then install the
new one.

ﬂ Click [Start], point to [Settings], and then click [Printers].
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B In the [Printers] window, click the icon of the printer you want to use.
On the [File] menu, click [Properties].

ﬂ Click the [Details] tab, and then click [Add Port].
B Click [Network], and then click [Browse].

E On the network tree, double-click the name of the file server.
The queues are displayed.

ﬂ Click the queue you want to print, and then click [OK].

B Click [OK].
In the [Print to the following port] box, a network path to the printer appears.

g Click [OK] to close the printer properties dialog box, and open it again.
[E] Click the [Printer Settings] tab.
m Clear the [Form Feed] and [Enable Banner] check boxes.

& Note

O ltis better not to check these boxes because they should be specified using the printer driver. If
they are selected, the printer might not print correctly.

When using the PostScript 3 printer driver

Follow the procedure below to set up for PostScript 3 printer driver:

@ Click the [PostScript] tab.

@ Click [Advanced].

© Clear the [Send CTRL+D before job] and [Send CTRL+D after job] check boxes. y
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m Click [OK] to close the printer properties dialog box.

’Q“If a message is displayed during printer driver installation

When there is a driver in the computer that is newer than the one currently being installed, a message
dialog box appears.

If this happens, you cannot install using the Auto Run program. Use the driver displayed in the mes-
sage, and reinstall using [Add Printer].

@ Click [Start], point to [Settings], and then click [Printers].
@ Double-click the [Add Printer] icon.

® Follow the wizard to install the driver.
If the printer driver is stored on a CD-ROM, the source for installation is as follows: (If the installer
starts up, click [Cancel] to quit it.)
e PCL 5¢
DRIVERS\PCL5C\WIN9X_ ME\ (Language) \DISK1
e RPCS
DRIVERS\RPCS\WIN9X_ME\ (Language) \DISK1
* PostScript 3
DRIVERS\PS\WIN9X_ME\ (Language) \DISK1
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Windows 2000

Follow this procedure to set up a Windows 2000 client.

& Preparation
Log on to the NetWare file server before starting the following procedure.

n Double-click the [My Network Places] icon on the desktop and navigate to the queue you want
to use, and then double-click it.
The printers dialog box appears.

ﬂ Click [No].
B Quit all applications that are running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

& Note

3 Auto Run might not work automatically due to certain operating system settings. If this is the
case, launch “Setup.exe” located in the CD-ROM root directory.

B Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

Using the PCL 5c or RPCS Printer Driver

@ Click [PCL/RPCS Printer Drivers]. J //
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@ The software license agreement appears in the [License Agreement] dialog box.

After reading through the content, click [l accept the agreement.] to agree with the license agree-
ment, and then click [Next>].

© In the [Select Program] dialog box, select the printer drivers you want to use, and then click
[Next>].

You can select more than one printer driver.
@ Select the [Printer Name] check box for the model(s) of printer you want to use.
To change the printer name, use the [Change settings for 'Printer Name'] box.
@ Double-click the printer name to display its settings, and then click [Port]
O In the [Change settings for 'Port'] box, select the queue you selected in step f].
@ Click [Continue]. Proceed to step [J.

Using the PostScript Printer Driver

@ Click [PostScript 3 Printer Driver].
“Add Printer Wizard” starts.
@ Click [Next>].
© Click [Local Printer], and then click [Next>].
O In the [Use the following port:] list, select the queue you selected in step fJ.
@ Click [Next>]. Proceed to step [J.

E Follow the instructions on the screen.
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’Q“If a message is displayed during printer driver installation

When there is a driver in the computer that is newer than the one currently being installed, a message
dialog box appears.

If this happens, you cannot install using the Auto Run program. Use the driver displayed in the mes-
sage, and reinstall using [Add Printer].

@ Click [Start], point to [Settings], and then click [Printers].
@ Double-click the [Add Printer] icon.

® Follow the wizard to install the driver.
If the printer driver is stored on a CD-ROM, the source for installation is as follows: (If the installer
starts up, click [Cancel] to quit it.)
e PCL 5¢
DRIVERS\PCL5C\WIN2K_XP\ (Language) \DISK1
e RPCS
DRIVERS\RPCS\WIN2K_XP\ (Language) \DISK1
* PostScript 3
DRIVERS\PS\WIN2K_XP\ (Language) \DISK1




Printer Client Reference

Windows XP

Follow this procedure to set up a Windows XP client.

& Preparation
Log on to the NetWare file server before starting the following procedure.

n On the [Start] menu, click [My Network Places], navigate to the queue you want to use, and then
double-click it.
The printers dialog box appears.

ﬂ Click [Cancel].
B Quit all applications that are running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

& Note

3 Auto Run might not work automatically due to certain operating system settings. If this is the
case, launch “Setup.exe” located in the CD-ROM root directory.

B Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

Using the PCL 5c or RPCS Printer Driver

@ Click [PCL/RPCS Printer Drivers]. L/
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@ The software license agreement appears in the [License Agreement] dialog box.

After reading through the content, click [l accept the agreement.] to agree with the license agree-
ment, and then click [Next>].

© In the [Select Program] dialog box, select the printer drivers you want to use, and then click
[Next>].

You can select more than one printer driver.
@ Select the [Printer Name] check box for the model(s) of printer you want to use.
To change the printer name, use the [Change settings for 'Printer Name'] box.
@ Double-click the printer name to display its settings, and then click [Port]
O In the [Change settings for 'Port'] box, select the queue you selected in step f].
@ Click [Continue]. Proceed to step [J.

Using the PostScript Printer Driver

@ Click [PostScript 3 Printer Driver].
“Add Printer Wizard” starts.
@ Click [Next>].
© Click [Local printer attached to this printer], and then click [Next>].
O In the [Use the following port:] list, select the queue you selected in step fJ.
@ Click [Next>]. Proceed to step [J.

E Follow the instructions on the screen.
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’Q“If a message is displayed during printer driver installation

When there is a driver in the computer that is newer than the one currently being installed, a message
dialog box appears.

If this happens, you cannot install using the Auto Run program. Use the driver displayed in the mes-
sage, and reinstall using [Add Printer].

@® Click [Start], and then click [Printers and Faxes].
@ Double-click the [Add Printer] icon.

® Follow the wizard to install the driver.
If the printer driver is stored on a CD-ROM, the source for installation is as follows: (If the installer
starts up, click [Cancel] to quit it.)
e PCL 5c¢
DRIVERS\PCL5C\WIN2K_XP\ (Language) \DISK1
e RPCS
DRIVERS\RPCS\WIN2K_XP\ (Language) \DISK1
* PostScript 3
DRIVERS\PS\WIN2K_XP\ (Language) \DISK1
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Windows NT 4.0

Follow this procedure to set up a Windows NT 4.0 client.

& Preparation
Log on to the NetWare file server before starting the following procedure.

n Double-click the [Network Neighborhood] icon on the desktop and navigate to the queue you
want to use, and then double-click it.
The printers dialog box appears.

ﬂ Click [No].
B Quit all applications that are running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

& Note

3 Auto Run might not work automatically due to certain operating system settings. If this is the
case, launch “Setup.exe” located in the CD-ROM root directory.

B Select a language for the interface, and then click [OK].

The following languages are available: Cestina (Czech), Dansk (Danish), Deutsch (German), Eng-
lish (English), Espanol (Spanish), Francais (French), Italiano (Italian), Magyar (Hungarian), Neder-
lands (Dutch), Norsk (Norwegian), Polski (Polish), Portugues (Portuguese), Suomi (Finnish),
Svenska (Swedish)

Using the PCL 5c or RPCS Printer Driver

@ Click [PCL/RPCS Printer Drivers]. J //
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@ The software license agreement appears in the [License Agreement] dialog box.

After reading through the content, click [l accept the agreement.] to agree with the license agree-
ment, and then click [Next>].

© In the [Select Program] dialog box, select the printer drivers you want to use, and then click
[Next>].

You can select more than one printer driver.

@ Select the [Printer Name] check box for the model(s) of printer you want to use.
To change the printer name, use the [Change settings for 'Printer Name'] box.

@ Double-click the printer name to display its settings, and then click [Port]

O From the [Change settings for 'Port'] drop-down list box, select the queue you selected in step
(1]

@ Click [Continue]. Proceed to step [J.

Using the PostScript Printer Driver

@ Click [PostScript 3 Printer Driver].
“Add Printer Wizard” starts.
@ Click [My Computer], and then click [Next>].
© In the [Use the following port:] list, select the queue you selected in step fJ.
O Click [Next>]. Proceed to step [J.

E Follow the instructions on the screen.
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’Q“If a message is displayed during printer driver installation

When there is a driver in the computer that is newer than the one currently being installed, a message
dialog box appears.

If this happens, you cannot install using the Auto Run program. Use the driver displayed in the mes-
sage, and reinstall using [Add Printer].

@ Click [Start], point to [Settings], and then click [Printers].
@ Double-click the [Add Printer] icon.

® Follow the wizard to install the driver.
If the printer driver is stored on a CD-ROM, the source for installation is as follows: (If the installer
starts up, click [Cancel] to quit it.)
e PCL 5¢
DRIVERS\PCL5C\NT4\ (Language) \DISK1
e RPCS
DRIVERS\RPCS\NT4\ (Language) \DISK1
* PostScript 3
DRIVERS\PS\NT4\ (Language) \DISK1
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7. Software and Utilities Included on the CD-ROM

Software and Utilities Included on the CD-ROM

There are three CD-ROMs provided with this printer. These are labeled “Operating Instructions”,
“Printer Drivers and Utilities” and “Document Management Utility”. The following items are included
on the three separate CD-ROMs:

< Font Manager 2000
Helps you to install new screen fonts, and organize and manage fonts already installed. For more
information about Font Manager, see the manual on the CD-ROM labeled “Printer Drivers and Util-
ities”.

% SmartDeviceMonitor for Admin
A utility for the system administrator to manage network printers.

ye Reference

For more information about SmartDeviceMonitor for Admin, see SmartDeviceMonitor for Admin
Help.

< SmartDeviceMonitor for Client
A utility for users to manage their own print status on the network.

ye Reference

For more information about SmartDeviceMonitor for Client, see SmartDeviceMonitor for Client
Help.

< 1394 Utility
This utility is for the optional IEEE 1394 interface board. For more information, see the Readme file
or the manual that comes with the optional IEEE 1394 interface board.

< USB Printing Support
This utility must be installed to use the USB connection under Windows 98 SE/Me.



Printer Client Reference

Viewing the Contents of the CD-ROM

Follow the procedure below to view the contents of the CD-ROM.

n Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

ﬂ Click [Browse This CD-ROM].
Explorer starts and displays the contents of the CD-ROM.
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Printer Drivers for This Printer

Printing requires installation of a printer driver for your operating system. The following drivers are
included on the CD-ROM that comes with this printer:

Printer Language PCL 5c¢ RPCS PostScript 3
Operating system
Windows 95 *! v N NEU
Windows 98 *2 v N \ 10
Windows Me "3 v N | #10
Windows 2000 * v v N
Windows XP 3 \ v \
Windows Server 2003 *© v \ ~
Windows NT 4.0 7 V ~ \ %9 10
Mac OS 8 \ *10
Mac OS X Nt

*]
)
*3
#4

Microsoft Windows 95 operating system
Microsoft Windows 98 operating system
Microsoft Windows Me operating system
Microsoft Windows 2000 professional
Microsoft Windows 2000 Server

Microsoft Windows 2000 Advanced Server
Microsoft Windows XP Professional
Microsoft Windows XP Home Edition

*5
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6 Microsoft Windows Server 2003 Standard Edition

Microsoft Windows Server 2003 Enterprise Edition

Microsoft Windows Server 2003 Web Edition

Microsoft Windows NT Server operating system version 4.0, Microsoft Windows NT Workstation op-

erating system version 4.0 in a computer using x86 processors.

Required version is 8.6 or later. (Mac OS X Classic environment is supported.)

Requires Service Pack 6 or later.

10 The Adobe PostScript printer drivers and PostScript Printer Description (PPD) files are included on the
CD-ROM labeled “Printer Drivers and Utilities”.

11 The PostScript Printer Description (PPD) files are included on the CD-ROM labeled “Printer Drivers and
Utilities”.

*7

*8
*9

< PCL 5c printer driver
This printer driver allows the computer to communicate with the printer via a printer language.
See p.184 “Windows 95/98/Me - Accessing Printer Properties”.
See p.186 “Windows 2000 - Accessing Printer Properties”.
See p.190 “Windows XP, Windows Server 2003 - Accessing Printer properties”.
See p.193 “Windows NT 4.0 - Accessing Printer Properties”.

< RPCS printer driver
This printer driver allows the computer to communicate with the printer via a printer language. The
preset type user interface is provided in addition to the conventional one.
See p.196 “Windows 95/98/Me - Accessing Printer Properties”.
See p.199 “Windows 2000 - Accessing Printer Properties”.
See p.202 “Windows XP, Windows Server 2003 - Accessing Printer Properties”.
See p.205 “Windows NT 4.0 - Accessing Printer Properties”.
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< Adobe PostScript Printer Drivers and PPD files
The Adobe PostScript printer drivers and PPD files are included on the CD-ROM that comes with
this printer. Adobe PostScript printer driver allows the computer to communicate with the printer
via a printer language. The PPD files allow the printer driver to enable printer specific functions.
See p.208 “Windows 95/98/Me - Accessing Printer Properties”.
See p.210 “Windows 2000 - Accessing Printer Properties”.
See p.214 “Windows XP, Windows Server 2003 - Accessing Printer Properties”.
See p.217 “Windows NT 4.0 - Accessing Printer Properties”.
See p.220 “Macintosh - Setting up for Printing”.
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SmartDeviceMonitor for Admin

SmartDeviceMonitor for Admin is software that uses TCP/IP and IPX/SPX to monitor the printers in
a network. It can monitor multiple network printers with IP addresses. We recommend network admin-
istrators to use this software.

% File Path
SmartDeviceMonitor for Admin is stored in the following folders on the CD-ROM:

NETWORK\DEVMON\ADMIN\DISK1

Operating system Protocol stack

Microsoft Windows 95/98/Me TCP/IP provided with Windows 95/98/Me

IPX/SPX provided with Windows 95/98/Me

NetWare network client provided with Windows 95/98
Novell Client for Windows 95/98

Microsoft Windows 2000 TCP/IP provided with Windows 2000
IPX/SPX provided with Windows 2000
NetWare Client provided with Windows 2000
Novell Client for Windows NT/2000

Microsoft Windows XP TCP/IP provided with Windows XP
IPX/SPX provided with Windows XP
NetWare Client provided with Windows XP
Novell Client for Windows XP

Microsoft Windows Server 2003 TCP/IP provided with Windows Server 2003
IPX/SPX provided with Windows Server 2003
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Operating system Protocol stack

Microsoft Windows NT 4.0 TCP/IP provided with Windows NT

IPX/SPX provided with Windows NT

Client Service for NetWare provided with Windows NT
Novell Client for Windows NT/2000

< What can it do?
SmartDeviceMonitor for Admin has the following functions:

* Device Information function
* Checks the printer's network settings and detailed device information.
* Checks the number of pages printed for each computer, using the user codes.
* Checks the results of print jobs executed from the computer.
* Enables you to change the printer's network settings.
* Device Settings function
* Limits the settings done from the control panel, and disables changes made to some items.
* Enables the selection of paper types loaded in the printer.
* Energy Saver function
» Switches to Energy Saver mode, and wakes up from Energy Saver mode.
* System Status function
* Checks printing information, paper levels, and such, from the computer.
* Groups function

* Monitors multiple printers at the same time. When there are many printers, you can create
groups and classify them in order to facilitate management.
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A Reference
For system administrator operations, see “Using SmartDeviceMonitor for Admin”, Administrator
Reference.

For more information about using SmartDeviceMonitor for Admin, see SmartDeviceMonitor for
Admin Help.
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SmartDeviceMonitor for Client

The SmartDeviceMonitor for Client software has the following functions:(We recommend all users of
this printer to install this software.)

* Provides functions for Peer-to-Peer network printing, using TCP/IP, NetBEUI, and IPP from
Windows95/98/Me/2000/XP, Windows Server 2003, and Windows NT 4.0.

* Uses TCP/IP and IPX/SPX to constantly monitor the status of network devices.

+ File Path
SmartDeviceMonitor for Client is stored in the following folders on the CD-ROM:

NETWORK\DEVMON\CLIENT\DISK1

Operating system Protocol stack

Microsoft Windows 95/98/Me TCP/IP provided with Windows 95/98/Me

IPX/SPX provided with Windows 95/98/Me

NetBEUI provided with Windows 95/98/Me

NetWare network client provided with Windows 95/98/Me
Novell Client for Windows 95/98/Me

Microsoft Windows 2000 TCP/IP provided with Windows 2000
IPX/SPX provided with Windows 2000
NetBEUI provided with Windows 2000
NetWare Client provided with Windows 2000
Novell Client for Windows NT/2000

Microsoft Windows XP TCP/IP provided with Windows XP
IPX/SPX provided with Windows XP
NetWare Client provided with Windows XP

Novell Client for Windows XP l y
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Operating system

Protocol stack

Microsoft Windows Server 2003

TCP/IP provided with Windows Server 2003
IPX/SPX provided with Windows Server 2003
NetWare Client provided with Windows Server 2003

Microsoft Windows NT 4.0

TCP/IP provided with Windows NT

IPX/SPX provided with Windows NT

NetBEUI provided with Windows NT

Client Service for NetWare provided with Windows NT
Novell Client for Windows NT/2000

< What can it do?

SmartDeviceMonitor for Client has the following functions:

* Checks printing information, paper levels, and such, from the computer.

» Checks results of print jobs executed from the computer.

& Note

3 Using these functions requires the user account enhance unit.

? Limitation

O Make similar settings for the option configuration of the printer for Recovery/Parallel Printing and
the printer for giving print commands. If the required options necessary for printing, such as the
paper feed unit, are not installed on the substitute printer, that function is disabled.

O Load paper of the same size on both the printer for Recovery/Parallel Printing and the printer for
giving print commands. When specifying a particular paper tray for printing, load paper of the

same size into that tray.

3 Ifthe type and devices of the printer for Recovery/Parallel Printing and the printer for giving com-
mands are different, the print results might not turn out identical.

3 If you select Sample Print or Locked Print, you cannot execute Recovery/Parallel Printing.
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~ Reference

For more information about using SmartDeviceMonitor for Client, see SmartDeviceMonitor for
Client Help.
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8. Setting up the Printer Driver and Canceling a Print Job

PCL 5c - Accessing Printer Properties

Windows 95/98/Me - Accessing Printer Properties

There are two methods you can use to open the printer properties dialog box.

Making default printer settings

To make the default printer settings, first open the printer properties dialog box from the [Printers] win-
dow.

& Note
O With some applications, the printer driver's settings are not used, and the application's own default
settings are applied.

n On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.
B On the [File] menu, click [Properties].

& Note

O When you open the printer properties dialog box for the first time after installing the RPCS printer
driver, a confirmation window appears. After that, the initial display of the printer properties dialog
box appears.

ﬂ Make the necessary settings, and then click [OK].
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’Z'Q'?If a message is displayed during printer driver installation

When there is a driver in the computer that is newer than the one currently being installed, a message
dialog box appears.
If this happens, you cannot install using the Auto Run program. Use the driver displayed in the mes-
sage, and reinstall using [Add Printer].
@ Click [Start], point to [Settings], and then click [Printers].
@ Double-click the [Add Printer] icon.
® Follow the wizard to install the driver.
If the printer driver is stored on a CD-ROM, the source for installation is as follows: (If the installer
starts up, click [Cancel] to quit it.)
* PCL 5¢
DRIVERS\PCL5C\WIN9X_ ME\ (Language) \DISK1

Making printer settings from an application

To make printer settings for a specific application, open the printer properties dialog box from that ap-
plication. The following example describes how to make settings for the WordPad application that
comes with Windows 95/98/Me.

& Note

3 The procedure you should follow to open the printer properties dialog box may differ depending on
the application. For more information, see the documentation that comes with the application you
are using.

O With some applications, the printer driver's settings are not used, and the application's own default
settings are applied.

3 Any settings you make in the following procedure are valid for the current application only.
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n On the [File] menu, click [Print].
The [Print] dialog box appears.

B In the[Name] list, select the printer you want to use, and then click [Properties].
The Printer Properties dialog box appears.

B Make the necessary settings, and then click [OK].
ﬂ Click [OK] to start printing.

Windows 2000 - Accessing Printer Properties

Making default printer settings - Printer properties

® Limitation

O Changing printer settings requires Manage Printers permission. Members of the Administrators and
Power Users groups have Manage Printers permission by default. When you set up options, log on
using an account that has Manage Printers permission.

n On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The [Properties] dialog box appears.
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& Note

O When you open the printer properties dialog box for the first time after installing the RPCS printer
driver, a confirmation window appears. After that, the initial display of the printer properties dialog
box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
3 Settings you make here are used as the default settings for all applications.

’Z'Q'?If a message is displayed during printer driver installation

When there is a driver in the computer that is newer than the one currently being installed, a message
dialog box appears.

If this happens, you cannot install using the Auto Run program. Use the driver displayed in the mes-
sage, and reinstall using [Add Printer].

@ Click [Start], point to [Settings], and then click [Printers].
@ Double-click the [Add Printer] icon.
® Follow the wizard to install the driver.
If the printer driver is stored on a CD-ROM, the source for installation is as follows: (If the installer
starts up, click [Cancel] to quit it.)
* PCL 5c
DRIVERS\PCL5C\WIN2K_XP\ (Language) \DISK1
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Making default printer settings - Printing preferences properties

? Limitation

O Changing printer settings requires Manage Printers permission. Members of the Administrators and
Power Users groups have Manage Printers permission by default. When you set up options, log on
using an account that has Manage Printers permission.

n On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.
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Making printer settings from an application

To make printer settings for a specific application, open the [Printing Preferences] dialog box from that
application. The following example describes how to make settings for the WordPad application that
comes with Windows 2000.

& Note

O The procedure you should follow to open the [Printing Preferences] dialog box may differ depending
on the application. For more information, see the documentation that comes with the application you
are using.

3 Any settings you make in the following procedure are valid for the current application only.

n On the [File] menu, click [Print...].
The [Print] dialog box appears.

ﬂ In the [Select Printer] box, select the printer you want to use.

B Make the necessary settings, and then click [Print] to start printing.
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Windows XP, Windows Server 2003 - Accessing Printer properties

Making default printer settings - Printer properties

® Limitation

3 Changing printer settings requires Manage Printers permission. Members of the Administrators and
Power Users groups have Manage Printers permission by default. When you set up options, log on
using an account that has Manage Printers permission.

n Access the [Printers and Faxes] window from [Start] on the taskbar.

The [Printers and Faxes] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The [Properties] dialog box appears

& Note

O When you open the printer properties dialog box for the first time after installing the RPCS printer
driver, a confirmation window appears. After that, the initial display of the printer properties dialog
box appears.

ﬂ Make the necessary settings, click [Apply], and then click [OK].

& Note
3 Settings you make here are used as the default settings for all applications.
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’Z'Q'?If a message is displayed during printer driver installation

When there is a driver in the computer that is newer than the one currently being installed, a message
dialog box appears.
If this happens, you cannot install using the Auto Run program. Use the driver displayed in the mes-
sage, and reinstall using [Add Printer].
@ Access the [Printers and Faxes] window from [Start] on the taskbar.
@® Select the [Add Printer] from the file menu.
® Follow the wizard to install the driver.
If the printer driver is stored on a CD-ROM, the source for installation is as follows: (If the installer
starts up, click [Cancel] to quit it.)
* PCL 5¢
DRIVERS\PCL5C\WIN2K_XP\ (Language) \DISK1

Making default printer settings - Printing preferences properties

® Limitation

3 Changing printer settings requires Manage Printers permission. Members of the Administrators and
Power Users groups have Manage Printers permission by default. When you set up options, log on
using an account that has Manage Printers permission.

n Access the [Printers and Faxes] window from [Start] on the taskbar.

The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.
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B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

ﬂ Make the necessary settings, click [Apply], and then click [OK].

& Note
3 Settings you make here are used as the default settings for all applications.

Making printer settings from an application

To make printer settings for a specific application, open the [Printing Preferences] dialog box from that
application. The following example describes how to make settings for the WordPad application that
comes with Windows XP.

& Note

3 The procedure you should follow to open the [Printing Preferences] dialog box may differ depending
on the application. For more information, see the documentation that comes with the application you
are using.

3 Any settings you make in the following procedure are valid for the current application only.

n On the [File] menu, click [Print...].
The [Print] dialog box appears.

B In the [Select Printer] box, select the printer you want to use.

B Make the necessary settings, click [Apply], and then click [Print] to start printing.
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Windows NT 4.0 - Accessing Printer Properties

Making default printer settings - Printer properties

® Limitation

3 Changing printer settings requires Full Control permission. Members of Administrators, Server Op-
erators, Print Operators, and Power Users groups have Full Control permission by default. When
you set up options, log on using an account that has Full Control permission.

n On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

& Note

O When you open the printer properties dialog box for the first time after installing the RPCS printer
driver, a confirmation window appears. After that, the initial display of the printer properties dialog
box appears.

B Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The Printer Properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
3 Settings you make here are used as the default settings for all applications.
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’Z'Q'?If a message is displayed during printer driver installation

When there is a driver in the computer that is newer than the one currently being installed, a message
dialog box appears.
If this happens, you cannot install using the Auto Run program. Use the driver displayed in the mes-
sage, and reinstall using [Add Printer].
@ Click [Start], point to [Settings], and then click [Printers].
@ Double-click the [Add Printer] icon.
® Follow the wizard to install the driver.
If the printer driver is stored on a CD-ROM, the source for installation is as follows: (If the installer
starts up, click [Cancel] to quit it.)
* PCL 5¢
DRIVERS\PCL5C\NT4\ (Language) \DISK1

Making default printer settings - Default document properties

® Limitation

3 Changing printer settings requires Full Control access permission. Members of the Administrators,
Server Operators, Print Operators, and Power Users groups have Full Control permission by de-
fault. When you set up options, log on using an account that has Full Control permission.

n On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use.
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B On the [File] menu, click [Document Defaults...].
The [Default] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
3 Settings you make here are used as the default settings for all applications.

Making printer settings from an application

To make printer settings for a specific application, open the printer properties dialog box from that ap-
plication. The following example describes how to make settings for the WordPad application that
comes with Windows NT 4.0.

& Note

3 The procedure you should follow to open the printer properties dialog box may differ depending on
the application. For more information, see the documentation that comes with the application you
are using.

O With some applications, printer driver settings are not used, and the application's own default set-
tings are applied.

3 Any settings you make in the following procedure are valid for the current application only.

n On the [File] menu, click [Print].
The [Print] dialog box appears.

ﬂ In the[Name] list, select the printer you want to use, and then click [Properties].
The Printer Properties dialog box appears.

B Make the necessary settings, and then click [OK].
ﬂ Click [OK] to start printing.
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RPCS - Accessing Printer Properties

Windows 95/98/Me - Accessing Printer Properties

There are two windows types you can use to open the printer properties dialog box.
“Multi-tab” is used as an example in this manual. See Help for information about changing the windows
types.
< Multi-tab
This is the window type for users who often change print settings in order to make various kinds of
prints.

% Custom Setting
This is the window type for users who rarely change print settings when making prints. The Custom
Setting display may vary depending on the installed options.

Making default printer settings

To make default printer settings, first open the printer properties dialog box from the [Printers] window.

& Note

3O With some applications, printer driver settings are not used, and the application's own default set-
tings are applied.

l] On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.
B On the [File] menu, click [Properties].
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& Note

O When you open the printer properties dialog box for the first time after installing the RPCS printer
driver, a confirmation window appears. After that, the initial display of the printer properties dialog
box appears.

ﬂ Make the necessary settings, and then click [OK].

’Q“If a message is displayed during printer driver installation

When there is a driver in the computer that is newer than the one currently being installed, a message
dialog box appears.

If this happens, you cannot install using the Auto Run program. Use the driver displayed in the mes-
sage, and reinstall using [Add Printer].

@ Click [Start], point to [Settings], and then click [Printers].
@ Double-click the [Add Printer] icon.
® Follow the wizard to install the driver.
If the printer driver is stored on a CD-ROM, the source for installation is as follows: (If the installer
starts up, click [Cancel] to quit it.)
e RPCS
DRIVERS\RPCS\WIN9X_ME\ (Language) \DISK1
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Making printer settings from an application

To make printer settings for a specific application, open the printer properties dialog box from that ap-
plication. The following example describes how to make settings for the WordPad application that
comes with Windows 95/98/Me.

& Note

3 The procedure you should follow to open the printer properties dialog box may differ depending on
the application. For more information, see the documentation that comes with the application you
are using.

3 With some applications, printer driver settings are not used, and the application's own default set-
tings are applied.

3 Any settings you make in the following procedure are valid for the current application only.

n On the [File] menu, click [Print].
The [Print] dialog box appears.

B In the[Name] list, select the printer you want to use, and then click [Properties].
The Printer Properties dialog box appears.

B Make the necessary settings, and then click [OK].
ﬂ Click [OK] to start printing.
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Windows 2000 - Accessing Printer Properties

Making default printer settings - Printer properties

® Limitation

3 Changing printer settings requires Manage Printers permission. Members of the Administrators and
Power Users groups have Manage Printers permission by default. When you set up options, log on
using an account that has Manage Printers permission.

n On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.
B On the [File] menu, click [Properties].

The Printer Properties dialog box appears.

& Note

O When you open the printer properties dialog box for the first time after installing the RPCS printer
driver, a confirmation window appears. After that, the initial display of the printer properties dialog
box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
3 Settings you make here are used as the default settings for all applications.
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’Z'Q'?If a message is displayed during printer driver installation

When there is a driver in the computer that is newer than the one currently being installed, a message
dialog box appears.
If this happens, you cannot install using the Auto Run program. Use the driver displayed in the mes-
sage, and reinstall using [Add Printer].
@ Click [Start], point to [Settings], and then click [Printers].
@ Double-click the [Add Printer] icon.
® Follow the wizard to install the driver.
If the printer driver is stored on a CD-ROM, the source for installation is as follows: (If the installer
starts up, click [Cancel] to quit it.)
* RPCS
DRIVERS\RPCS\WIN2K_XP\ (Language) \DISK1

Making default printer settings - Printing preferences properties

® Limitation

3 Changing printer settings requires Manage Printers permission. Members of the Administrators and
Power Users groups have Manage Printers permission by default. When you set up options, log on
using an account that has Manage Printers permission.

n On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use.
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B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
3 Settings you make here are used as the default settings for all applications.

Making printer settings from an application

To make printer settings for a specific application, open the [Printing Preferences] dialog box from that
application. The following example describes how to make settings for the WordPad application that
comes with Windows 2000.

& Note

3 The procedure you should follow to open the [Printing Preferences] dialog box may differ depending
on the application. For more information, see the documentation that comes with the application you
are using.

3 Any settings you make in the following procedure are valid for the current application only.

n On the [File] menu, click [Print...].
The [Print] dialog box appears.

B In the [Select Printer] box, select the printer you want to use.

B Make the necessary settings, and then click [Apply] to start printing.
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Windows XP, Windows Server 2003 - Accessing Printer Properties

Making default printer settings - Printer properties

® Limitation

3 Changing printer settings requires Manage Printers permission. Members of the Administrators and
Power Users groups have Manage Printers permission by default. When you set up options, log on
using an account that has Manage Printers permission.

n Access the [Printers and Faxes] window from [Start] on the taskbar.

The [Printers and Faxes] window appears.

ﬂ Click the icon of the printer you want to use.
B On the [File] menu, click [Properties].

The Printer Properties dialog box appears.

& Note

O When you open the printer properties dialog box for the first time after installing the RPCS printer
driver, a confirmation window appears. After that, the initial display of the printer properties dialog
box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
3 Settings you make here are used as the default settings for all applications.
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’Z'Q'?If a message is displayed during printer driver installation

When there is a driver in the computer that is newer than the one currently being installed, a message
dialog box appears.

If this happens, you cannot install using the Auto Run program. Use the driver displayed in the mes-
sage, and reinstall using [Add Printer].

@ Access the [Printers and Faxes] window from [Start] on the taskbar.
@ Double-click the [Add Printer] icon.

® Follow the wizard to install the driver.
If the printer driver is stored on a CD-ROM, the source for installation is as follows: (If the installer
starts up, click [Cancel] to quit it.)
e RPCS
DRIVERS\RPCS\WIN2K_XP\ (Language) \DISK1

Making default printer settings - Printing preferences properties

® Limitation

3 Changing printer settings requires Manage Printers permission. Members of the Administrators and
Power Users groups have Manage Printers permission by default. When you set up options, log on
using an account that has Manage Printers permission.

n Access the [Printers and Faxes] window from [Start] on the taskbar.

The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.
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B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
3 Settings you make here are used as the default settings for all applications.

Making printer settings from an application

To make printer settings for a specific application, open the [Printing Preferences] dialog box from that
application. The following example describes how to make settings for the WordPad application that
comes with Windows XP.

& Note

3 The procedure you should follow to open the [Printing Preferences] dialog box may differ depending
on the application. For more information, see the documentation that comes with the application you
are using.

3 Any settings you make in the following procedure are valid for the current application only.

n On the [File] menu, click [Print...].
The [Print] dialog box appears.

B In the [Select Printer] box, select the printer you want to use.

B Make the necessary settings, click [Apply], and then click [Print] to start printing.
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Windows NT 4.0 - Accessing Printer Properties

Making default printer settings - Printer properties

® Limitation

3 Changing printer settings requires Full Control permission. Members of Administrators, Server Op-
erators, Print Operators, and Power Users groups have Full Control permission by default. When
you set up options, log on using an account that has Full Control permission.

n On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The Printer Properties dialog box appears.
& Note
O When you open the printer properties dialog box for the first time after installing the RPCS printer

driver, a confirmation window appears. After that, the initial display of the printer properties dialog
box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
3 Settings you make here are used as the default settings for all applications.
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’Z'Q'?If a message is displayed during printer driver installation

When there is a driver in the computer that is newer than the one currently being installed, a message
dialog box appears.
If this happens, you cannot install using the Auto Run program. Use the driver displayed in the mes-
sage, and reinstall using [Add Printer].
@ Click [Start], point to [Settings], and then click [Printers].
@ Double-click the [Add Printer] icon.
® Follow the wizard to install the driver.
If the printer driver is stored on a CD-ROM, the source for installation is as follows: (If the installer
starts up, click [Cancel] to quit it.)
* RPCS
DRIVERS\RPCS\NT4\ (Language) \DISK1

Making default printer settings - Default document properties

® Limitation

3 Changing printer settings requires Full Control access permission. Members of the Administrators,
Server Operators, Print Operators, and Power Users groups have Full Control permission by de-
fault. When you set up options, log on using an account that has Full Control permission.

n On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use.
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B On the [File] menu, click [Document Defaults...].
The [Default] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
3 Settings you make here are used as the default settings for all applications.

Making printer settings from an application

To make printer settings for a specific application, open the printer properties dialog box from that ap-
plication. The following example describes how to make settings for the WordPad application that
comes with Windows NT 4.0.

& Note

3 The procedure you should follow to open the printer properties dialog box may differ depending on
the application. For more information, see the documentation that comes with the application you
are using.

O With some applications, printer driver settings are not used, and the application's own default set-
tings are applied.

3 Any settings you make in the following procedure are valid for the current application only.

n On the [File] menu, click [Print...].
The [Print] dialog box appears.

ﬂ In the[Name] list, select the printer you want to use, and then click [Properties].
The Printer Properties dialog box appears.

B Make the necessary settings, and then click [OK].
ﬂ Click [OK] to start printing.
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PostScript 3 - Setting up for Printing

Windows 95/98/Me - Accessing Printer Properties

There are two methods you can use to open the printer properties dialog box.

Making default printer settings

To make default printer settings, first open the printer properties dialog box from the [Printers] window.

& Note
3 With some applications, printer driver settings are not used, and the application's own default set-
tings are applied.

n On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The Printer Properties dialog box appears.

& Note

O When you open the printer properties dialog box for the first time after installing the RPCS printer
driver, a confirmation window appears. After that, the initial display of the printer properties dialog
box appears.

ﬂ Make the necessary settings, and then click [OK].
B Click [OK].
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’Z'Q'?If a message is displayed during printer driver installation

When there is a driver in the computer that is newer than the one currently being installed, a message
dialog box appears.

If this happens, you cannot install using the Auto Run program. Use the driver displayed in the mes-
sage, and reinstall using [Add Printer].
@ Click [Start], point to [Settings], and then click [Printers].
@ Double-click the [Add Printer] icon.
® Follow the wizard to install the driver.
If the printer driver is stored on a CD-ROM, the source for installation is as follows: (If the installer
starts up, click [Cancel] to quit it.)
* PostScript 3
DRIVERS\PS\WIN9X_ME\ (Language) \DISK1

Making printer settings from an application

To make printer settings for a specific application, open the printer properties dialog box from that ap-
plication. The following example describes how to make settings for the WordPad application that
comes with Windows 95/98/Me.

& Note

3 The procedure you should follow to open the printer properties dialog box may differ depending on
the application. For more information, see the documentation that comes with the application you
are using.

O With some applications, printer driver settings are not used, and the application's own default set-
tings are applied.

3 Any settings you make in the following procedure are valid for the current application only.
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n On the [File] menu, click [Print].
The [Print] dialog box appears.

B In the[Name] list, select the printer you want to use, and then click [Properties].
The Printer Properties dialog box appears.

B Make the necessary settings, and then click [OK].
ﬂ Click [OK] to start printing.

Windows 2000 - Accessing Printer Properties

Making default printer settings - Printer properties

® Limitation

O Changing printer settings requires Manage Printers permission. Members of the Administrators and
Power Users groups have Manage Printers permission by default. When you set up options, log on
using an account that has Manage Printers permission.

n On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The Printer Properties dialog box appears.
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& Note

O When you open the printer properties dialog box for the first time after installing the RPCS printer
driver, a confirmation window appears. After that, the initial display of the printer properties dialog
box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
3 Settings you make here are used as the default settings for all applications.

’Z'Q'?If a message is displayed during printer driver installation

When there is a driver in the computer that is newer than the one currently being installed, a message
dialog box appears.

If this happens, you cannot install using the Auto Run program. Use the driver displayed in the mes-
sage, and reinstall using [Add Printer].

@ Click [Start], point to [Settings], and then click [Printers].
@ Double-click the [Add Printer] icon.
® Follow the wizard to install the driver.
If the printer driver is stored on a CD-ROM, the source for installation is as follows: (If the installer
starts up, click [Cancel] to quit it.)
* PostScript 3
DRIVERS\PS\WIN2K_XP (Language) \DISK1
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Making default printer settings - Printing preferences properties

? Limitation

O Changing printer settings requires Manage Printers permission. Members of the Administrators and
Power Users groups have Manage Printers permission by default. When you set up options, log on
using an account that has Manage Printers permission.

n On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

B Click the icon of the printer you want to use.

B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.
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Making printer settings from an application

To make printer settings for a specific application, open the [Printing Preferences] dialog box from that
application. The following example describes how to make settings for the WordPad application that
comes with Windows 2000.

& Note

O The procedure you should follow to open the [Printing Preferences] dialog box may differ depending
on the application. For more information, see the documentation that comes with the application you
are using.

3 Any settings you make in the following procedure are valid for the current application only.

n On the [File] menu, click [Print...].
The [Print] dialog box appears.

ﬂ In the [Select Printer] box, select the printer you want to use.

B Make the necessary settings, and then click [Print] to start printing.
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Windows XP, Windows Server 2003 - Accessing Printer Properties

Making default printer settings - Printer properties

® Limitation

3 Changing printer settings requires Manage Printers permission. Members of the Administrators and
Power Users groups have Manage Printers permission by default. When you set up options, log on
using an account that has Manage Printers permission.

n Access the [Printers and Faxes] window from [Start] on the taskbar.

The [Printers and Faxes] window appears.

ﬂ Click the icon of the printer you want to use.
B On the [File] menu, click [Properties].

The Printer Properties dialog box appears.

& Note

O When you open the printer properties dialog box for the first time after installing the RPCS printer
driver, a confirmation window appears. After that, the initial display of the printer properties dialog
box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
3 Settings you make here are used as the default settings for all applications.
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’Z'Q'?If a message is displayed during printer driver installation

When there is a driver in the computer that is newer than the one currently being installed, a message
dialog box appears.
If this happens, you cannot install using the Auto Run program. Use the driver displayed in the mes-
sage, and reinstall using [Add Printer].
@ Access the [Printers and Faxes] window from [Start] on the taskbar.
@ Select [Add Print] from the file menu.
® Follow the wizard to install the driver.
If the printer driver is stored on a CD-ROM, the source for installation is as follows: (If the installer
starts up, click [Cancel] to quit it.)
* PostScript 3
DRIVERS\PS\WIN2K_XP\ (Language) \DISK1

Making default printer settings - Printing preferences properties

® Limitation

3 Changing printer settings requires Manage Printers permission. Members of the Administrators and
Power Users groups have Manage Printers permission by default. When you set up options, log on
using an account that has Manage Printers permission.

n Access the [Printers and Faxes] window from [Start] on the taskbar.

The [Printers and Faxes] window appears.

B Click the icon of the printer you want to use.
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B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

ﬂ Make the necessary settings, and then click [Apply].

& Note
3 Settings you make here are used as the default settings for all applications.

Making printer settings from an application

To make printer settings for a specific application, open the [Printing Preferences] dialog box from that
application. The following example describes how to make settings for the WordPad application that
comes with Windows XP.

& Note

3 The procedure you should follow to open the [Printing Preferences] dialog box may differ depending
on the application. For more information, see the documentation that comes with the application you
are using.

3 Any settings you make in the following procedure are valid for the current application only.

n On the [File] menu, click [Print...].
The [Print] dialog box appears.

B In the [Select Printer] box, select the printer you want to use.

B Make the necessary settings, click [Apply], and then click [Print] to start printing.
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Windows NT 4.0 - Accessing Printer Properties

Making default printer settings - Printer properties

® Limitation

3 Changing printer settings requires Full Control permission. Members of Administrators, Server Op-
erators, Print Operators, and Power Users groups have Full Control permission by default. When
you set up options, log on using an account that has Full Control permission.

n On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The Printer Properties dialog box appears.
& Note
O When you open the printer properties dialog box for the first time after installing the RPCS printer

driver, a confirmation window appears. After that, the initial display of the printer properties dialog
box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
3 Settings you make here are used as the default settings for all applications.
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’Z'Q'?If a message is displayed during printer driver installation

When there is a driver in the computer that is newer than the one currently being installed, a message
dialog box appears.

If this happens, you cannot install using the Auto Run program. Use the driver displayed in the mes-
sage, and reinstall using [Add Printer].
@ Click [Start], point to [Settings], and then click [Printers].
@ Double-click the [Add Printer] icon.
® Follow the wizard to install the driver.
If the printer driver is stored on a CD-ROM, the source for installation is as follows: (If the installer
starts up, click [Cancel] to quit it.)
* PostScript 3
DRIVERS\PS\NT4\ (Language) \DISK1

Making default printer settings - Default document properties

® Limitation

3 Changing printer settings requires Full Control access permission. Members of the Administrators,
Server Operators, Print Operators, and Power Users groups have Full Control permission by de-
fault. When you set up options, log on using an account that has Full Control permission.

n On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

B Click the icon of the printer you want to use.
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B On the [File] menu, click [Document Defaults...].
The [Default] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
3 Settings you make here are used as the default settings for all applications.

Making printer settings from an application

To make printer settings for a specific application, open the printer properties dialog box from that ap-
plication. The following example describes how to make settings for the WordPad application that
comes with Windows NT 4.0.

& Note

3 The procedure you should follow to open the printer properties dialog box may differ depending on
the application. For more information, see the documentation that comes with the application you
are using.

O With some applications, printer driver settings are not used, and the application's own default set-
tings are applied.

3 Any settings you make in the following procedure are valid for the current application only.

n On the [File] menu, click [Print...].
The [Print] dialog box appears.

ﬂ In the[Name] list, select the printer you want to use, and then click [Properties].
The Printer Properties dialog box appears.

B Make the necessary settings, and then click [OK].
ﬂ Click [OK] to start printing.
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Macintosh - Setting up for Printing

Making paper settings from an application

n Open the file you want to print.
ﬂ On the [File] menu, click [Page Setup].

B Check the printer you want to use is shown in [Format for:], and then use [Paper] *! to select the
paper size you want to use.
*I' Under Mac OS X, this is called [Paper Size].

& Note
O If the printer now appears in the [Format for:] box, use the pop-up menu to display a list of avail-
able printers.

ye Reference

The actual appearance of the [Page Setup] dialog box depends on the application you are using.
See the documentation that comes with the Macintosh for more information.

ﬂ After configuring the settings, click [OK].
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Setting up for printing from an application

n Open the file you want to print.
ﬂ On the [File] menu, click [Print].
B Check the printer is selected in the [Printer] box, and then make the printer settings.

ﬂ After configuring the settings, click [Print].
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Canceling a Print Job

Windows 95/98/Me/2000/XP, Windows Server 2003, Windows NT 4.0 -
Canceling a Print Job

n Double-click the printer icon on the Windows taskbar.

A window appears, showing all print jobs currently queued for printing. Check the current status of
the job you want to cancel.

B Select the name of the job you want to cancel.
B On the [Document] menu, click [Cancel] or [Cancel Printing].

& Note
3 You can also open the print job queue window by double-clicking the printer icon in the [Printer]

window.
ﬂ Press the [Job Reset]) key on the control panel.
“Job Reset?” appears on the panel display.
B Select between canceling the job currently printing and canceling all jobs (including the job
currently printing) using the [A] and [ V] keys.
*  When canceling only the current job
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*  When canceling all jobs including the current job

& Note
O ltis also possible to resume printing by selecting [Resume Print], and then pressing the [# Enter)

key.
E Press the [# Enter] key.
A confirmation message appears.

& Note
O Printing resumes if you press the [Escape] key at this point.

ﬂ Press the [# Enter] key.
The job is canceled. When the cancellation procedure is complete, a message appears.

{¥Important

3 If the printer is shared by multiple computers, be careful not to accidentally cancel someone
else's print job.

& Note

3 This procedure cancels print jobs being processed by the printer. In some cases, the printer may
already be processing data for the next series of print jobs following the one currently being out-
put. If this is the case, subsequent print jobs are also canceled when you press the [Job Reset]
key.

3 Print jobs containing a large volume of data may take considerable time to stop.
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Macintosh - Canceling a Print Job

n Double-click the printer's icon on the desktop.

A window appears, showing all print jobs currently queued for printing. Check the current status of
the job you want to cancel.

& Note
O Under Mac OS X, start Print Center.

B Select the name of the job you want to cancel.
B Click the pause icon, and then click the trash icon.

ﬂ Press the [ Job Reset] key on the control panel.
“Job Reset?” appears on the panel display.

B Select between canceling the job currently printing and canceling all jobs (including the job
currently printing) using the [A] and [ V] keys.
*  When canceling only the current job

*  When canceling all jobs including the current job
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& Note
O ltis also possible to resume printing by selecting [Resume Print], and then pressing the [# Enter)

key.
E Press the [# Enter] key.
A confirmation message appears.

& Note
O Printing resumes if you press the [Escape] key at this point.

ﬂ Press the [# Enter] key.
The job is canceled. When the cancellation procedure is complete, a message appears.

{¥Important

3 If the printer is shared by multiple computers, be careful not to accidentally cancel someone
else's print job.

& Note

3 This procedure cancels print jobs being processed by the printer. In some cases, the printer may
already be processing data for the next series of print jobs following the one currently being out-
put. If this is the case, subsequent print jobs are also canceled when you press the [Job Reset]
key.

O Print jobs containing a large volume of data may take considerable time to stop.
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9. Sample Print/Locked Print

Sample Print

Use this function to print only the first set of a multiple-set print jobs. Remaining sets are saved on the
printer's optional hard disk drive. Saved jobs can be printed or canceled from the printer's control panel.

1¥Important
3 If you turn off the power switch, the job saved on the hard disk will be deleted.

® Limitation

O To use this function, the optional hard disk drive must be installed on the printer.

/A Reference
For more information about settings for printer driver, see the printer driver Help.

& Note
O You can identify the file you want to print by User ID and time it was stored.

3 The actual number of pages the printer can save depends on the contents of the print images. For
example, the printer can save up to 30 jobs or 1,000 pages for Sample Print and Locked Print. Page
storage depends on data volume.

3 If the first set of the Sample Print file is not as you expected and you do not want to print remaining
sets, delete the Sample Print file using the control panel.

3 If you print the remaining sets of the Sample Print file, the job in the printer is deleted automatically.

O The following procedures describe how to use this function with the PCL 5¢ or RPCS printer driver
under Windows. If you want to use this function with the PostScript 3 printer driver or on a Macin-
tosh, see PostScript 3 Supplement.

n From an application, select the menu command to print.
The [Print] dialog box appears.

B In the[Name] list, select the printer you want to use, and then click [Properties].
The Printer Properties dialog box appears.
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B In the [Job Type:] box, click [Sample Print].
ﬂ In the [User ID:] box, enter a User ID of up to eight alphanumeric characters.

& Note
3 This is used to identify the user associated with a job.
3 The User ID can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters.

B Click [OK].
B After making the necessary settings, click [OK].

ﬂ Check the print job, and then select from the control panel whether to print or delete remain-
ing sets.

A Reference
See p.228 “Printing Remaining Sets”.
See p.230 “Deleting a Sample Print File”.
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Printing Remaining Sets

n Press the [ Menu] key.

I-oOnOline Esape A
Job%set F%reed #8&

@Power “Error © Data In
— T — T

ACE0828

B Press the [A ] or [ V] key to display “Sample Print”, and then press the [# Enter] key.

User ID and time the job was stored appear.

B Press the [A ] or [ ¥ ] key to display the file you want to print, and then press the [# Enter ] key.
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ﬂ Check “Print File” is displayed, and then press the [# Enter] key.

Remaining sets are displayed.

& Note
O To cancel printing, press the [Escape] key.

B Press the [# Enter] key. To change the number of sets you want to print, press the [A] or [ V]
key to select the number of sets, and then press the [# Enter] key.

The job is printed, and the job saved on the hard disk is deleted.
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Deleting a Sample Print File

n Press the [ Menu] key.

I-oOnOline Esape A
Job%set F%reed #8& v

@Power “Error © Data In
— T — T

ACE0828

“Menu” appears on the display.

ﬂ Press the [A] or [ V] key to display the “Sample Print” menu, and then press the [# Enter)
key.

B Press the [A] or [ V] key to display the file you want to delete, and then press the [# Enter]
key.
The following message appears on the display:
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ﬂ Press the [A]) or [ V] key to display “Delete File”, and then press the [# Enter] key.

& Note
O If you want to cancel deletion of a Sample Print file, press the [Escape] key.

B Press the [# Enter] key to delete the file.
The following message appears on the display:

B Press the [On Line] key.
“Ready” appears on the display.
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Checking the Error Log

When a print job is not saved on the hard disk, it remains in the error log and can be checked using the
control panel.

® Limitation

3 The error log displays up to 20 of the newest jobs. If you turn off the power switch, they will be de-
leted.

n Press the [ Menu] key.

b Online| Menu Escape

JAN
,wgm Fgm ] #%e,v

@Power “Error © Data In
— T — T

ACE0828

“Menu” appears on the display.

ﬂ Press the [A ] or [ V] key to display “Sample Print”, and then press the [# Enter] key.

User ID and time the job was stored appear.
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B Press the [A ) or [ V] key to display “Error File(s)”’, and then press the [# Enter] key.

After you finish checking the error log, press the [Escape] key.
The display returns to the Sample Print job selection menu.

& Note

3 To print a document with an error, either print by form feed or delete the job saved on the hard
disk, and then resend the job from the computer.

B When you finish checking the error log, press the [ Escape ] key.
The display returns to the Sample Print job selection menu.

E Press the [On Line] key.
“Ready” appears on the display.
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Locked Print

Use this function to maintain privacy when printing confidential documents. Documents will not be
printed out automatically, unless a password is entered using the control panel after sending the print
job.

iﬁklmportant

3 If you turn off the power switch, the job saved on the hard disk will be deleted.

® Limitation

O To use this function, the optional hard disk drive must be installed on the printer.

A Reference
For more information about printer driver settings, see the printer driver Help.

& Note
O You can identify the file you want to print by User ID and time it was stored.

3 The actual number of pages the printer can save depends on the contents of the print images. For
example, the printer can save up to 30 jobs or 1,000 pages for Sample Print and Locked Print. Page
storage depends on data volume.

3 The following procedures describe how to use this function with the PCL 5¢ or RPCS printer driver
under Windows. If you want to use this function with the PostScript 3 printer driver or on a Macin-
tosh, see PostScript 3 Supplement.

After the Locked Print file is printed, the job in the printer is deleted automatically.

n From an application, select the menu command to print.
The [Print] dialog box appears.

B Open the printer properties dialog box.
B In the [Job Type:] box, click [Locked Print].
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ﬂ In the [User ID:] box, enter a User ID of up to eight alphanumeric characters.

& Note
3 This is used to identify the user associated with a job.
3 The User ID can consist of up to eight alphanumeric (a-z, A-Z, 0-9) characters.

B In the [Password:] box, enter a password of four digits.

& Note
3 The password must be four digits (0-9).

E Command to print.
The job is saved on the Hard Disk Drive.

ﬂ Enter the password using the control panel, and then specify whether to print or delete.

~ Reference
See p.236 “Printing a Locked Print File”.

See p.238 “Deleting a Locked Print File”.

? Limitation
3 Print jobs are not saved on the hard disk in the following cases:(You can check the error log for
jobs that were not saved.)

*  When there are 30 Sample Print and Locked Print jobs saved on the hard disk drive, and a
31st job is transmitted.

* The total number of pages saved on the hard disk exceeds 1,000.

g
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Printing a Locked Print File

n Press the [ Menu] key.

I-oOnOline Esape A
Job%set F%reed #8& v

@Power “Error © Data In
— T — T

ACE0828

“Menu” appears on the display.

ﬂ Press the [A ] or [ V] key to display “Locked Print”, and then press the [# Enter] key.

User ID and time the job was stored appear.

B Press the [A ] or [ V] key to display a file you want to print, and then press the [# Enter] key.
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ﬂ Enter the password.

@ Press the [A]) or [ V] key to enter the leftmost digit of the password, and then press the
[# Enter] key.

© Enter the remaining digit of the password, and then press the [# Enter] key.
B Check “Print File” is displayed, and then press the [# Enter] key.

& Note
O If you want to cancel printing, press the [Escape] key.

E Press the [# Enter] key.

The job is printed, and the job saved on the hard disk is deleted.
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Deleting a Locked Print File

n Press the [ Menu] key.

I-oOnOline Esape A
Job%set F%reed #8& v

@Power “Error © Data In
— T — T

ACE0828

“Menu” appears on the display.

ﬂ Press the [A] or [ V] key to display the “Locked Print” menu, and then press the [# Enter]
key.
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ﬂ Enter the password of the Locked Print file.

@ Press the [A]) or [ V] key to enter the leftmost digit of the password, and then press the
[# Enter] key.

© Repeat steps @ and @ to enter the remaining password digits, and then press the [# Enter]
key.

B Press the [A ] or [ V] key to display “Delete File”’, and then press the [# Enter] key.

& Note
O If you want change the Locked Print file, press the [Escape] key.

E Press the [# Enter] key.
“Deleted” appears on the display, and then the printer returns to the previous menu.
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Checking the Error log

When a print job is not saved on the hard disk, it remains in the error log and can be checked using the
control panel.

® Limitation

3 The error log displays up to 20 of the newest jobs. If you turn off the printer power, they will be de-
leted.

n Press the [ Menu] key.

b Online| Menu Escape

JAN
,wgm Fgm ] #%e,v

@Power “Error © Data In
— T — T

ACE0828

“Menu” appears on the display.

ﬂ Press the [A ] or [ V] key to display “Locked Print”, and then press the [# Enter] key.

User ID and time the job was stored appear.
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B Press the [A ) or [ V] key to display “Error File(s)”’, and then press the [# Enter] key.

After you finish checking the error log, press the [Escape] key.
The display returns to the Locked Print job selection menu.

& Note

3 To print a document with an error, either print or delete the job saved on the hard disk, and then
printing command the host computer to print again.

B When you finish checking the error log, press the [ Escape ] key.
The display returns to the Sample Print job selection menu.

E Press the [On Line] key.
“Ready” appears on the display.
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10. Checking Printer Status

SmartDeviceMonitor for Client

n Start up SmartDeviceMonitor for Client.
B Right-click the SmartDeviceMonitor for Client icon on the task bar, and then point and left-

click [Options] on the displayed menu.
The [SmartDeviceMonitor for Client-Options] window is displayed.

B Select the printer you want to use, check [To be Monitored], and then click [OK].

ﬂ Right-click the SmartDeviceMonitor for Client icon on the task bar, and then point and left-
click the printer you want to monitor.

The [Status] window of the target printer to be monitored is opened.

B Click the [Configuration] or [Device Properties] tab to find the amount of paper in the paper
tray, etc..

& Note
O For more information about how to use each item, see SmartDeviceMonitor for Client Help.
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Web Image Monitor

n Start up Web Image Monitor.

ﬂ In the [Address] box, enter “http://(the IP address of the printer you want the status to be dis-
played)”.
The status of the selected printer appears on Web Image Monitor.

If you have configured SSL (secure sockets layer) encryption and have issued the server certificate,
enter "https://<printer's IP address>/printer". Internet Explorer 5.01 or later or Netscape 7.0 or later
must be installed on the computer.

B Click [Status] to find the amount of paper in the paper tray, etc..

& Note
3 For more information about how to use each item, see Web Image Monitor Help.
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11. Appendix
Color Guide

Color Printing Basics

Additive (Emitted) and Subtractive (Reflected) Color Models

All light is a mixture of red, green, and blue, which can be illustrated by what is normally called the
RGB color model. When red, green, and blue are of equal intensities, the RGB color model produces
white.

& Note
O RGB is also called additive or emitted color. The colors on your computer screen are produced by
varying the intensities of RGB.
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Printed color is a mixture of cyan, magenta, and yellow, which can be illustrated by what is normally
called the CMY color model. When mixed in equal proportions the CMY color model produces black.

yellow

magenta

& Note
O CMY is also called subtractive or reflective color. The printer uses CMY toner plus K (black) toner
(CMYK color model) to provide full color printing.

The colors of the RGB color model can be mixed to produce the cyan, magenta, and yellow of the CMY
color model and vice versa. Two colors of one model are mixed to produce the color of the other model
(mixing blue and green produces cyan, for example). The remaining color is the complement of the
color produced (red in this example). Complementary colors are: red and cyan, green and magenta, blue
and yellow.

magenta

cyan
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Printed Color

This printer produces full-color output using four toner colors: cyan, magenta, yellow, and black. These
four colors make up the CMYK color model.

& Note

3 Mixing CMY in equal proportions should hypothetically produce pure black, but imperfections in ink
cause equal measure of these colors to produce a muddy or dark brown. Black toner is added to
the color model, making it possible to produce pure black.

For example, if the image is created with cyan only, there is no problem printing it using only cyan ton-

er. However, full-color images are comprised of 10,000s of fine colors. These fine colors can be ex-

pressed by changing the density of CM YK toner particles to be printed per unit of surface.

There are also dark and light shadings to each color. This shading can be expressed by changing the
density of toner particles printed per unit of surface.
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Printing a PDF File Directly

You can send PDF files directly to the printer to print without opening a PDF application.

Limitation

This is possible for genuine Adobe PDF files only.

Version 1.3, 1.4, and 1.5 PDF files are compatible.

Transparency and JBIG2 (functions of PDF version 1.4) are not compatible.
PDF version 1.5 only functions are not compatible.

When you make the [Duplex] and [Layout] settings using the printer driver, be sure to select [Portrait]
or [Landscape] according to the actual orientation of the PDF print job.

3 The stapling and punching positions displayed in the printer driver dialog box apply to sheets in por-
trait orientation. If you staple or punch sheets in landscape orientation, the result may not be what
you intended.

Qaaaoaao.e

Printing Method

< Using DeskTopBinder V2 Lite
PDF files registered with DeskTopBinder V2 Lite can be sent directly to the printer for printing.

& Note
O The RPCS printer driver must be installed.

O Use DeskTopBinder V2 Lite on the provided CD-ROM. PDF file direct printing is supported only
by DeskTopBinder V2 Lite Version 3.1.1.0 or later.

O PDF Direct Print settings can be made from PDF Direct Print properties.
3 To print password-protected PDF files, you must do the following:
» Enter the PDF password using PDF Direct Print properties.
* On the control panel, select [PDF: Change PW] on the “PDF Menu” to set the PDF password. r
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3 When a group password is set with DeskTopBinder V2 Lite, set a group password using [PDF:
Change PW] on the “PDF Menu” menu on the control panel.

~ Reference
For details, see DeskTopBinder V2 Lite Help.

To check which version of DeskTopBinder V2 Lite you have, see DeskTopBinder V2 Lite Help
or the DeskTopBinder V2 Lite ReadMe file on the provided CD-ROM.

< Using commands
From Windows and UNIX, you can print PDF files directly, using commands such as “ftp” and
G‘lpr’9.

R Reference

» For more information about printing using commands under Windows, see “Printing Files Di-
rectly from Windows”, Administrator Reference.

« For more information about printing using commands under UNIX, see UNIX Supplement.




Printer Client Reference

Printing with Bluetooth Connection

= Preparation
The printer supports the following profiles:
+ SPP
« HCRP
» BIP (Some printers do not support BIP. For details, see the manual that comes with the printer.)

/A Reference
For more information about printing with SPP, see p.249 “Printing with Bluetooth Connec-
tion”.
For more information about printing with HCRP or BIP, see the manual for each product.

For more information about the supported profiles, see the manual that comes with the Blue-
tooth adaptor.

Printing with Bluetooth Connection

= Preparation
Make sure you install the printer driver using the same procedure as for the parallel interface instal-
lation. For more information about how to install the printer driver, see p.75 “Printing via Parallel
Connection”.

Confirm the following:

* The power switch is on.

» The Bluetooth card has been inserted into the printer and its light is blinking.

The printer is confirmed to work with a computer which has one of the following Bluetooth adaptors.

+ 3Com PCMCIA Bluetooth adaptor Parts# 3SCRWB6096

+ 3Com USB Bluetooth adaptor Parts# 3CRWB96 J7
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& Note

3 The system requirements depend on the Bluetooth product used. See the manual for each product
for more details.

3 For more information about how to set up Bluetooth under other operating systems or for use with
different utilities, see the manuals for those operating systems or utilities.

n Start 3Com Bluetooth Connection Manager.
B Make sure the printer you want to use appears in 3Com Bluetooth Connection Manager.
B On the [Tool] menu, click [COM port].

ﬂ Make sure that “Bluetooth Serial Client (COMXx)”’ appears under Client Ports. (x indicates the
COM port number used by Bluetooth).

B Click [Close].

E Click [Start] on the taskbar, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].

g Click the [Ports] tab.

[m Under [Port], select [COMx:]. x represents the same number as in step [J.

m Click [OK].
The [Printers] window closes.
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< If a dialog box appears while transmitting a print job, reestablish the connection as follows:
@ Select the printer you want to use in the [Softkey] list.
@® Click [Connect].

& Note
O If you always use the same printer, select the [Always use for this connection] check box.

/A Reference
For more information, see the manual that comes with the Bluetooth adaptor.

Security Mode

n Start 3Com Bluetooth Connection Manager.

ﬂ On the [Tools] menu, click [Security Mode].
The [Security Mode:] dialog box appears.

B Select a security mode in the [Security Mode:] list.

If you select [High], or if you select [Custom] and then select [Link] in the [Custom Settings] dialog
box, you will be asked to enter the Bluetooth password. (See p.252 “Printing” for details about how
to find out what the password is.) For all other Security Modes and Custom Settings, no password
will be asked.

& Note
3 For more information about each mode, see the user's manual for the utility.

ﬂ Click [OK].
The [Security Mode:] dialog box closes.

7
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Printing

@ Transmit the print job to the printer being used.

Depending on how your computer is set up, the [Connect] dialog box may appear. If it does, use
it to establish a connection with the printer.

@ The [Authentication] dialog box appears.
© Enter the Bluetooth password, and then click [OK].

The Bluetooth password consists of the last four digits of the printer's serial number. You can
find the serial number on the label on the back of the printer. For example, if the serial number
is 00A0-001234, the Bluetooth password is 1234.

@ The print job is transmitted.

& Note
3 The Bluetooth password differs for each printer and cannot be changed.

1*SPP and HCRP

The maximum number of Bluetooth adaptor or Bluetooth-equipped computers that can be connect-
ed at the same time by the Bluetooth interface is two, including one by SPP connection and one by
HCRP connection.

When connecting more than one Bluetooth adaptor or Bluetooth-equipped computer at the same
time, the first device which establishes the connection is selected. When selecting the connection
between the other devices, you need to cancel the first established connection.

Conditions for Bidirectional Communication
* SPP connection does not support bidirectional communication.
* HCRP connection supports bidirectional communication.
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EBIP
* Only one Bluetooth adaptor or Bluetooth-equipped computer can be connected using BIP.
* The format that can be printed using BIP connection is JPEG.
» User code is disabled for BIP connection.
» If settings are made to limit the use of the print function using user codes, you cannot print.
* Some printers do not support BIP. For details, see the manual that comes with the printer.
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Staple and Punch Position

Stapling

By installing the 2 tray finisher or booklet finisher, you can staple one set at a time when printing mul-
tiple copies. See the Help files of the printer driver for details about print methods.

? Limitation
3 The printer cannot staple paper fed from the bypass tray.

& Note

3 If you cannot make settings for stapling even when the 2 tray finisher or booklet finisher is connect-
ed, it is possible optional devices have not been attached properly. Make proper settings for any
optional devices in the printer driver's dialog box.

+ See p.51 “Setting Up Options” in “Windows 95/98/Me Configuration”.

+ See p.84 “Setting Up Options” in “Windows 2000 Configuration”.

+ See p.115 “Setting Up Options” in “Windows XP, Windows Server 2003 Configuration”.
+ See p.143 “Setting Up Options” in “Windows NT 4.0 Configuration”.

O Staple output depends on print and feed direction. The following table shows possible staple posi-
tions:
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< Staple Position

< 2 tray finisher

Feed Print
Direction| direction

AllA|A
Portrait

o || A]A] A

- ‘AllA][A]

Landscape

Staple Position

)

Landscape
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< Booklet finisher

Feed Print
Direction| direction

Staple Position

]

Landscape ‘_A ‘ ‘ A_‘ ‘_A_‘

portat

-
Landscape

3 When two-sided printing is selected, adjust the staple position to the binding direction.
3 If you are punching at the same time, specify the same side.
3 The paper sizes and number of pages that can be stapled are displayed below.

ACE073S
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< 2 tray finisher

Paper Size Staple Capacity
A3, 11 x 17, B4, Legal 30
A4, BS, Letter 50

< Booklet finisher

Paper Size Staple Capacity
A3,B4, 11 x 17, Legal 25
A4, BS, Letter 50

Punching

Used to punch holes in pages.

? Limitation
3 The printer cannot punch paper fed from the bypass tray.
O To use this function, the 2 tray finisher or booklet finisher must be installed on the printer.

& Note
3 Punch positions depend on print and feed direction. The following table shows possible punch po-
sitions:
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< Punch Position

Feed Print Punch Position
Direction| direction 2 holes 3 holes 4 holes

Lancape

J

[

——

If you cannot make settings for punching even when the 2 tray finisher or booklet finisher is connect-
ed, it is possible optional devices have not been attached properly. Make proper settings for any
optional devices in the printer driver's dialog box.

+ See p.51 “Setting Up Options” in “Windows 95/98/Me Configuration”.

+ See p.84 “Setting Up Options” in “Windows 2000 Configuration”.

+ See p.115 “Setting Up Options” in “Windows XP, Windows Server 2003 Configuration”.
+ See p.143 “Setting Up Options” in “Windows NT 4.0 Configuration”.

When duplex print is selected, adjust the punch position to the binding direction.

Paper sizes that can be punched are displayed below.
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< 2 tray finisher

Type Feed Direction Paper Size
L A4, 16K, Letter
e
2 holes
e A3, 8K, 11x17
e
D A4, B5, 16K, Letter
e
NA 3 holes
e A3, B4, 8K, 11x17
e
I A4, BS, 16K, Letter
e
EU 4 holes
[ A3, B4, 8K, 11x17
e
[ A4, BS, 16K, Letter
e
Northern EU 4 holes o A3, B4, A4, BS, A5, 8K, 16K,
11x17, Legal, 8 1/2”x13”, 8
< 1/47x13”, 87x13”, Letter
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< Booklet finisher

A3,B4, A4,B5,11x 17, Legal, Let-
ter

Type Feed Direction Paper Size

U A4, Letter
e

NA 2 holes
= A3, A4, B5, 11 x 17, Legal, Letter
e
B A4, Letter
e

NA 3 holes
(g A3,11x17
e
U A4, BS, Letter
e

EU 2 holes
(g A3,B4, A4,B5, 11 x 17, Legal, Let-
«— ter
L A4
e

EU 4 holes
(g A3
e
L A4, B5, Letter
e

Northern EU 4 holes

(g
e
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Collate and Job Separation

~ Reference
For more information about collate and job separation, see the printer driver Help.

% Collate
Output can be assembled as sequentially ordered sets.

123 12 12 12

< Job Separation
The shift tray moves backward or forward each time the copies of a set or separate job are delivered,
causing the next set to shift when delivered so you can differentiate between them.
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? Limitation

3 The printer cannot collate or perform job separation when printing onto paper loaded on the bypass
tray.

3 The printer cannot collate or perform job separation when printing on “Thick”, and “OHP” paper
types in the paper tray.

O To use these functions, a memory unit of total 192 MB or the hard disk must be installed on the print-
er.

3 Job separation requires the optional 2 tray finisher or booklet finisher to be installed on the printer.

& Note

3 If you cannot make settings for stapling even when the 2 tray finisher or booklet finisher is connect-
ed, it is possible optional devices have not been attached properly. Make proper settings for any
optional devices in the printer driver's dialog box.
+ See p.51 “Setting Up Options” in “Windows 95/98/Me Configuration”.
+ See p.84 “Setting Up Options” in “Windows 2000 Configuration”.
+ See p.115 “Setting Up Options” in “Windows XP, Windows Server 2003 Configuration”.
+ See p.143 “Setting Up Options” in “Windows NT 4.0 Configuration”.

3 If the output location is one of the finisher trays, job separation is performed.

O If you set “job separation” using the printer driver, the output location becomes one of the finisher
trays automatically.

3 The RPCS printer driver automatically sets "job separation” if you select one of the finisher trays as

the output tray.
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Precautions When Using Windows Server 2003

Precautions When Using the Terminal Server Mode

The following printer driver functions are either disabled or have limitations. Disabled functions are
dimmed.

* Disabled functions
Locked Print, Sample Print, Overlay

» Functions that require administrator permission
Custom setting, Custom size, Watermark, [User settings] on the [Print Quality] tab
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Installing the Font Manager 2000

® Limitation

3 If your system is Windows 2000/XP, Windows Server 2003, or Windows NT 4.0, installing software
using Auto Run requires Administrators permission. When you install a printer driver using Auto
Run, log on using an account that has Administrators permission.

n Quit all applications that are running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
Auto Run will start the installer.

B Click [Font Manager 2000].

ﬂ Follow the instructions on the screen.
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Using Adobe PageMaker Version 6.0, 6.5, or 7.0

If you use this printer under Windows 95/98/Me/2000/XP, Windows Server 2003, or Windows NT 4.0
with Adobe PageMaker, you need to copy the PPD file to the PageMaker folder.

The PPD file is the file with extension “.ppd” in the folder “DRIVERS\PS\WIN9X_ME\(Lan-
guage)\DISKI1\” on the CD-ROM.
The “WIN9X_ME” folder, inside the “PS” folder is for Windows 95/98/Me. Use the folder at a level
appropriate for your operating system.
The third folder, “(Language)” may be substituted for an appropriate language name.
Copy the file with the extension “ppd” to the PageMaker folder.
» For PageMaker 6.0 default installation
The directory is “C:\PM6\RSRC\PPD4”.

» For PageMaker 6.5 default installation
The directory is “C:\PM65\RSRC\USENGLISH\PPD4”.
The “USENGLISH” may vary depending on your language selection.

» For PageMaker 7.0 default installation
The directory is “C:\PM7\RSRC\USENGLISH\PPD4”.
The “USENGLISH” may vary depending on your language selection.

& Note
3 If the driver is not set correctly after copying the “.ppd” file, printing may not be performed properly.

3 When using PageMaker, the optional features that can be selected by the printer driver will not be
active. The following procedure describes how to activate the optional printer features.

@ On the [File] menu, click [Print].
The [Print Document] dialog box appears.

@ Make the necessary settings in the [Features] box.



1394 Utility, 173

A

Additive (Emitted) Color Models, 244

B

Bidirectional transmission, 52, 85,116, 143

C

Changing the Zone (Macintosh), 160
Changing to EtherTalk, 158
Checking Printer Status, 242
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Configuring NetBEUI for Printing
Windows 2000, 62
Windows 95/98/Me, 30
Windows NT 4.0, 126

Configuring Protocols
Windows 2000, 60
Windows 95/98/Me, 28
Windows NT 4.0, 124
Windows Server 2003, 93
Windows XP, 93

Configuring TCP/IP and IPP for Printing
Windows 2000, 60
Windows 95/98/Me, 28
Windows NT 4.0, 124
Windows Server 2003, 93
Windows XP, 93

D

Deleting a Locked Print File, 238
Deleting a Sample Print File, 230

E

EtherTalk, 158

F

Font Manager 2000, 173, 264
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| P
Installing Software PageMaker, 265
Windows 2000, 63 PCL 5¢, 176

Windows 95/98/Me, 31
Windows NT 4.0, 127
Windows Server 2003, 95
Windows XP, 95

J

Job Separation, 261
L

LAN adapter number (Lana Number), 126

Macintosh, 145
ColorSync, installing, 150

N

NetWare, 161

NetWare Configuration
Windows 2000, 164
Windows 95/98/Me, 161
Windows NT 4.0, 170
WindowsXP, 167

PDF Direct Print, 247
PostScript, 177
Precautions When Using the Terminal Server Mode
Windows Server 2003, 263
Precautions When Using Windows Server 2003
Windows Server 2003, 263
printer driver, 175
printer name, 159
Printing a Locked Print File, 234, 236
Printing a PDF File Directly
PDF Direct Print, 247
Printing Method
PDF Direct Print, 247
Printing Remaining Sets, 228
Printing Using a Print Server
Windows 2000, 54
Windows 95/98/Me, 22
Windows NT 4.0, 118
Windows Server 2003, 87
Windows XP, 87
Printing via Parallel Connection
Windows 2000, 75
Windows 95/98/Me, 43
Windows NT 4.0, 139
Windows Server 2003, 106
Windows XP, 106
Printing with Bluetooth Connection
Windows, 249
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Printing without a Print Server
Windows 2000, 60
Windows 95/98/Me, 28
Windows NT 4.0, 124
Windows Server 2003, 93
Windows XP, 93

Punching, 257

R

RGB, 244
RGB color model, 244

S

Sample Print, 226
Setting Up Options

Windows 2000, 84

Windows 95/98/Me, 51

Windows NT 4.0, 143

Windows Server 2003, 115

Windows XP, 115
Setting up the Printer Driver and Canceling a Print Job, 184
SmartDeviceMonitor for Admin, 178
SmartDeviceMonitor for Client, 181
Software and Utilities Included on the CD-ROM, 173
Sorting copies into sets, 261
Stapling, 254
Subtractive (Reflected) Color Models, 244

U

USB Printing Support, 173
Using Rendezvous

Mac OS X, 157
Using USB Interface

Mac OS, 153

Mac OS X, 156

w

Windows 2000, 54
printer properties, PostScript 3, 210
printer properties, RPCS, 186,199
Windows 95/98/Me
printer properties, PostScript 3, 208
printer properties, RPCS, 184,196
Windows 95/98/Me/2000/XP,
Windows Server 2003, Windows NT 4.0
canceling a job, 222
Windows 95/98/Me Configuration, 22
Windows NT 4.0, 118
document defaults, PostScript 3, 218
document defaults, RPCS, 194, 206
printer properties, PostScript 3, 217
printer properties, RPCS, 193,205
Windows Server 2003, 87
printer properties, PostScript 3, 214
printer properties, RPCS, 190
Windows Setup
Netware Configuration, 161
Windows XP, 87
printer properties, PostScript 3, 214
printer properties, RPCS, 190, 202




Printer Client Reference

Copyright © 2004

W



Printer Client Reference

GB G106-7519



	TABLE OF CONTENTS
	Introduction
	Trademarks
	Notes:

	How to Read This Manual
	Symbols

	Checking the Network Environment
	Windows Configuration
	Macintosh Configuration
	UNIX Configuration

	1. Windows 95/98/Me Configuration
	Printing Using a Print Server
	Printing Using a Windows 2000/XP, Windows Server 2003, or Windows NT 4.0 Print Server
	Installing the PCL 5c or RPCS Printer Driver
	Installing the PostScript Printer Driver


	Printing without a Print Server
	Configuring Protocols
	Configuring TCP/IP and IPP for Printing
	Configuring NetBEUI for Printing

	Installing Software
	Installing SmartDeviceMonitor for Client
	Installing the PCL 5c or RPCS Printer Driver
	Installing the PostScript Printer Driver
	Changing Port Settings


	Printing via Parallel Connection
	Installing the PCL 5c or RPCS Printer Driver
	Installing the PostScript Printer Driver

	Installing the Printer Driver Using USB
	Windows 98 SE/Me - Installing the Printer Driver Using USB

	Installing the Printer Driver Using IEEE 1394
	Printing via IP over 1394
	Installing the Printer Driver


	Setting Up Options

	2. Windows 2000 Configuration
	Printing Using a Print Server
	Printing Using a Windows 2000/XP, Windows Server 2003, or Windows NT 4.0 Print Server
	Installing the PCL 5c or RPCS Printer Driver
	Installing the PostScript Printer Driver


	Printing without a Print Server
	Configuring Protocols
	Configuring TCP/IP and IPP for Printing
	Configuring NetBEUI for Printing

	Installing Software
	Installing SmartDeviceMonitor for Client
	Installing the PCL 5c or RPCS Printer Driver
	Installing the PostScript Printer Driver
	Changing Port Settings


	Printing via Parallel Connection
	Installing the PCL 5c or RPCS Printer Driver
	Installing the PostScript Printer Driver

	Installing the Printer Driver Using USB
	Windows 2000 - Installing the Printer Driver Using USB

	Installing the Printer Driver Using IEEE 1394
	Printing via SCSI print
	Installing the Printer Driver


	Setting Up Options

	3. Windows XP, Windows Server 2003 Configuration
	Printing Using a Print Server
	Printing Using a Windows 2000/XP, Windows Server 2003, or Windows NT 4.0 Print Server
	Installing the PCL 5c or RPCS Printer Driver
	Installing the PostScript Printer Driver


	Printing without a Print Server
	Configuring Protocols
	Configuring TCP/IP and IPP for Printing

	Installing Software
	Installing SmartDeviceMonitor for Client
	Installing the PCL 5c or RPCS Printer Driver
	Installing the PostScript Printer Driver
	Changing Port Settings


	Printing via Parallel Connection
	Installing the PCL 5c or RPCS Printer Driver
	Installing the PostScript Printer Driver

	Installing the Printer Driver Using USB
	Windows XP, Windows Server 2003 - Installing the Printer Driver Using USB

	Installing the Printer Driver Using IEEE 1394
	Printing via SCSI print
	Installing the Printer Driver

	Printing via IP over 1394
	Installing the Printer Driver


	Setting Up Options

	4. Windows NT 4.0 Configuration
	Printing Using a Print Server
	Printing Using a Windows 2000/XP, Windows Server 2003, or Windows NT 4.0 Print Server
	Installing the PCL 5c or RPCS Printer Driver
	Installing the PostScript Printer Driver


	Printing without a Print Server
	Configuring Protocols
	Configuring TCP/IP and IPP for Printing
	Configuring NetBEUI for Printing

	Installing Software
	Installing SmartDeviceMonitor for Client
	Installing the PCL 5c or RPCS Printer Driver
	Installing the PostScript Printer Driver
	Changing Port Settings


	Printing via Parallel Connection
	Installing the PCL 5c or RPCS Printer Driver
	Installing the PostScript Printer Driver

	Setting Up Options

	5. Macintosh Configuration
	Mac OS
	Installing the Printer Driver and Software
	Installing the PostScript Printer Driver and PPD File
	Setting Up the PPD File
	Creating a Desktop Printer icon
	Setting Up Options
	Installing the ColorSync profile
	Installing the Adobe Type Manager
	Installing screen fonts

	Using USB Interface

	Mac OS X
	Installing the PPD File
	Setting Up the PPD File
	Setting Up Options
	Using USB Interface
	Using Rendezvous

	Configuring Macintosh
	Changing to EtherTalk
	Mac OS
	Mac OS X

	Configuring the Printer
	Changing the Printer Name
	Changing the Zone


	6. NetWare Configuration
	Windows 95/98/Me
	Windows 2000
	Windows XP
	Windows NT 4.0

	7. Software and Utilities Included on the CD-ROM
	Software and Utilities Included on the CD-ROM
	Printer Drivers for This Printer
	SmartDeviceMonitor for Admin
	SmartDeviceMonitor for Client

	8. Setting up the Printer Driver and Canceling a Print Job 
	PCL 5c - Accessing Printer Properties
	Windows 95/98/Me - Accessing Printer Properties
	Making default printer settings
	Making printer settings from an application

	Windows 2000 - Accessing Printer Properties
	Making default printer settings - Printer properties
	Making default printer settings - Printing preferences properties
	Making printer settings from an application

	Windows XP, Windows Server 2003 - Accessing Printer properties
	Making default printer settings - Printer properties
	Making default printer settings - Printing preferences properties
	Making printer settings from an application

	Windows NT 4.0 - Accessing Printer Properties
	Making default printer settings - Printer properties
	Making default printer settings - Default document properties
	Making printer settings from an application


	RPCS - Accessing Printer Properties
	Windows 95/98/Me - Accessing Printer Properties
	Making default printer settings
	Making printer settings from an application

	Windows 2000 - Accessing Printer Properties
	Making default printer settings - Printer properties
	Making default printer settings - Printing preferences properties
	Making printer settings from an application

	Windows XP, Windows Server 2003 - Accessing Printer Properties
	Making default printer settings - Printer properties
	Making default printer settings - Printing preferences properties
	Making printer settings from an application

	Windows NT 4.0 - Accessing Printer Properties
	Making default printer settings - Printer properties
	Making default printer settings - Default document properties
	Making printer settings from an application


	PostScript 3 - Setting up for Printing
	Windows 95/98/Me - Accessing Printer Properties
	Making default printer settings
	Making printer settings from an application

	Windows 2000 - Accessing Printer Properties
	Making default printer settings - Printer properties
	Making default printer settings - Printing preferences properties
	Making printer settings from an application

	Windows XP, Windows Server 2003 - Accessing Printer Properties
	Making default printer settings - Printer properties
	Making default printer settings - Printing preferences properties
	Making printer settings from an application

	Windows NT 4.0 - Accessing Printer Properties
	Making default printer settings - Printer properties
	Making default printer settings - Default document properties
	Making printer settings from an application

	Macintosh - Setting up for Printing
	Making paper settings from an application
	Setting up for printing from an application


	Canceling a Print Job
	Windows 95/98/Me/2000/XP, Windows Server 2003, Windows NT 4.0 - Canceling a Print Job
	Macintosh - Canceling a Print Job


	9. Sample Print/Locked Print
	Sample Print
	Printing Remaining Sets
	Deleting a Sample Print File
	Checking the Error Log

	Locked Print
	Printing a Locked Print File
	Deleting a Locked Print File
	Checking the Error log


	10. Checking Printer Status
	SmartDeviceMonitor for Client
	Web Image Monitor

	11. Appendix
	Color Guide
	Color Printing Basics
	Additive (Emitted) and Subtractive (Reflected) Color Models
	Printed Color


	Printing a PDF File Directly
	Printing Method

	Printing with Bluetooth Connection
	Printing with Bluetooth Connection
	Security Mode


	Staple and Punch Position
	Stapling
	Punching

	Collate and Job Separation
	Precautions When Using Windows Server 2003
	Precautions When Using the Terminal Server Mode

	Installing the Font Manager 2000
	Using Adobe PageMaker Version 6.0, 6.5, or 7.0

	INDEX

